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Kroll  is an advanced prescription management solution that gives pharmacies the tools to handle the 
complexities of modern prescription dispensing. It offers a powerful, visually appealing approach to 
prescription dispensing that improves the productivity, efficiency, and security of your pharmacy’s 
operations.

This user guide is intended for new Kroll users. It describes how to navigate the software, manage patient, 
drug, and prescriber records, and fill and manage patient prescriptions. For more information, please visit 
the Kroll website.

Chapter1

Introduction
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Logging in
 1.  Double-click the Kroll shortcut icon on your desktop.

The Kroll login window is displayed. 

 2.  Enter your Initials and Password and select OK.

Chapter2

Logging in and out of Kroll
This section explains how to log in and out of the Kroll application. You must have Kroll user credentials.
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Logging out
 1.  Select File > Exit, or select the X in the top right corner of your window.

A prompt appears, asking if you are sure you want to exit. 

 2.  Select Yes.

Another prompt appears, asking if you want to print the Dayend Label. 

 3.  Select Yes if you want to print the label.

If you answered Yes to the Dayend Label prompt, another prompt appears, asking if you want to 
get the Network Totals. 

 4.  Select Yes to generate the Adjudication Totals  report.

It is not necessary to print the Dayend Label or Network Total for each session; one 
printout of each report includes all Rxs filled that day.

Logging out >
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Adding a user
 1.  From the Alt-X Start window, select  Edit > Users and Groups.

The Edit Users and User Groups window is displayed. 

Chapter3

Users and groups
This section explains how to add and manage user accounts so that pharmacy users can access and use Kroll.
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 2.  Select Ins.

The User Information window is displayed.

 3.  Complete the  fields, and add the user to at least one user group.

 4.  Select Save.

The new user is added to the Users list on the Edit Users and User Groups window.

Provide the user with their initials and preliminary password. The user will have to change their 
password immediately after their first log in.

Adding a user >
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Editing a user profile
 1.  From the Alt-X Start window, select Edit > Users and Groups.

 2.  Select the user you want to edit, and select F2.

The User Information window is displayed.

 3.  Update the necessary information, then select Save.

Editing a user profile >
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Deleting a user profile
 1.  From the Alt-X Start window, select Edit > Users and Groups.

The Edit Users and User Groups window is displayed. 

 2.  Select the user you want to delete, then select Del.

A prompt appears, asking if you are sure you want to delete this user. 

 3.  Select Yes.

Deleting a user profile >
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Adding a user group
 1.  From the Alt-X Start window, select Edit > Users and Groups.

The Edit Users and User Groups window is displayed. 

 2.  Select the User Groups tab and select Ins.

The User Group Edit Form is displayed. 

 3.  Enter a Group Name and Privilege Level.

Adding a user group >
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 4.  To add users to the group:

Select Ins, then select the user(s) you want to add to the group. 

To add multiple users, select each user name and press the space bar.

The selected users’ names appear in bold text. 

Select OK.

The selected users are added to the User Group Edit Form. 

Select Save.

Editing a user group
 1.  From the Edit Users and User Groups window, select the User Groups tab.

 2.  Select the User Group you want to edit, then select F2.

The User Group Edit Form is displayed.

 3.  Make the necessary changes and select Save.

Editing a user group >
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Deleting a user group
You must remove all users from a user group before you can delete it.

 1.  From the Edit Users and User Groups window, select the User Groups tab.

 2.  Select the user group you want to delete, then select Del.

A prompt appears, asking if you are sure you want to delete the user group. 

 3.  Select Yes.

Changing user passwords
 1.  From the Alt-X Start window, select File > Users > Change Password.

 2.  Enter your login credentials and select OK.

The Change Password pop-up is displayed. 

 3.  Enter your new password in the New Password and Verify New Password fields, then select 
OK.

Deleting a user group >
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Assistants working within the dispensary must be associated with a pharmacist so that the pharmacist's 
license number is included when:

processing prescriptions,

retrieving information from the Drug Information System (DIS), and

submitting third-party payer claims

Associating assistants with pharmacists
 1.  From the Alt-X Start window, select  File > Users > Associate Pharmacist.

The Pharmacist Association Form is displayed. 

Chapter4

Pharmacist and assistant association
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 2.  Select the assistant(s) you want to associate.

 3.  Have the pharmacist enter their credentials in the Pharmacist Initials and Password fields. 

 4.  Select Associate.

Disassociating assistants from pharmacists
 1.  From the Alt-X Start window, select File > Users > Disassociate Pharmacist.

 2.  Have the pharmacist enter his or her login credentials and click Login.

All assistants are disassociated from the specified pharmacist.

Disassociating assistants from pharmacists >
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You can open multiple sessions from the same terminal. It is recommended that you do not 
exceed three sessions per terminal, to avoid slow processing times.

Chapter5

Start window
The Start window is displayed when you log into a Kroll session.
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Function keys
The Function Keys (i.e. F3, F5, F7, F9, F11, and F12) are located directly below the menu options. These 
keys are explained in detail in later sections of this user manual.

Universal Search Field
The Universal Search Field is used to search for patients, drugs, prescribers, and prescriptions. It is 
located beneath the F3 - Patient button in the upper left corner of the ALT+X Start window.

In this field, you can enter search criteria for a patient, drug, prescriber, or Rx, and press the corresponding 
function key to obtain search results that match the criteria you entered. For example,  you could enter a 
patient’s phone number and select F3 - Patient to search for a patient, or enter a DIN and select F5 - Drug 
to search for the associated drug record.

Function keys >
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You can also enter a prescription number (Rx) or transaction number (Tx) into the Universal Search Field 
and choose one of the options from the left navigation pane.

Name Select to...
Modify Rx Modify the most recent Tx in the Prescription Chain without generating a new transaction 

number when possible (e.g. Add missing repeats to a prescription).
Reprint Rx Reprint vial labels, hardcopies, Kroll Care, privacy labels, and receipts for the most recent 

Tx in the Prescription Chain.
Cancel Rx Reverse a prescription.
Modify 
Specific Rx 
#

Modify a Tx that is not the most recent Tx in the prescription chain.

Reprint 
Specific Rx 
#

Reprint vial labels, hardcopies, Kroll Care, privacy labels, and receipts for an Rx that is not 
the most recent Tx in the prescription chain.

Counsel 
Rx

Display the Counseling window for the Rx number entered in the search field.

Universal Search Field >
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Menu options
The menu options contain a hierarchy of items you can select.

Name Description
File and 
Edit

Contains commands used for configuring and managing the Kroll Pharmacy software. 
Since a large majority of system configurations are centrally maintained, only a small 
subset of users have to access these two options.

Reports Contains a comprehensive list of Kroll reports.
Utilities Contains supplementary system features, including Drug Ordering, Interactions Checking, 

Patient Merge, Drug Merge, Quick Price, and Print Free Form Labels.
NH Contains commands to create new nursing home forms, edit the existing nursing home 

forms, print MAR/TMR reports, fill manual batches, package, view cycles, and add Rxs to a 
manual batch.

Cards Displays the functions also represented by the function keys (i.e. F3, F5, F7, F9, F11, and 
F12). Selecting one of the commands in this hierarchy is equivalent to pressing the 
associated function key.

Session Links to Kroll sessions. Select a link to open and manage multiple Kroll sessions from one 
terminal. 

Help Contains links to the on-window help and diagnostic tools.
Version 
10

Displays contact information for the Kroll support team, version, release date, last FDB or 
Vigilance update, and current formulary dates.

Dashboard
The Dashboard is the default view for the Alt-X Start window. It displays prescriptions that are overdue, 
approaching due time, or in the Trouble queue.

Menu options >
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The workflow window allows users to quickly determine the number of Rxs approaching due time at each of 
the prescription processing stages.

Dashboard buttons
The buttons on the  Alt-X Start window provide access to tools that support pharmacy operations. The 
numbers in the purple circles identify the number of entries of each type.

Callbacks
The Callbacks button displays communications initiated from the system and sent to prescribers. 

An entry is automatically created in the callback list when the Add to Doctor Callbacks command is 
selected from the Extra Functions menu in the patient profile.

The following table describes the filters on this list.

Dashboard buttons >
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Name Description
Filter Filter the list for callback entries generated during a specific a date range:

Current + [x] days: Entries that are currently active as well as those that are scheduled to 
become active “x” number of days.

Current Or Resolved Today + [x] days: Entries that are either currently active or that have 
been resolved today.

All + [x] days: All entries, historical and current.

History + [x] days: Entries that have been resolved for “x” number of days.
Doctor Filter the list for callback entries generated for a specific provider.

You can manage the status of a callback entry by highlighting an entry and selecting one of the following 
options:

Name Description
C (Mark as 
Call Doctor)

Select to indicate that a phone call needs to be made to the doctor for the highlighted 
entry. You can specify a comment for the doctor callback.

O (OK Refills) Select to add prescription repeats to an entry. Once repeats have been added, the 
status of the entry will change to “Doc Okayed”.

F (Fill) This option is only available for callback entries with a status of “Doc Okayed”. When 
this option is selected,  the following choices are displayed:

Copying the entry to a new Rx number will create a new Rx Work Order

Apply repeats to the existing entry

Ignore changes = do nothing
W (Mark as 
Waiting)

Select to change the status of a callback entry to “Wait for Doc”.

R (Refuse 
Refills)

Select this option if the prescriber has declined the pharmacy’s request for repeats on 
behalf of the patient. The status of the callback entry will change to “Doc Refused”, and 
an entry will be added to the Follow-ups to remind you to contact the patient to let them 
know their request for repeats was refused.

D 
(Summarize 
Doctor)

Select to display the address, phone number and fax number of the prescriber listed in 
the callback entry. 

Print Report Select to print the To Do Report, which can be used to identify outstanding and resolved 
notes, refills, follow-ups, and doctor callbacks.

Callback entries generated from printing or previewing the ‘Doctor Authorization Report’ are 
automatically removed from the list when the Rx(s) are refilled using the ‘Copy Rx’ function. 
The system recognizes that the authorization request has been resolved through the act of 
copying the old Rx to a new Rx number.

Regular maintenance of the Callback window is essential for ensuring that entries in the list are relevant to 
pharmacy operations for that day. For example, entries that have been resolved or have become irrelevant 
need to be deleted so that only current and active entries are displayed.

Callbacks >
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Followups
The Followups button displays entries that serve as reminders to follow up with patients regarding a 
specific matter; the actual follow up can be performed via phone call or face-to-face interaction.

The following table describes the filters on this list.

Name Displays...
Current + 
[x] days

Entries that are currently active and those that are scheduled to become active in “x” number 
of days. If set to <Blank>, those entries that are due on the current day are displayed.

All All entries, both historical and current.
History + 
[x]days

Entries that have been resolved “x” number of days ago.

You can manually add a follow up entry by clicking Ins or pressing Insert  and completing the Patient Note 
form. The following table describes the options in this form:

Name Description
Due Date When the follow-up is due.
Reoccurring 
Follow-up

If the follow-up recurs, specify the frequency (every x days).

Patient Depending on how the follow-up entry was added, the patient field may or may not be 
populated. If the patient field is empty, select F2  to search for and insert a patient 
record into the follow-up entry.

Entered by Enter your initials to identify the author of the follow-up entry. The initials are defaulted 
to you, as you initiated the Kroll session, but they can be overwritten.

Followups >
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Name Description
Resolved by Enter your initials to confirm a follow-up has been completed. Once a follow-up has 

been “resolved” it can only be accessed by setting the date range to “History + _days”.
Comment Details of the patient follow-up.

Mark Callback entries as “Doc Refused”. When a prescriber refuses to authorize 
repeats for a patient, the pharmacy will need to follow-up with the patient so they can 
make other arrangements to obtain their medication.

Notes
The Notes window is a communication tool  pharmacy users use to communicate with each other. The 
intention is to reduce paper clutter within the dispensary by using a system-supported function that 
facilitates user-to-user communication. For example, a pharmacist may wish to leave a message for the 
afternoon assistant indicating that drug expiry checking should be continued to the second and third bay.

Select Ins to insert a new note. You can also use the filter to view note entries generated for a specific date 
range.

The following table describes the filters on this list.

Name Displays...
Current + 
[x] days

Entries that are currently active and those that are scheduled to become active in “x” number 
of days. If set to <Blank>, those entries that are due on the current day are displayed.

All All entries, both historical and current.
History + 
[x]days

Entries that have been resolved “x” number of days ago.

Notes >
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The following table describes the fields on the To Do Note pop-up:

Name Description
Due 
Date/Time

Select when the note entry becomes active. Active notes contribute to the running count 
on the Notes window.

Reoccurring 
Notes

If the note recurs, specify the frequency (every x days).

Entered by Enter your initials to identify the author of the follow-up entry. The initials are defaulted 
to you, as you initiated the Kroll session, but they can be overwritten.

Resolved by Enter your initials to confirm a follow-up has been completed. Once a follow-up has 
been “resolved” it can only be accessed by setting the date range to “History + _days”.

Comment Enter any responses or general comments.

Inbound Docs

The Inbound Docs window displays images that have been scanned into the system via the document 
scanner or received via the fax or email. From the scan window, users can filter the Inbound Documents 
list by selecting Pending, Completed, or Deleted and Network Scan, Inbound Fax, or All from the Show 
menus. Use the From the last [x] days field to specify a date range.

For more information on this functionality, see the Sending and Receiving Faxes User Guide.

Inbound Docs >
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Outbound Fax
The Outbound Fax window is used for sending fax messages such as Prescription Authorization 
Requests and Rx Transfer Requests. 

Mail
The Mail button launches an internal email system built within the Kroll Pharmacy software. The head 
office can use this tool to send “fan out” messages to pharmacy users for various communications such as 
provincial network broadcasts. All users set up in Kroll can send messages to other local system users.

Outbound Fax >
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The number beside the mail icon identifies the number of unread messages you have. Select the mail icon 
or the envelope at the bottom of the window to access your inbox. Select a message to view it.

To compose a new message:

 1.  From the upper left hand corner of the Mail window, select New Message.

The New Mail Message window is displayed.

Mail >
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 2.  In the To field, enter the recipient’s name.

 3.  In the Subject field, enter the subject.

 4.  Optionally select the Add Attachment button and attach an image or document.

 5.  Select Send.

Table buttons
There are numerous areas within the Kroll application where a table of records is displayed beneath F2, 
Ins, and Del buttons. For example, there are three instances in the upper portion of the patient record.

The F2 button is also occasionally used alone or alongside the Clear button.

The following table describes the functions of these four buttons and identifies the keys on your keyboard 
you can press to trigger the same functions.

Button Key Function
Ins Insert Add a row to the selected table or to a field.
F2 F2 Edit the selected row in the table.
Del Delete Delete the selected row from the table.
Clear N/A Deletes a value from a field.

Table buttons >
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Configuring the columns in  search windows
You can configure which columns are displayed in the drug, mixture, and prescriber searches. The 
appearance of the windows in this procedure vary according to the search you are configuring.

 1.  Select Change Columns from the right navigation pane, or right click a row in the search results 
and select Change Columns.

The Edit Scan Columns window is displayed.

 2.  Select the columns you want to display.

 3.  Optionally use the Move Up and Move Down buttons to resequence the columns.

 4.  To restore the default columns, select Use Store Default Columns or Use Kroll Defined 
Columns.

 5.  Select OK.

Configuring the columns in search windows >
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Navigating tabs
The drug and mixture records contain a series of tabs. To from tab to tab, press CTRL+→ to move right or 
CTRL+← to move left.

Navigating tabs >
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Patient records contain comprehensive information about patients’ contact details, drug plans, allergies 
and conditions, and Rx history. This section explains how to perform patient searches and how to create 
and manage patient records.

Searching for a patient

Method 1: From the F3 - Patient Search window

 1.  From the Alt-X Start window, select F3 - Patient.

 2.  Enter one of the following patient search criteria:

Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”).

A period (.) and the Patient Quick Code (e.g. “.DoeJ”).

7 or 10-digit phone number (e.g. 800-263-5876 or 263-5876).

A number sign (#) and the +Third Party Billing number (e.g. #123456789).

An asterisk (*) to search ALL patients in the database.

 3.  Select Search.

Chapter6

Patient records
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 4.  Double-click the patient record.

The F3 - Patient window is displayed.

Searching for a patient > Method 1: From the F3 - Patient Search window
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Method 2: From the Alt - X Start window
 1.  Enter any of the search criteria described above in the Universal Search Field and click F3 - 

Patient.

If more than one patient record matches the search criteria, select the patient from the list of 
matching patients to display the F3 - Patient window for that patient. Otherwise, the F3 - Patient 
window is displayed automatically.

Method 3: From the F11 - Drop-Off window
 1.  From the F11 - Drop-Off window, enter your search criteria in the Patient Search field and 

press Enter.

The list of matching patients is displayed. 

 2.  Double-click the applicable patient record. 

The F3 - Patient window is displayed.

Method 2: From the Alt - X Start window > Method 1: From the F3 - Patient Search window
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Performing an Advanced Patient Search
If you cannot find a patient  through one of the regular patient searches described in the previous sections, 
you can use the advanced search.

 1.  From the F3 - Patient window, select Advanced. 

The Advanced Search pane is displayed.

 2.  Enter the advanced patient search criteria and click Search.

Inactive patient records
To inactivate a patient record, deselect its Active checkbox. Inactive patients do not show up in the regular 
patient search, but you can locate them using an Advanced search.

Performing an Advanced Patient Search > Method 1: From the F3 - Patient Search window
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Inactive patient records cannot be used in prescriptions. The Active checkbox must be 
selected for prescriptions to be filled for a patient.

There are various reasons you may choose to inactivate a patient record. For example, the patient may 
have died or moved to another country. Inactivating these records enables the regular search to provide 
more succinct results; this reduces the chances of selecting the wrong patient record for a prescription.

To locate inactivated patient records in the system, perform an Advanced search. Ensure the Inactive 
checkbox or All option is selected. 

Inactive patient records are displayed in red font in the patient search window.

Inactive patient records > Method 1: From the F3 - Patient Search window
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Configuring columns in the Patient Search window
You can change which the columns are displayed in the Patient Search window.

 1.  Select  Change Columns from the right navigation pane.

The Edit Scan Columns window appears. 

 2.  Select the columns you want to be displayed, then select OK.

If needed, you can use the Use Default Columns button to revert your changes and show the 
default collection selections.

Configuring columns in the Patient Search window > Method 1: From the F3 - Patient Search window
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Creating a patient record
 1.  Perform a thorough search to ensure the patient does not already exist in the database. 

You are prompted to perform an Advanced search for inactive patients.

 2.  When you have determined that the patient does not exist in the system, select Ins.

The Patient Name popup is displayed, with the information you entered in the search filled in.

Creating a patient record > Method 1: From the F3 - Patient Search window
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 3.  Enter the rest of the patient name information, and select OK.

Do not include any symbols in the name fields.

A blank F3 - Patient window is displayed. 

 4.  In the Address 1, Address 2, City, Province, Postal Code, and Country fields, enter or select 
the patient's address.

Creating a patient record > Method 1: From the F3 - Patient Search window
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 5.  To add the patient's email address:

Select the + button to the right of the Email field to launch the Edit E-mail communication 
type pop-up.

In the E-mail field, enter the patient's email address.

Select the applicable Notification Events.

To initiate an email message to the address you entered, select Send Email. The message 
is created in your local email application.

Select Save.

 6.  Optionally enter a Quick Code for the patient.

 7.  Optionally select the F2 button to the right of the Family Dr and then search for and select the 
patient's family doctor.

Be careful of prescriber errors when using this field, as all prescriptions processed for the patient 
default to this prescriber.
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 8.  To enter a phone number:

In the Phone Numbers section, select Ins.

The Add/Modify Phone Number pop-up is displayed.

Select the Description and optionally select the Type.

Enter the Phone number and optionally enter an Extension.

Select Save.

 9.  Enter the patient's Birthdate in the format DDMMYYYY. 

The year can be entered as a 2 or 4 digit number (e.g. 1950 or 50). The system automatically 
calculates the patient’s Age in years.

 10.  Select the patient's Language if it is not English.

Be careful when changing the language setting as this will cause the SIG on the vial label to print 
in the language selected if the language has been configured in Kroll.

English translations will appear on the hardcopy for the pharmacist checking the prescription.

 11.  Select the patient's Sex and Gender, and optionally select their Pronouns.

Creating a patient record > Method 1: From the F3 - Patient Search window
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 12.  Optionally enter the patient's height and weight:

Select the + button to the right of the Height or Weight field to display the Edit Charting 
Record popup:

Optionally select the Source.

Enter the Height, choose the measurement, and optionally enter a comment.

Use the same measurements to record height and weight, to maintain database consistency 
(i.e. use feet or centimeters for height, and pounds or kilograms for weight).

Select Save.

 13.  In the Provincial Plan field, enter the patient’s provincial health number (i.e. ODB, RAMQ).

Creating a patient record > Method 1: From the F3 - Patient Search window
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 14.  To load the patient's image using the document scanner:

Feed the photo into the scanner, then select Load to initiate scanning.

The Patient Picture pop-up is displayed.

You can also select Retry, then select From Other File to load a saved image.

Optionally adjust the photo, then select Save.

Creating a patient record > Method 1: From the F3 - Patient Search window
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 15.  Optionally enter one or more Comments:

Select Ins or simply begin typing in the Comment field. 

The Patient Comment pop-up is displayed.

Select a Topic.

Enter the text of your comment.

To display the comment on the F12 Fill window, select Show on Rx.

To print the patient comment on the hardcopy, select Print on Hardcopy. 

This checkbox can only be selected for one comment, as there is limited space on the 
hardcopy.

To cause the comment to pop up every time the patient record is accessed, and every time 
an Rx is filled for the patient, select Alert.

Select Save.
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 16.  In the Plans section, add the patient's third party plan information. 

A patient can have an unlimited number of third party plans. The system supports billing to all 
plans listed in the patient’s record.

Select Ins, or simply begin typing the name of the plan. 

The Patient Plan Information window is displayed. 

Select the Plan.

You can select the Plan Info button to display the details of the plan.

If there is only one plan for the patient, it is automatically be set as the Primary plan in the 
Order field. If there are multiple plans, specify the sequence of billing for coordination of 
benefits (i.e. primary, secondary, tertiary, etc.).

Obtain the Carrier ID, Group ID, and Client ID numbers from the patient’s plan card. Some 
plans do not require all of these fields to be filled out.

The CPHA Pat Code field is only used by certain plans, such as Green Shield.

Creating a patient record > Method 1: From the F3 - Patient Search window
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In the Patient Override Values section, enter the patient's Last Name and First Name as 
they appear on the plan card, if they differ from the name in the patient record. 

This is the  name that is sent to the plan. For example, if the patient’s first name on the plan 
card is “Robert”, but on the patient record it is recorded as “Bob”, enter Robert here.

The Always Use in Rx checkbox is selected by default. It applies the plan to all Rxs filled for 
the patient. You may want to deselect it for plans that only cover certain 
medications/products (e.g. STI Plans and Workers' Compensation Plans).

Select Inactive if the plan no longer accepts claims for the patient. You can also delete plans 
instead.

Select Link To to link an existing patient to the current plan.

Select the Relationship of the beneficiary to the cardholder of the plan. 

Optionally enter a Deduct Type.

This field is used for manually billed plans. It refers to how the patient deductible is calculated 
(e.g. select whether the deductible amount is calculated based on percentage or dollar 
amount).

Optionally select a Deduct Value.

This field is used for manually billed plans only; this must be left blank for real-time plans. If 
the plan is a manual plan, enter the value of the deductible in this field. This field works in 
conjunction with “Deduct Type”.

Optionally enter the plan's Expiry Date in the format DDMMYYYY.

Optionally enter a Comment related to the patient record.

Select Save.
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 17.  In the Allergies section, add the patient's allergies.

Allergies entered into the patient record are cross-checked against prescriptions filled for the 
patient using the First Data Bank (FDB) clinical module.
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To enter a therapeutic class of allergy:

Select Ins. 

The Select an Allergy pop-up is displayed:

Enter the text of the allergy, then select Starts with or Contains. 

Select Search or press Enter.

To select an allergy, double-click it, or select it and then press Enter or click Select.

The Patient Allergy Information pop-up is displayed.

Select the Source of the allergy.

Enter the Date the allergy was reported.

If all of the allergies were reported on the same date and by the same source, select 
Apply to all Allergies.

Optionally enter any Comments regarding the allergy.

Allergy entries with comments have asterisks (*) next to them.

Select OK.
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To add an allergy by searching for a specific drug:

Select the Add Drug button.

The  Drug Search window is displayed.

Search for and select the drug to which the patient is allergic. 

Click Select.

The Select Allergy window is displayed.

This window displays all of the components of the selected drug.

Deselect any of the components of the drug that the patient is not allergic to.

Select OK.

The Patient Allergy Information pop-up is displayed.

Use the Source field to identify who reported this allergy.

Enter the Date the allergy was reported.

If all of the allergies were reported on the same date and by the same source, select 
Apply to all Allergies.

Optionally enter any Comments regarding the allergy.

Allergy entries with comments have asterisks (*) next to them.

Select OK.
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 18.  In the Medical Conditions section, add the patient's medical conditions.

Any number of medical conditions can be added to a patient record. Medical conditions entered 
for the patient are cross-checked against prescriptions in the patient profile using the First Data 
Bank (FDB) clinical module. You should only add physician-diagnosed medical conditions to the 
patient record, to prevent inaccurate clinical warnings from showing up during the prescription 
filling process.

Select Ins or begin typing the condition in the field. 

The Select a Condition window is displayed.

Enter the text of the medical condition, then select Starts with or Contains. 

Optionally change the value in the unnamed drop-down list to search by ICD-10-CA or 
FDBDX conditions, or both. 

Select Search.
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To select a medical condition, double-click it, or select it and then press Enter or click Select.

The Patient Condition Information pop-up is displayed.

Use the Source field to identify who reported this medical condition.

Enter the Date the medical condition was reported.

If all of the medical conditions were reported on the same date and by the same source, 
select Apply to all Conditions.

Optionally enter any Comments regarding the medical condition.

Medical condition entries with comments have asterisks (*) next to them.

Select OK.

 19.  In the Groups section, optionally add the patient to one or more groups:

Select Ins or begin typing the name of the group in the field. 

The Add/Delete Groups popup is displayed.
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 20.  Optionally update the information in the patient information tabs as described in "Patient 
Information tabs" (page 61).

 21.  Select Save.

Patient Information tabs
The patient record contains tabs of information in the bottom right. Use the  Ctrl key in conjunction with the 
underlined letter on the tab (e.g,. press Ctrl + F to access the Family tab) to switch between tabs. You can 
also flip from tab to tab by pressing Ctrl + → to move right or Ctrl + ← to move left.
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General
The General tab displays  the patient's general information and preferences.

 1.  If the patient has not filled a prescription with the pharmacy for an extended period of time, and 
you do not want them appearing in the regular patient search, deselect the Active checkbox.

Inactive patients are excluded from reports unless otherwise specified in the Options tab of the 
report.

 2.  Optionally enter the patient's Alt. (alternate) Last Name.

 3.  Optionally change the Patient Type to a value other than Human.

In certain provinces, selecting Animal triggers taxes to be applied to the patient’s prescriptions, 
as veterinarian Rxs are taxable. In certain provinces, selecting Animal prevents the patient’s 
prescriptions from being sent to the pharmacy network.

 4.  If the patient has passed, enter their deceased date in the Deceased On field.

The Active checkbox is automatically unchecked.

 5.  Select the Delivery Type and Delivery Route.

Delivery routes are defined in Edit > Lists > Master Lists.

 6.  Optionally select a Price Group to activate patient specific pricing. 

Patient price groups are set up by head office.

 7.  Optionally change the Drug Line 1 and Drug Line 2 from the default values to another value.

Drug Line 1 refers to first piece of drug information printed on the vial label, and Drug Line 2 is 
the second. The drug information is pulled directly from the Drug record.
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 8.  Optionally specify if Double Count is required for the patient. 

If double count is required, a message is displayed on the packaging window during the filling 
stage to prompt you to double count medications for the patient.

 9.  If the patient has requested not to receive Kroll Care Monographs, select No Kroll Care. 

Kroll Care will not print any prescriptions filled for the patient.

 10.  If the wallet card should not be printed for the patient, select No Wallet Card.

 11.  To print a calendar according to the day supply on the Rx, select Compliance Calendar on 
Label.

The patient can use this calendar to record when a dose has been taken.

 12.  In the Unit Dose section, optionally enter the dose packaging details.

If a Unit Dose Type or Unit Dose Cycle has been selected, you are prompted to activate and 
configure unit dose packaging for each prescription that is processed for the patient.

Enter the Type of unit dose packaging used for the patient, and the number of week of 
medication packaged for the patient for one Cycle, and select the Price Group that adds a 
supplementary charge to unit dose Rxs.

Unit dose price groups are configured and set up by head office.

 13.  The Rx Totals is a read-only section keeps a running total of the number of Rxs filled for the 
patient and the cumulative dollar value of those Rxs. To reset the counters to zero, select Reset. 
The date will appear in the Reset date field.

 14.  If the patient requested snap cap vials, select the Snap Caps Requested checkbox.

A message will be displayed on the packaging window during the filling stage, to prompt the 
pharmacist to package medications in snap cap vials, and "Snap Caps Requested" will be 
printed on the hardcopy.

 15.  If the patient provided written documentation or consent to package their medication in snap cap 
vials, select the Snap Caps Documented checkbox.

This checkbox is disabled unless the Snap Caps Requested checkbox is selected.

 16.  When the patient record is created, it is assigned a read-only ID that is used to track the patient 
within the system tables.

Family
Family members can be grouped together in the system, to make managing records more efficient. If you 
change the information for one member of a family group, (such as their address, telephone number, or 
third party plan information, you can extend these changes to other family members. After you save the 
updates, the following pop-up is displayed. Select the names of the family members whose information you 
would like to change, then select Change.
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Grouping family members also links family work orders together at the point of sale. For example, if John 
and Jane are linked as family members and both have prescriptions ready for pick-up, when the pharmacy 
user accesses John’s prescriptions at pickup, Jane’s prescriptions will be displayed as well. The patient 
can be asked if he wants to pick up her prescriptions as well. The family can consolidate their trips to the 
pharmacy and help users manage the Pickup Bins more effectively.

To add a family member:

 1.  Select Ins.

The Patient Search window is displayed. 
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 2.  Search for and select the family member as you normally would.

If the family member you are linking has a different address than the original patient, you are 
asked whether you want to update the family member's address to match the current patient's 
address.
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 3.  Select the applicable button.

The family member is added.

If a patient is added into the database by copying an existing patient, the Family link 
will automatically be created.

Nursing Home
The Nursing Home tab displays information that pertains to nursing home patients only.
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 1.  Select the Home you want to enroll the patient in.

This field lists the nursing homes configured in your system.

 2.  Select the applicable Ward and Cycle.

 3.  Optionally enter the patient's Room and Bed numbers.

 4.  If the patient has dietary restrictions, enter them in the Diet field.

 5.  Optionally enter comments in the Comment field.

 6.  Enter the Admit Date.

 7.  If the patient has been discharged from the nursing home, enter the Discharge Date. 

 8.  Optionally enter the date the patient received their last three-month review in the Last TMR Date 
field.

 9.  If the patient is on a leave of absence (LOA):

Select the New button to the right of the Status field.

The Start Patient Leave of Absence pop-up is displayed.

Complete the form and select Save.
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 10.  Complete the Standing Orders section.

This section is used to record the medications that registered nurses and registered psychiatric 
nurses administer based on their assessments of the resident’s needs. These orders must not 
exceed three doses per 24-hour period without notifying the physician. Any rapid deterioration in 
the resident’s condition must be reported to the physician immediately.

Select Ins. 

The NH Standing Orders window is displayed. 

Complete the necessary fields and select OK.
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Other
The Other tab displays the patient's emergency contacts, as well as the dates the patient record was 
created, when it was last changed, and when a prescription was last filled for the patient.

Copying an existing patient record
If a new patient has a family member who is already in the system, you can use the Copy Pat function to 
copy information from the family member to a new patient record.

 1.  Perform a thorough search to ensure the patient does not already exist in the database. 

It is recommended that you perform an Advanced search for inactive patients as well.

 2.  Select  Copy Pat or Copy Patient, or press CTRL+Y.

A second patient search window is displayed. 
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 3.  Search for the family member who is already in the system.

 4.  Highlight the family member and click Select. 

The family member’s patient record is displayed.

Review the information and confirm this is the patient you want to copy information from. 

 5.  Click Select.

 6.  Complete the new patient's record as described in "Creating a patient record" (page 47).

Enter missing information for the new patient record such as birthdate, gender, snap cap 
preference, and phone numbers.

 7.  Click Save to save the patient record.

Third party plans are linked to the patient that the information was copied from. If any 
changes to the plan numbers must be made, it must be done from the originating 
patient record.

Patient profile
The patient profile displays a list of medications the patient has filled at the pharmacy. Each line within the 
profile represents a written prescription with details such as the Rx number, dispensed quantity, drug brand 
name, SIG, authorized quantity, remaining quantity, prescriber, and dispensed date. Users can perform 
actions against these entries, such as refill, modify, cancel, inactivate, and detail.

The patient profile also enables pharmacy users to actively participate in monitoring patient care, by 
comparing new medication orders to all of the medications that the patient has been taking. This 
reconciliation is done to avoid medication errors such as omissions, duplications, dosing errors, or drug 
interactions. This verification should be performed at every transition of care in which new medications are 
ordered or existing orders are rewritten.

Patient profile views
Eight (8) patient profile views available in Kroll. You can use these views to filter and display different 
statuses of prescription information.
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All Rxs
The All Rxs profile displays all of the prescriptions filled for the patient regardless of when the Rx was 
filled, or the Rx status. This view is useful for viewing prescriptions that have been inactivated or 
transferred out.

To access the All Rxs view, do one of the following:

From the patient profile or F11 - Drop-off window, do one of the following:

Press Shift + F3, or 

Press Shift + F4, or 

Select All Rxs from the right navigation pane.

From the patient profile, select Profile > All Rxs.

Active Rxs
The Active Rxs medication profile displays prescriptions with an Active prescription status. This includes 
prescriptions that are Unfilled, Not dispensed, Transferred-In or have a <blank> status. 

This view is useful for filtering out prescriptions that have been inactivated or transferred-out.

To access the Active Rxs view, do one of the following:

From the patient profile or F11 - Drop-off window, press Shift + F5 or  select Active Rxs from the right 
navigation pane.

From the patient profile, select Profile > Active Rxs.

Active Rxs with Passtimes
The Active Rxs w/ Passtimes profile is similar to the Active Rxs tab, but it includes additional columns 
that show unit dose information for prescriptions that are configured for unit dosing. These additional 
columns show the pass time, unit dose quantity, and pass time note.

To access the Active Rxs view, from the patient profile or F11 - Drop-off window, press Shift + F10 or 
select Active Rxs w/ Passtimes from the right navigation pane.
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Refillable
The Refillable Rxs medication profile displays only those prescriptions with a Remaining Quantity left on 
the prescription. In other words, this view filters out prescriptions that cannot be refilled, while only 
displaying those prescriptions that can be refilled.

To access the Refillable Rxs view, from the patient profile or F11 - Drop-off window, press Shift + F6 or  
select Refillable Rxs from the right navigation pane.

Pricing Profile
The Pricing Profile displays all of the prescriptions filled for the patient, and their cost, markup, fee, and 
Rx Total. The values represent amounts pulled from the last filled Rx in the prescription chain. This view is 
useful for determining prescription pricing and resolving pricing discrepancies.

To access the Pricing Profile view, from the patient profile or F11 - Drop-off window, press Shift + F7 or 
select Pricing Profile from the right navigation pane.

Not Dispensed/OTC Rxs
The Not Dispensed/OTC Rxs medication profile displays prescriptions that have been marked with a 
status of “Not Dispensed”. Over-The-Counter (OTC) products are added to the patient profile and marked s 
“Not Dispensed” to allow drug interaction checking to occur without generating official prescription receipts.
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To access the Not Dispensed/OTC Rxs view, from the patient profile or F11 - Drop-off window, press Shift 
+ F8 or select Not Disp/OTC Rx from the right navigation pane.

Rxs Filled in Error
The Rxs Filled in Error view displays prescriptions filled in error for the patient. This profile is commonly 
known as the “Garbage Profile” because it houses prescriptions for the patient that should not have been 
filled and contain incorrect information. Entries in this profile are excluded from drug interactions checking 
and should not influence dispensing decisions.

To access the Rxs Filled in Error view, do one of the following from the patient profile:

Press Shift + F9, 

Select Rxs Filled in Error from the right navigation pane, or 

Select Profile > Rxs Filled in Error.

Transactions
The Transactions view lists all of the transactions completed for the patient.

Suspended Rxs
The Suspended Rxs view displays Rxs that were marked as suspended.

Filter Profile Rxs
You can filter  views by Drug or Rx Comment.
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 1.  Select the view you want to filter, such as All Rxs.

 2.  Select  Filter Profile Rxs.

A filter is displayed above the table.

 3.  Enter your search criteria 

 4.  From the Filter By drop-down list, select Drug or Rx Comment.

 5.  Select Filter.

To remove the filter, select Clear. To hide the filter, re-select Filter Profile Rxs.

Perform Clinical Analysis
Select the  Perform Clinical Analysis option from the patient sidebar to a perform a clinical interactions 
analysis on a patient’s medication profile, 

 1.  From the selection window, select the clinical information you want to retrieve, or Select All or 
Select None . 

 2.  Select OK or press Enter  to execute the analysis.

The Clinical Reports window is displayed. The results are displayed in a series of tabs. 
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 3.  Select a tab to display it, or click the Next button to display the next tab.

Configuring the columns in the Patient Profile
You can configure which information columns are displayed on the patient profile.

Configuring the columns in the Patient Profile > Method 1: From the F3 - Patient Search window

Kroll User Guide © 2025 TELUS Health 75



 1.  Right-click anywhere on any patient profile column, and from the menu that is displayed, select 
Change Columns.

You can also display this menu by selecting the Extra Functions button or pressing X.

The Edit Scan Columns pop-up is displayed.

 2.  Select the columns you want to be displayed, and deselect those you want to hide.

 3.  To resequence a column, select it and then select Move Up or Move Down.

 4.  To revert to the store or Kroll default columns, select Use Store Default Columns or Use Kroll 
Defined Columns.

 5.  Select OK to save your changes.

The following table describes some of the columns you can select. 

Name Description
Ago The number of days ago the prescription was filled.
Auth The authorized prescription quantity in units (e.g. the number of tablets/caplets).
Auth # The number of refills authorized.
B Batched prescription (Y or N).
BrandName The brand name of the drug.
Card # The blister card number the prescription is assigned to.
CF Central Fill prescription (Y or N).
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Name Description
Cost The calculated cost of the last filled Rx in the prescriber chain.
Date The date of the last filled Rx in the prescriber chain.
Days The days’ supply of the last filled Rx in the prescriber chain.
DIN The Drug Identification Number of the drug product.
Doctor The name of the individual who prescribed the prescription.
Due The number of days until the prescription is due to be refilled.
Equivalent To The brand name equivalent of the drug product being dispensed. This column is not 

populated if the associated field is not populated on the drug record.
Exp Date The expiry date for the written prescription.

Expiry dates for written prescriptions vary from province to province and drug 
schedule to drug schedule.

Fee The calculated fee of the last filled Rx in the prescriber chain.
GenericName The generic name of the drug.
Inact Whether the prescription is inactive (True or False).
Init The user initials of the pharmacist who worked on the prescription.
Markup The calculated markup of the last filled Rx in the prescriber chain.
Methadone 
Ingest Date 

The Methadone Ingest Date for methadone prescriptions. 

MI Whether the prescription was billed to a third party with an “MI” intervention (Y or N).
Mix Fee The calculated mixture fee for the last filled Rx in the prescriber chain.
NH Nursing Home prescription (Y or N).
Orig Rx The original prescription number for the prescriber chain.
Orig Date The date the first Rx of the prescriber chain was filled.
Qty The dispensed quantity.
Rem The remaining prescription quantity in units (e.g. the number of tablets/caplets).
Rem # The number of refills remaining.
RxNum The prescription number of the last filled Rx in the prescriber chain.
Sig The SIG code for the prescription (not expanded).
Sig Expansion The expanded SIG code for the prescription. For example, “Take one tablet once 

daily until finished”.
SSC Fee Special Service Code Fee: the dollar value of this fee.
Status Prescription Status (e.g. <BLANK> = Active, Inactive, Unfilled, Not Dispensed, 

Transferred In, Transferred Out, etc.)
Tech The user initials of the assistant who worked on the prescription.
Total The total dollar value of the last filled Rx in the prescriber chain. (Cost + Markup + 

Fee + MixFee + SSCFee = Total).
Total Fee The total fees of the last filled Rx in the prescriber chain. (Fee + MixFee + SSCFee = 

Total Fee).
U Unit Dose Indicator: whether the prescription is configured for unit dosing (Y or N).

Configuring the columns in the Patient Profile > Method 1: From the F3 - Patient Search window
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Patient Profile commands
There are several commands you can execute on highlighted or tagged prescriptions in  the patient profile. 
Eight commands are identified below; the others are accessible from the Extra Functions button.

ESC – Back to patient
Press the Esc key to return to the patient record from the patient profile.

Space – Mark multiple Rxs
You can tag multiple prescriptions and then select a command to perform on all of them. For example, if 
you select three prescriptions and then select Cancel, the first prescription is brought through the 
cancellation process, then the second, then the third.

To tag prescriptions on the patient profile:

Highlight an Rx entry and press the space bar. The entry is bolded. 

Repeat this step to tag additional Rxs.

F-Refill
To tag prescriptions for refill:

 1.  Highlight or tag the prescription(s) to be refilled.

 2.  Press F or select F- Refill.

The F12 - Fill Rx window is displayed.

The status of the prescription on the upper left hand corner of the window shows "Refill”. A work 
order due time must be selected from this window in order to continue processing the 
prescription.

Patient Profile commands > Method 1: From the F3 - Patient Search window
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M-Modify
To tag prescriptions to modify:

 1.  Highlight or tag the prescription(s) to be modified.

 2.  Press M or select M - Modify.

The F12 window is displayed.

Once a prescription has been adjudicated to a plan, only certain fields can be modified. Fields 
that impact price are read-only.

M-Modify > Method 1: From the F3 - Patient Search window
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R-Reprint
To tag prescriptions to reprint:

 1.  Highlight or tag the prescription(s) from the patient profile.

 2.  Press R or select R - Reprint.

The Reprint Rx Paperwork pop-up is displayed.

 3.  Select the workflow and the documents you want to reprint, as well as the number of Vial Labels, 
then select Reprint.

C-Cancel
Cancelling a prescription is synonymous with reversing it.  When an Rx is cancelled after adjudication to a 
third party, a reversal is also made for financials. Cancellations are always initiated on the pharmacy side. 
They cannot be initiated by a patient. To cancel a prescription, the patient would have to call the pharmacy 
directly and request that the prescription be cancelled. 

To cancel prescriptions:

 1.  Highlight or tag the prescription(s) from the patient profile.

 2.  Press C or select  C-Cancel . 

Each prescription is brought up in cancel mode.

The following sections describe these prompts and their impacts on invoices and the payment process.

R-Reprint > Method 1: From the F3 - Patient Search window
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Confirm Cancellation Type
Upon cancellation of a prescription in the patient's profile, the Confirm Rx dialog box is displayed. The 
button you select determines the type of cancellation you will perform.

Select Yes if you want to cancel the prescription without replacing it with a different prescription.

Select No if you no longer want to cancel the prescription.

Select Cancel and Refill if you want to cancel the prescription and replace it with a different 
prescription.

Cancel
If you select Yes, the prescription is cancelled and not replaced. The impact on invoices is different 
depending on whether the invoice is Paid or Posted. 

If the cancelled drug was never filled, you are prompted to determine what to do with the prescription.

Select Make this Rx Unfilled to keep the prescription  on file. 

Select Filled in Error - Remove from profile to remove the prescription from the patient's profile. You 
can copy some of the information of the cancelled prescription over to a new prescription.

C-Cancel > Confirm Cancellation Type
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Confirm Cancel and Refill
If you select Cancel and Refill, you will need to determine the type of change you need to make.

Select Clinical Changes to correct a prescription's clinically-relevant information, such as the drug, 
prescriber, quantity, directions, SIG, or insurance information.

The new or modified prescription will need to go through the workflow again.

Select Billing Changes if the price of the drug has changed, and you need to manually adjust it. Do not 
select this button to change patient coverage, as this workflow does not re-trigger adjudication.

Options 
In most cases, making a change to a work order impacts the invoice. If the invoice is impacted,  the Select 
an option to continue dialog box is displayed, offering you the following four options:

Select Leave invoice open if you have multiple changes to do to the work order.

Select Post invoice (or Post and consolidate invoice(s) if you have completed the invoice.

Kroll ensures all the invoices in the work order correspond to the desired outcome. If the invoice was 
not paid, the former invoice is deleted and replaced by a new invoice. If the invoice was paid, it remains 
on file and a new invoice with the adjusted amount is posted. 

The new invoice is added to the Invoices tab, and the new invoice is reflected in PharmaConnect. The 
patient receives a new notification.

Select Send Rx to Trouble if you want to confirm the changes before posting them.

The invoice will not be posted.

Select Back to Rx to return to the prescription. You will not be able to make changes to the 
prescription. The invoice will not be posted.

D-Detail
You can use the Detail command to view adjudication details for a prescription. This command is useful for 
identifying and resolving pricing issues. 

To view prescription details:

D-Detail > Confirm Cancel and Refill
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 1.  Highlight or tag the applicable prescription(s).

 2.  Press D or select D - Detail.

The Rx Detail pop-up is displayed. It displays all of the transaction numbers (Tx Number) used 
with the original Rx.

 3.  To view the RX Plan Detail Form for a specific TX number, select a row and press D or select D-
Billing Detail.

This window breaks down the amounts paid by each third party payer for the Rx selected.

Cash rows identify patient pays amounts.

 4.  To view the Rx Plan Adjudication History pop-up, select a third party plan entry, and press D 
or select D- Adjudication History.

The Rx Plan Adjudication History pop-up shows the details and messages sent back from the 
third party plan.

D-Detail > Options
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 5.  To display the Adjudication Claim and Response Form, press D or select  D-View 
Adjudication Detail. The left side of the window, Claim Values, shows all the values being sent 
to the third party payer. The right side of the window, Response Values, shows all the values 
and messages sent back from the third party payer. 

D-Detail > Options
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I-Inactivate
 1.  Highlight or tag the prescription(s) to be inactivated.

 2.  Press I or select I-Inactivate.

The Inactivate Rx(s) pop-up is display.

Inactivated prescriptions can be reactivated by selecting Extra Functions > Reactivate.

I-Inactivate > Options
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Extra Functions 
You can select the Extra Functions button on the patient profile to access less-frequently used 
commands.

View workflow details
You can use the View workflow details function to view and print the steps associated with a specific 
prescription.

Counsel
You can use the Counsel function to indicate whether the patient accepted or rejected counselling, and to 
enter information about the counselling that was provided or the reason counselling was rejected. When 
you select this tab, a series of questions are presented for you to answer.

The following image shows the Counsel tab after you confirm that the patient did accept counselling, and 
indicate who the counselling was received by, and indicate where or how it was received (in person, by 
phone, or virtual).

Extra Functions > Options
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Add to Doctor Callbacks
You can use the Add to Doctor Callbacks function to add a reminder to the  Callbacks window to call the 
doctor regarding a specific prescription. This callback reminder may serve to clarify prescription dosage, 
SIG instructions, refills etc.

 1.  Highlight or tag the prescription(s) from the patient profile.

 2.  Select Extra Functions > Add to Doctor Callbacks.

The prescription is added to the Alt+X - Start screen with a Status of Call Doctor.

 3.  To view and resolve a callback, double-click it on the list.

Add to Manual NH Batch
You can use the Add to Manual NH Batch function to add the selected Rxs to the batch order for the 
nursing home where the patient resides.

Add to Doctor Callbacks > Options
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Add to Rx To Do List
You can use the Add to Rx To Do List function  to quickly create a work order for refill prescriptions, and 
indicate when the work order is due. This function is useful if a patient arrives at the pharmacy to refill their 
prescriptions.

 1.  Highlight or tag the prescription(s) from the patient profile.

 2.  Select Extra Functions > Add to Rx To Do List.

The Please Enter a Due Date and Delivery Route pop-up is displayed.

 3.  Use the default Due Date for the Rxs or select Specific Time, then enter a number of days and a 
time.

 4.  Select whether to create a New work order or add the refill to an Existing work order.

 5.  Select OK.

The refill(s) are prioritized against all other existing work orders in the system and presented to 
you for processing at each applicable Rx stage.

Add to Rx To Do List > Options
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AutoFill
You can use the AutoFill function to automatically fill the selected Rxs.

Create Delivery Order
You can use the Create Delivery Order option to add the selected Rxs to a delivery order.

For more information, see the Pharmacy Delivery Guide.

Change Next Fill Parameters
You can use the Change Next Fill Parameters function to change the parameters applied to the next refill 
of the Rx.

 

The following table describes the fields on the Change Next Fill Parameters for Multiple Rxs pop-up.

Name Description
Copy to New # If selected, the Rx is copied and the new parameters applied to the copy.
Refills The number of refills
Unlimited Refills Until If selected, you can enter the date until which the refills expire.
Doctor The prescribing doctor.

This field is enabled when you select Copy to New #.
Comments Any optional comments.

AutoFill > Options
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Copy to New Num and Make Unfilled
You can use the Copy to New Num and Make Unfilled function to copy a selected Rx to a new Rx 
number and mark it as unfilled. You can then modify the copy and action it as needed.

Display Therapeutic Equivalents
The Display Therapeutic Equivalents function enables you to highlight a prescription from the patient 
profile and display any therapeutic equivalents the patient may have had in the past.

The patient profile only displays therapeutic equivalents for the prescription that was initially selected.

Adapt Rx by Pharmacist
For information on the Adapt Rx by Pharmacist  function, please visit the Kroll website and select the 
appropriate Rx adaptation and Rx extension guide from the Downloadable documentation and 
guides > Provincial user guides.

Copy to New Num and Make Unfilled > Options
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Extend Rx by Pharmacist
For information on the Extend Rx by Pharmacist function, please visit the Kroll website and select the 
appropriate Rx adaptation and Rx extension guide from the Downloadable documentation and 
guides > Provincial user guides.

Request Renewal
The Request Renewal function enables you to request a renewal on behalf of the patient. You can send 
this request to the prescribing doctor or another doctor.

 

Extend Rx by Pharmacist > Options
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 1.  Enter the renewal information, then  select Request.

The Doctor Authorization Report is displayed.

 2.  Complete the report, then select Print, and send it to the doctor.

Toggle Batch Fill Status (Hold)
You can use the Toggle Batch Fill Status function to turn batch filling on or off for the selected Rxs. This 
function applies only to patients in nursing homes.

Toggle Batch Fill Status (Hold) > Options
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Transfer Rx to another store
To transfer an Rx to another store:

 1.  Select the prescriptions you want to transfer to another pharmacy.

 2.  Select  Extra Functions> Transfer Rx to Another Store.

The Transfer Out Rx(s) window is displayed.

 3.  Search for and Select the pharmacy  to which you want to transfer the Rx.

The pharmacy’s address and contact information are added to the window.

To insert a new pharmacy record, select New, complete the Create Store form, 
then enter the pharmacy information and select OK.

 4.  Optionally enter the Pharmacist Name and Comments.

Transfer Rx to another store > Options
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 5.  Select Transfer Out Eligible Rxs.

A prompt is displayed, asking you if you want to print the transfer report.

If you select Yes, the Rx Transfer Report popup is displayed. 

 6.  Select the information you want included on the report, then select Print.

The Status of the Rx is updated to show Inact (Transferred Out).

Reactivate Rx
You can use the Reactivate function to reactivate inactive prescription(s). Be careful when reactivating a 
prescription; be sure you know why the Rx was inactivated  to avoid dispensing errors.

 1.  Use the space bar  to select the prescription you want to reactivate.

 2.  Select Extra Function > Reactivate Rx.

The Reactivate Rx window is displayed. 

Reactivate Rx > Options
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 3.  Select Reactivate Eligible Rxs or press Enter.

The prescriptions with a status OK to Reactivate are reactivated.

Suspend
You can use the Suspend function to stop prescriptions from being filled or appearing on reports (including 
all blister packaging reports) for a specific amount of time, or indefinitely. Suspended prescriptions can be 
filled interactively if needed; however, you will be unable to adjust the dispensed quantity since it is not 
known when the patient started taking the medication for this fill. During an interactive fill, you will receive a 
warning that the Rx is suspended.

An active prescription can be suspended for many reasons, including drug-to-drug interactions and 
hospital admission.

Rxs with the following statuses cannot be suspended: Inactive, Inactive (Copied), Inactive Transferred Out, 
Fee for Service, Stock Transfer, or Unfill).

Suspend > Options
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 1.  Use the space bar  to select the prescription you want to suspend.

 2.  Select Extra Function >   Suspend.

The Suspend Rx(s) window is displayed:

If more than one Rx is being suspended, the first tab shows an Rx Summary that lists all of the 
prescriptions selected for the suspend action. Subsequent tabs display information specific to 
the Rx number listed on the first tab. The details for the selected prescriptions are displayed at 
the bottom of the window.

 3.  In the Suspend section, enter the Date, Time, and Reason for suspending the Rx(s). 

To suspend an Rx indefinitely, do not specify a Date or Time.

 4.  Select a Reason from the drop-down list or enter a text reason in the same field. 

 5.  Optionally enter a Comment.

 6.  Select Suspend Eligible Rxs.

Prescriptions with a status of OK to suspend are suspended. Their Status now shows 
Suspended.

Suspend > Options

96 © 2025 TELUS Health Kroll User Guide



Resume
Only prescriptions with a status of Suspended can be resumed. 

 1.  Use the space bar  to select the suspended prescription you want to resume.

 2.  Select Extra Function > Resume.

The Resume Rx(s) window is displayed:

 3.  Select the Date, Time and Reason for resuming the Suspended Rx. 

 4.  Select a Reason from the drop-down list or enter a text reason in the same field. 

 5.  Select Resume Eligible Rxs or press Enter.

The prescriptions with a status of OK to Resume become active again.

View/Edit Suspends/Resumes
You can view or edit the suspend/resume history for a specific prescription.

You can only delete suspensions with future suspend dates.

Resume > Options
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 1.  Use the space bar  to select the applicable prescription.

 2.  Select Extra Functions >   View/Edit Suspends/Resumes.

The Suspensions for Rx [number] window is displayed.

 3.  To edit an existing suspend/resume entry, double click the entry or highlight it and press F2.

The Modify Suspension window is displayed.

 4.  Update the information as applicable, then select OK.

Patient profile commands from the F11 - Drop-Off window
Six key commands can be executed  from the F11 - Drop-Off window. These commands act on the 
highlighted or tagged prescription(s) in the patient profile.

Patient profile commands from the F11 - Drop-Off window > Options
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Command Description
Esc Back to patient.
Space Mark Multiple Rxs
D Detail prescription(s)
Y Copy to new prescription
F Refill prescription(s)
I Inactivate prescription(s)

The following procedure describes how to  copy to a new prescription number (or work order). For 
information on the other commands, see "Patient Profile commands" (page 78).

 1.  Use the space bar  to select the prescription you want to copy to a new prescription number.

 2.  Press Y  or select Y-Copy To New.

The F11-Drop-off window is displayed. It is populated with prescription information from the Rx 
you copied.

 3.  After all of the prescriptions have been copied, select Finalize Work Order or press Enter  to 
move the work order to the input stage.

Patient profile commands from the F11 - Drop-Off window > Options

Kroll User Guide © 2025 TELUS Health 99



Patient sidebar functions
This section describes those sidebar functions on the F3 - Patient window that apply to pharmacies.

Patient sidebar functions > Options
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Alternate Address
Use the Alternate Addresses function to add, edit, or delete a patient's secondary addresses.

 1.  Select  Alternate Addresses from the patient sidebar. 

The Alternate Patient Addresses window is displayed.

 2.  Select Ins. 

The Alternate Patient Addresses window is displayed.

 3.  In the Location field, add a description of the new address, such as summer home or parent’s 
home.

 4.  Complete the rest of the fields as required, then select Save.

Alternate Address > Options
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Appointments
You can use the Appointments function to manage patient appointments. 

 1.  Select Ins.

The Patient Appointment Time Selection window is displayed.

Appointments > Options
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 2.  Select a time slot, then click Select.

The New Appointment window is displayed.

 3.  Enter the appointment information, then select Save.

The appointment is added to the Appointments list.

AR Profile
You can use the AR Profile function to view the patient’s Accounts Receivable information. Accounts 
Receivable is a program that maintains the charges and payments made by customers within the store. 
You can view charges, print statements, and run reports to analyze the impact of the AR program within the 
store.

AR Profile > Options
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Authorized Agents
You can use the Authorized Agents function to view the individuals authorized to act on behalf of a 
patient. These agents must be registered in the system as patients.

Select Ins to display the Authorized Agent window, then select an authorized agent, enter their personal 
information, and select their permissions.

Batches
Batch filling is available to nursing home customers only. You can use it to fill Rxs belonging to a particular 
cycle in a single batch.

To view additional details about a batch, double click it.

Authorized Agents > Options
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Charting
You can use Patient Charting  to monitor and record patient health metrics directly within the pharmacy 
management system. The benefits of charting include the ability to print charts and electronically store 
patient health information in one area for ease of access. 

If an existing chart value has a comment attached, an asterisk is displayed to its right. To display the 
comment, place the mouse cursor over the asterisk.

To add a value:

Charting > Options
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 1.  Select Add other reading > Other, then select the type of charting value you want to add.

The Edit Charting Record popup is displayed. The fields it contains vary depending on the type 
of record you selected.

 2.  Complete the fields, then select Save.

Consents
From the Consent window, you can record whether a patient has provided the pharmacy with the consents 
you have configured.

Consents > Options

106 © 2025 TELUS Health Kroll User Guide



Credit Cards
The Credit Cards section is used to store patient EFT and credit card information. To enter credit card 
information, you must:

 1.  Be assigned to a user group that has permission to view credit card information.

 2.  Have the credit card access password.

Documents
You can use the Documents function to import and attach external files, such as medical forms, 
medication charts and lab results, to specific patient records. The supported formats include .docx, .pdf, 
.xslx, and .jpeg.

ERx Orders
You can use the ERx Orders function to view and action prescription orders that were sent from an 
external application, such as PrescribeIT.

Select Show Outgoing Orders to display the orders that will be sent to the external application.

To view an order, press D, and to process it, press F.

History
You can use the History function to track changes made to the patient record, including changes to third 
party plans, phone numbers, and addresses. The History for Patient window is read-only. It displays 
entries sorted by date and the initials of the user who executed the change. 

Credit Cards > Options
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Select > to expand the details and select it again to hide them.

To view what the patient profile looked like after or before a particular change was made, select a 
change record, then select Display Record After Changes or Display Record Before Changes, 
respectively.

Immunizations
You can use the Immunizations function to manage patient immunizations.

You can use the commands at the top of this section, and those available from Extra Functions button, to 
add immunizations and perform actions on them.

Immunizations > Options
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Outbound Communications
You can use the Outbound Communications function to manage communications with the patient, 
including whether their refill and pickup settings and the language they speak. You can also view their prior 
and pending communications. 

Professional Services
You can use the Professional Services section to manage the medical services that you perform for 
patients, including general counseling, laboratory analyses, and the treatment of minor ailments.

You can use the commands at the top of this section, and those available from Extra Functions button, to 
add services and perform actions on them.

Rx Counseling History
You can use the Rx Counseling History section to record the patient’s Rx counseling sessions. 
Recording these sessions in the patient profile helps pharmacies meet the legal requirements for 
counseling documentation.

Use the Type menu to specify whether you want to view all Rx counseling sessions, or only those sessions 
that have been Accepted, Rejected, or performed on Paper.

Select F2-View to view the information for a selected counseling record.

Outbound Communications > Options
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Rx Notes
You can use the Rx Notes function to view the notes entered for all of the patient's Rxs. These notes are 
entered on the Comments tab of each Rx.

To view a note, double click a record or select it and then select F2.

To Do Items
The To Do section displays all outstanding callbacks and followups for the patient. You can also manually 
insert a to do item for a patient.

Work Orders
The Work Orders section displays all of the patient's outstanding work orders.

Rx Notes > Options
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This section explains how to perform drug searches and how to create and manage drug records.

Searching for a Drug

Method 1: From the F5 - Drug window

 1.  From the Alt-X Start window, select F5 - Drug.

 2.  Enter one of the following patient search criteria, then select Search:

Brand or Generic Name, Strength/Pack Size (e.g. Apo-Metformin, 500/360)

DIN (5-8 digits)

UPC (11-12 digits)

A period (.) and the Drug Quick Code (e.g. TYLE3)

# symbol and the Catalog Item Number (e.g. #78945)

Chapter7

Drug records
Drug records contain comprehensive information about how drugs should be stored, administered, handled, and priced.
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 3.  Double click the drug record. 

TheF5 - Drug window is displayed.

Method 2: From the Alt - X Start window
 1.  From the Alt - X Start window, enter any of the search criteria described in the previous section, 

then select F5 - Drug.

The list of matching drugs is displayed. 

Method 2: From the Alt - X Start window > Method 1: From the F5 - Drug window
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 2.  If the criteria you entered matches a single drug, it is displayed. If it matches multiple drugs, a list 
of drugs is displayed. Double-click the applicable drug.

 3.  TheF5 - Drug window is displayed.

Method 3: From the F11 - Drop-Off window
 1.  From the  F11 - Drop-Off window, search for and select the applicable patient. 

 2.  In the Drug/Mix field, enter any of the search criteria described in "Searching for a Drug" (page 
111) in the Drug Search field and press Enter.

 3.  If the criteria you entered matches a single drug, it is displayed. If it matches multiple drugs, a list 
of drugs is displayed. Double-click the applicable drug.

The F5 - Drug window is displayed.

Method 3: From the F11 - Drop-Off window > Method 1: From the F5 - Drug window
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Performing an Advanced Drug Search
If you cannot locate a drug  through a regular drug search described earlier, you can complete an 
Advanced Drug Search.

 1.  From the F5 - Drug search window, select Advanced. 

The Advanced Search pane is displayed.

 2.  Enter your search criteria and select Search.

 3.  To locate an inactivate drug, select the  Only Inactive or All checkbox.

Inactive drug records are displayed in red text in the drug search window.

Inactive drug records
There are several reasons you may choose to inactivate drug records. For example, you may inactivate a 
drug  because the manufacturer no longer produces that particular pack size, or because the drug has been 
discontinued. Inactivating these records ensures the regular search provides more succinct results and 
reduces the chances the wrong drug pack is selected for a prescription. Inactivated drug records are not 
returned in the regular drug search; you must locate them using the Advanced search.

Inactive drugs cannot be used in prescriptions.

Performing an Advanced Drug Search > Method 1: From the F5 - Drug window
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To inactivate a drug record, deselect the Pack Active checkbox in the drug record:

Creating a new drug record
 1.  Perform a thorough search to ensure the drug does not already exist. You will be prompted to 

perform an Advanced search for inactive drugs.

 2.  Once you have determined the drug does not exist in the system, select Insert or press the 
Insert key.

 3.  Enter a pack size for the new drug and select OK.

A blank F5 - Drug window is displayed. 

 4.  Complete the drug fields and select Save.

Creating a new drug record > Method 1: From the F5 - Drug window
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Copying an existing drug record
When a drug manufacturer releases a new strength for an existing drug product, you can copy the existing 
drug rather than re-entering duplicate drug information. 

 1.  Perform a thorough search to ensure the drug does not already exist. You will be prompted to 
perform an Advanced search for inactive drugs.

 2.  When you have determined the drug does not exist in the system, select Copy Drug or press 
CTRL+Y.

A second drug search window is displayed.

 3.  Search for the drug that should already be in the system.

 4.  Highlight the drug you want to copy and click Select.

The selected drug record is displayed. 

 5.  Review the record and ensure it is the drug you want to copy. 

 6.  Click Select.

 7.  Enter a pack size for the new drug and select OK.

A prompt appears, asking if you want to copy the price information to the new drug. 

 8.  Select Yes.

 9.  Enter any missing information for the new drug record. 

The DIN is not copied over.

 10.  Select Save.

Copying an existing drug record > Method 1: From the F5 - Drug window
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Drug Record fields
Name Description
Name The name of the drug.
DIN The Drug Identification Number for the drug product, or one of the following values: 

“PDIN – Pseudo DIN”, “ NPN – Natural Product Number”, “HDIN – Homeopathic 
DIN”, or “OPIN – OPINION”.

Generic If the drug record is a generic product, this field displays the brand name equivalent.
Strength The strength of the drug.
Sched The drug schedule.
Description, 
Description 2

The description of the drug.

Followup 
(Days)

The number of days that will elapse before a follow-up reminder is created  to remind 
the pharmacist to follow up with the patient regarding their drug treatment.

Oral/Written Whether the drug requires an oral or written prescription.
Form The form of the drug product, such as capsule, tablet, or injection.
Equivalent To The brand name equivalent of the drug product being dispensed. 
Route The route of administration for the drug product, such as oral, topical, or intravenous.
Default SIG Used to quickly populate the Rx with a repeatedly used sig code.
Manufacturer The manufacturer of the drug product, such as Astra or Pfizer.
Location Store level users can enter information about the physical location of a drug product 

in this field to facilitate its retrieval (e.g. refrigerator, safe.)
Handling Instr. The handling instructions for a drug product (e.g. sublingual tablets should be 

handled with clean dry hands).
Generic Type One of the following:

Brand Multi Source Brand

Brand Multi Source Generic

Brand Single Source

Generic Multi Source

Generic Single Source
Priority The priority of the drug.
Price Group The price group assigned to the drug, for activation of specific pricing requirements. 

Drug Price Groups are configured and assigned by head office.
Department The department the drug belongs to.

Drug departments are used to narrow report output to certain clusters of drugs. They 
are similar to drug groups, but a drug record can only belong to one drug department 
(which maintains mutual exclusivity between departments), whereas a drug record 
can belong to multiple drug groups.

Drug Record fields > Method 1: From the F5 - Drug window
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Name Description
Marketing 
Msg.

The marketing message for the drug. 

Marketing messages promote and support awareness for certain products, and 
facilitate branding of the business. They are printed on the patient receipt whenever a 
prescription is filled for the drug. For example, if a pharmacy is holding a diabetes 
clinic, a message about this clinic can be attached to diabetic drugs and supplies.

Marketing messages are configured by the head office. 
Fee for Svc. If a value is selected, the drug record is being used to bill a professional service. 

Some types of professional service billings require specific indicators to be sent to the 
third party in order for the claim to go through; by selecting the appropriate Fee for 
Service option in the drug record, billing indicators are automatically sent with the 
prescription during adjudication.

Fee For Service entries are configured  by the head office.
Drug line 1 The type of drug information (i.e. Brand, Generic, Description, Description 2, 

Equivalent To) that is printed on the vial label.
Drug line 2 The type of drug information, different from Drug Line 1, that is printed on the vial 

label.
Half-siz Sig

 

If selected, the SIG is printed at half its usual size. This option is useful for drug 
products that usually have long SIG instructions, such as eye drops.

Track Lot Num If selected, you must enter the lot number of the drug product into the Motorola 
handheld during the filling stage.

Track Expiry If selected, you must enter the expiry date (MM/YYYY) of the drug product into the 
Motorola handheld during the filling stage.

Double Count If selected, the quantity of the drug must be counted twice.
Refrigerated If selected, the word “Refrigerated” appears on the handheld during filling and at point 

of sale, during the prescription pick up stage.
Drug Sub Select this button to link the drug record to an interchangeable substitute. When a 

Drug Sub is selected, you will be prompted to use the substitution when inputting a 
prescription.

Drug Card 
Type

The type of drug record if it is not for a standard drug (default). For example, device or 
vaccine.

Reportable If selected, the system tracks prescriptions filled for the drug product and display 
results in the Narcotic report.

Trial If selected,  during the first fill of a prescription, you are asked if you would like to fill a 
trial supply instead of the total dispense quantity of the prescription.

Dispense as 
Pack

If selected, the drug product is billed to third parties as multiples of one pack instead 
of doses. This checkbox is used in some provinces for billing birth control, inhalers, 
and nasal sprays.

Ward Stock Used by pharmacies that dispense ward stock to patients.
Rx Sync If selected, this drug is included when  the refill due dates are synchronized, so the 

patient makes only one trip to the pharmacy to pick up their prescriptions, rather than 
separate trips per prescription. 

Drug Record fields > Method 1: From the F5 - Drug window
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Name Description
Print 
compliance 
calendar

If selected, a calendar of empty boxes appears for the patient to use to document the 
doses they have taken.

Eligible for 
Coupon

If selected, the configured coupon is printed when the  prescription is filled.

Coupons are configured  by home office
Flavor Rx If selected, flavoring should be used to augment the taste of the medication. A note is 

printed on the hardcopy to remind users to use flavoring when preparing of the drug.
Class The therapeutic class code from First Data Bank.
Clinical Form The clinical form of the drug product from First Data Bank.
Comments Any comments about the drug record.

Comments are entered from the Comments pop-up:

If Show on Rx is selected, the comment is displayed on the F12 - Fill Rx 
window.

If Print on Hardcopy is selected, the comment is printed on the hardcopy portion 
of the Rx label. Only one drug comment can be flagged on the hardcopy due to 
limited space.

If Alert is selected,  the comment will pop up every time the drug card is accessed.
Groups The group or groups the drug belongs to, if applicable.

Drugs can be included in a group for a wide range of reporting purposes.  For 
example, a drug group called “Diabetic Supplies” could be attached to a drug record 
for diabetic supplies. 

Drug Groups are created by head office and can be applied to any number of drug 
records.

View Reason 
Codes

Select to display Reason Codes and Reason Code descriptions for Limited Use 
products. You can also print Reason Code information from the window.

This button is only applicable to Ontario pharmacies.

Drug Record fields > Method 1: From the F5 - Drug window
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General
The General tab displays general information about the cost and quantity of the selected drug.

The following table describes the fields on this tab.

Name Description
Packs (#) The pack sizes available for the drug product (in Ontario, this area also displays ODB 

pack sizes). When a drug pack is highlighted, its information is displayed to the right.
Pack 
Active

If selected, the pack size is in current or recent use. If deselected, the pack size has been 
discontinued or is no longer in use. Inactive drug packs are not returned using the regular 
search; they must be located via the advanced search.

Front Store If selected, the product is available over-the-counter.
Quick 
Code

A short name for the drug record, for use during searching (e.g. T3 for Tylenol with 
Codeine #3). Note: when searching for a drug by its quick code, the code must be 
preceded by a period (.).

Chapter8

Drug information tabs
The following sections describe the tabs at the bottom of the drug record.
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Name Description
Only allow 
manual 
price 
changes

If selected, pricing fields are not updated when updates are run against the drug card.

Purchase The cost of the drug product when it is purchased from the vendor (i.e. acquisition cost). 
System pricing strategies may use the value of this field.

Default 
Vendor

The vendor of the drug product.

Selling The cost of the drug as it is sold to the patient.
On Hand The number of days' worth of medication currently available for dispensing. 
User Cost 
1, 2, 3, 4, 
and 5

The pricing strategy for the drug.

Min Qty A number representing the minimum allowable quantity for a drug product before a 
reorder is triggered. For example, if the minimum quantity is set at 100, when the amount 
on hand drops below 100 units, the drug pack is placed on order. 

The Days field display the minimum number of days’ supply that triggers reordering and is 
related to Min Qty through a calculated formula.

 Min Qty is required for perpetual inventory.
Max Qty Is used to calculate how much of the drug product should be reordered.

For example, if a drug pack has a Max Qty set to 300, the system will order enough so 
that the current amount on hand reaches 300 units.

The Days field displays the maximum days’ supply a store should have on hand and is 
related to Max Qty through a calculated formula. 

Max Qty is optional for perpetual inventory; when the field is empty the system will always 
order 1 package of the drug pack.

UPC The drug pack's UPC. If there is more than one UPC for the drug pack, the UPC marked 
as “default” is displayed here.

Lot The lot number of the drug product. This field cannot accept multiple lot numbers.
Expiry Date The expiry date (DDMMYYYY) of the drug, or the number of Days that the drug is good 

for once it is dispensed. The expiry date is printed on the vial label. This field cannot 
account for multiple expiry dates.

(Drug 
picture)

A photo of the drug. Drug pictures are provided via periodic updates from central 
maintenance.

Markup 
Percent

The percentage of markup applied to the drug.

General >
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Ordering
The Ordering tab displays information  related to drug ordering.

The following table describes the fields on this tab.

Name Description
Packs (#) The pack sizes available for the drug product (in Ontario, this area also displays ODB 

pack sizes). When a drug pack is highlighted, its information is displayed to the right.
Available 
Vendor Items

The default vendor of the drug product, as well as its catalog information.

No Inventory 
Adjustment

If selected, the On Hand field is not adjusted when the drug is dispensed, nor is it 
adjusted when the product is received into the system; in other words, the On Hand 
field remains static. 

You might use this checkbox for OTC products that you create a “Not Dispensed” 
prescription for because you want the prescription in the patient’s medication history, 
but you do not want to deduct inventory from the drug record for it.

Disable 
Automatic 
Ordering

If selected, the drug is not included in the automatic order even if the On Hand quantity 
is less than the Minimum. You might select this checkbox for expensive products you 
want to order on demand rather than through the automatic ordering system.

On Hand The current amount of medication available for dispensing. This field is also displayed 
on the General tab.

Ordering >
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Name Description
Base 
Ordering On

Reordering can be based on Min/Max or Usage/Days Supply (default). In both 
scenarios, if automatic ordering is activated, a drug product is placed on order when 
the On Hand value drops below the Minimum value. When Min/Max is selected, the 
Days Supply fields are greyed out, and vice-versa.

Use Min/Max ordering if you want to control the exact point at which a drug is 
reordered. The Min/Max values do not change once they are set because the values 
are independent of usage, which means you need be aware of drug usage and adjust 
these values as needed. Min/Max ordering is particularly useful for drugs that the 
pharmacy wishes to under-stock or overstock. 

Use Usage (Days Supply) ordering if you want your reorder drug points to be dynamic 
values that increase or decrease depending on how often the drug is dispensed within 
the days supply indicated. This is particularly useful for cyclical drugs like allergy 
medications, which are dispensed frequently during some parts of the year and less 
during other parts. The minimum and maximum values are not open for manipulation 
as they are calculated values; this may result in less control over the exact point the 
drug is ordered.

Min Scripts 
Calc

Script quantity can be based on Maximum Rx Quantity or Average Rx Quantity.

Minimum and 
Maximum

The minimum and maximum Qty or Days' worth of the drug to maintain.

Order in 
Multiples of _
__ pack(s)

This field is useful for products that are dispensed in multiple packs, such as birth 
control.

Outstanding 
Orders

A row is added to this table when a drug product has been ordered and is on its way to 
the pharmacy, or is in the process of being ordered.

If a row is displayed in this table, the drug product will not be ordered even when the 
On Hand is below the minimum required. This rule prevents the system from 
duplicating orders for drug products.

Place Order Select this button to add a manual order for the drug; this manual order is added to the 
automatic order when it is generated. This function is  used when the pharmacy wants 
to order more of a product even though the On Hand quantity is greater than the 
minimum. It is also used to future-date a drug order so that the drug product will be 
placed on order on the date specified. This is useful for drug products that have short 
expiries or are costly to stock in advance of dispensing.

For more information, see "Order Drug" (page 129).
Order 
Grouping

Select this button to create reorder points for a drug grouping. By grouping 
interchangeable drugs, Kroll will reorder the primary assigned pack when stock 
depletes from each drug in the group.

Usage Values 
section

The fields in this section display a succinct snapshot drug movement in terms of daily 
usage, average Rx quantity, and maximum Rx quantity. Usage values help users to 
make optimal decisions on replenishment.

Ordering >

123 © 2025 TELUS Health Kroll User Guide



UPCs
The UPCs tab displays all of the UPCs listed for the selected drug pack. To view the UPCs that correspond 
to a specific pack size, highlight the applicable drug pack on the right hand side. 

UPCs are centrally maintained; as such, please communicate any errors to TELUS Health support for 
correction.

The UPCs listed in this view are used to verify that the correct product is being used to package an Rx at 
the filling stage.

Plans
The information displayed on the Plans tab is centrally maintained by head office.

This tab serves two purposes:

It displays formulary coverage for the drug product. From this tab, you can locate the entry for the 
provincial plan (in this case ODB for Ontario) and see if the drug product is covered. Provincial 
coverage is updated regularly through formulary updates to the system.

UPCs >
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It contains the Pseudo DINs that are adjudicated to third parties for reimbursement. To view the details 
of a pseudo DIN, double click the applicable row, or highlight it and press F2. This displays the Drug-
Plan Information window, where detailed pseudo DIN information is displayed.

From the Drug-Plan Information window, you can see which pack sizes the pseudo DIN is being 
applied to. If the Default checkbox is selected, the pseudo DIN is automatically sent to the third party 
during adjudication; if it is not selected, the DIN on the drug record is sent to the third party rather than 
the pseudo DIN.

If Covered is selected, the third party plan will pay for the drug product. This checkbox is for 
informational purposes only.

Usage
The Usage tab displays information regarding how often and in what volume a drug product was dispensed 
within a specific time period. This information helps you to determine if current ordering points (i.e. Min/Max 
values) support optimal replenishment. 

The graph on the Usage tab displays how many prescriptions have been filled for the drug product and the 
total drug quantity dispensed monthly. Use the Year dropdown menu to specify a date range.

Usage >
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Old Costs
The Old Costs tab displays pricing changes made to any of the seven price fields on the General Tab of 
the drug record. Refer to this tab to identify when, why and by whom a price change was made.

Counseling
The Counseling tab displays patient counseling messages from the First Data Bank (FDB) clinical drug 
module. Counseling messages are divided into Patient Messages and Professional Messages.

Old Costs >

Kroll User Guide © 2025 TELUS Health 126



Kroll Care
The Kroll Care tab displays the Drug Information Monograph that is printed out and handed to the patient 
during the prescription filling process. The content of Kroll Care is provided by the First Data Bank (FDB) 
clinical drug module. To print this monograph on demand, select Print Kroll Care from the drug sidebar, or 
select  Drug > Print Kroll Care from the menu.

Other tab
The Other tab displays miscellaneous information about the drug record.

The following table describes the fields on this tab.

Name Description
User Field 1, 2, and 3 These fields are used if configured via Central Maintenance 

Configuration.
Created On The date and time the drug record was created.
Changed On The date and time the drug record was last changed.
Refill/Renewal Reminders 
Allowed

Whether refill and renewal reminders are allowed.

Kroll Care >
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Chapter9

Drug sidebar functions
The drug sidebar is available to the right of the Drug window whenever a drug record is displayed. 
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Order Drug
The Order Drug function is   used to create a manual order when the pharmacy wants to order more of a 
product even though the On Hand quantity is greater than the minimum. It is also used to future-date a 
drug order so that the drug product will be placed on order on the date specified. This is useful for drug 
products that have short expiries or are costly to stock in advance of dispensing. Your manual order is 
added to part of the automatic order when it is generated.

 1.  Select Order Drug.

You an also select the Place Order button on the Ordering tab. 

The Place Order window is displayed.

 2.  Select the Vendor.

 3.  Enter the Order Quantity and  Order Date. 

 4.  Select Save.

Order Drug >

129 © 2025 TELUS Health Kroll User Guide



Receive Drug
Use the Receive Drug function when you want to add drugs to your pharmacy’s drug inventory. When 
drugs are received into the system, the on hand quantity for that drug is updated accordingly.

 1.  Select Receive Drug.

The  Receive a Drug window is displayed. 

 2.  Enter the number of Packs received, the Lot Number, and the Expiry Date.

 3.  Select Save.

Receive Drug >
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Returning to stock
Use the Return to Stock function to return stock to the inventory.

 1.  Select Return to Stock.

The following pop-up is displayed.

 2.  Enter the Qty to return to stock and select a Reason, if applicable. 

 3.  Select Save.

Print Kroll Care
Kroll Care is an informational printout that is provided to patients upon receiving their prescribed 
medication. The content of Kroll Care is provided by the First Data Bank (FDB) clinical drug module. 

Returning to stock >
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Select Print Kroll Care to generate this printout.

Print Kroll Care >
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Alerts
Alerts are messages about drug products. They are printed along with Kroll care and distributed to the 
patient as additional drug information. The number in brackets next to the type of alert identifies the number 
of alert messages for the drug product.

Drug alerts are added by head office and can be found under Edit ˃  Lists ˃  Drug Alerts.

Select the Alerts button to read the details of the message. 

 

Documents
Use the Documents function to manage the attachments pertinent to a specific drug.

Generic Equivalents
Use the Generic Equivalents function to view a comprehensive list of generic equivalents for a drug 
product. In Alberta and British Columbia, the Generic Equivalent list is maintained by First Data Bank 
(FDB) Updates, whereas in the rest of the provinces, the Generic Equivalent list is maintained by 
Provincial Formulary Updates. Highlight a generic equivalent entry and click Select or press Enter to 
display the corresponding drug record. Each entry displays the following information:

Preferred Brand Indicator (1 = Preferred; 2 = 2nd Preferred, etc.)

DIN

Drug Name

Manufacturer

Unit Cost (Acquisition Cost ÷ Pack Size)

On Hand quantity (Allows users to quickly see what brands are stocked)

Extra Info: any applicable comments

Alerts >
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Modification History
Use the Modification History function to display a read-only record of the changes made to the drug 
record. For example, if inventory is missing or overstated in the drug record, you could display the 
Modification History to view what changes were made to the On Hand field.

Select the plus sign (+) to expand the details or  the minus sign (-) to hide them.

To view what the drug record looked like after or before a particular change was made, select a change 
record, then select Display Record After Changes or Display Record Before Changes, respectively.

Modification History >
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Old/New DIN Links
DIN links appear for drug products that have had a DIN change. They link the old DIN to the new DIN so 
that the system recognizes that both DINs are for the same product. You cannot create a DIN Link, but you 
can remove one by highlighting it and selecting Del or pressing Delete.

DIN links are centrally maintained by head office.

Order History
Use the Order History function to see when a drug product was placed on order (i.e., InitPO), sent (i.e., 
Ord), and received (i.e., Rec). You can use this information to help determine the root causes of ordering 
issues and discrepancies. To display the order history for different packs, change the  Pack Size. 

Reason Codes
The Reason Codes function is only applicable to pharmacies operating in the province of Ontario and for 
drug products that are eligible to be billed to the provincial plan (ODB) using Limited Use (LU) Codes. Use 
the Reason Code sidebar function to view all codes, descriptions, and expiries for the LU drug. To print 
these codes, select Print or press CTRL+P.

Old/New DIN Links >
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Mixture records are composed of two or more drug records. The drug records within a mixture are referred 
to as “components”. 

Searching for a Mixture

Method 1: From the F5 - Drug window

 1.  From the Alt-X Start window, select F5 - Drug.

 2.  Select Mixture, then  enter one of the following search criteria in the Search Criteria field:

 a.  The name or description of the mixture.

 b.  The full or partial names of each component in the mixture, separated by commas, in 
any sequence. For example, to search for “Hydrocortisone 1% Powder in 
Clotrimaderm 1% Cream” you could enter “hydro, clot” or “clot, hydro”.

 c.  If a quick code has been assigned to the mixture, a period (.) followed by the quick 
code.

 d.  An asterisk (*), if you want to display all mixtures.

Chapter10

Mixture records
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 3.  Double-click the mixture record. 

The F5 - Mixture window is displayed.

Method 2: From the F11 - Drop-Off window
 1.  From the F11 - Drop-Off window, search for and select a patient.

The Drug/Mix field become available.

Method 2: From the F11 - Drop-Off window > Method 1: From the F5 - Drug window
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 2.  Enter any of the search criteria described in the previous section in the Drug Search field and 
press Enter.

The matching mixtures are displayed. 

 3.  Double-click the applicable record. 

The F5 - Mixture window is displayed.

Performing an advanced mixture search
 1.  From the F5 - Drug search window, select Mixture and Advanced.

The Advanced Search pane is displayed.

 2.  Enter your search criteria, then select Search.

 3.  To locate an inactivate drug, select the  Only Inactive or All checkbox.

Inactive drug records are displayed in red text in the drug search window.

Performing an advanced mixture search > Method 1: From the F5 - Drug window
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Inactive mixture records
You can inactivate mixture records if they become obsolete or are no longer used.  Inactivating these 
records ensures the regular search provides more succinct results and reduces the chances the wrong 
drug pack is selected for a prescription. Inactivated mixture records are not returned in the regular mixture 
search; you must locate them using the Advanced search.

Inactive drugs cannot be used in prescriptions.

To inactivate a mixture record, deselect the Active checkbox in the mixture record:

Recommended mixture naming conventions 
When creating a new mixture record, it is recommended that you use the following naming conventions:

 1.  List the ingredients in the following sequence:

 a.  active ingredient(s), sequenced from highest to lowest concentration

 b.  base ingredient(s), sequenced from highest to lowest proportion

 2.  Insert percentages/ratios after the name of a component (e.g. “Hydrocortisone Powder 1%”, 
rather than “1% Hydrocortisone Powder).

 3.  Spell out the full component names and forms when possible. If there is insufficient room, 
abbreviate the names in the following sequence, as needed:

 a.  form

 b.  base components

 c.  active components

Whenever possible, enter mixture proportions by percentage so the system can automatically calculate 
how much of each component is needed to make the mixture, regardless of dispense quantity.

Inactive mixture records > Method 1: From the F5 - Drug window
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Creating a mixture record
Mixture records are added and maintained by store-level users, not the central system, which makes 
understanding them especially important. Avoid adding a mixture record without performing a thorough 
search of the system; duplicate mixture records cause confusion for the pharmacy and potentially for the 
patient.

If, during mixture creation, you discover that a mixture component is inactive, you will have to 
open a new Kroll session to reactivate or add the component before you can continue creating 
the mixture record.

 1.  Perform a thorough search to ensure the mixture does not already exist. You will be prompted to 
perform an Advanced search for inactive drugs.

 2.  Select or press Insert.

A blank F5 - Mixture window is displayed. 

 3.  Complete the mixture fields and select Save.

Creating a mixture record > Method 1: From the F5 - Drug window
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Inserting Mixture Components
A mixture record is not complete without the addition of mixture components. In fact, users cannot save a 
mixture record until components have been selected.

 1.  From the Mixture card of the mixture you want to add components to, select Ins or press Insert 
from the Components pane.

 2.  Perform a drug search. Highlight the applicable component and click Select.

The Compound Component form is displayed. 

 3.  Select Add.

 4.  Repeat steps 2-3 for each component you want to add to the mixture. When you have finished 
adding components, click Close to exit the drug search window.

Inserting Mixture Components > Method 1: From the F5 - Drug window
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 5.  The drug components will appear in the Components pane. Click Save to save the mixture 
record.

Inserting Mixture Components > Method 1: From the F5 - Drug window
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Mixture information tabs
The following sections describe the tabs at the bottom of the mixture record.

General
The General tab displays general information about the selected mixture.

The following table describes the fields on this tab.

Name Description
Enter 
Proportions 
by

Select the best, or most applicable, way to enter the proportions of the mixture.

Whenever possible, select Percentage (i.e. ratios) to enter mixture proportions, so 
the system can calculate how much of each ingredient is required to compound 
any dispensing quantity. The Base Quantity for mixtures entered in percentage 
proportions is always equal to 100.

If you select Units, you must indicate the quantity being prepared in the Base 
Quantity field so the system to correctly calculate how much of each ingredient is 
required for compounding.

Select Bags/Capsules when entering I.V. bags or pharmacy prepared capsules. 
In the Base Quantity field, enter the number of bags or capsules being prepared 
so the system to can calculate how much of each ingredient is required for 
compounding.

Base Quantity The physical quantities of the mixture components, as described above.
Form The physical state of the mixture, such as liquid, powder, or vaccine.
Route of 
Admin

How the mixture must be administered, such as injection, topical, or oral.

Schedule The drug schedule of the mixture if it contains a controlled component.
Oral/Written Whether the mixture requires an oral or written prescription.
Mix Type The mixture type, as required for adjudication purposes.
Price Group The price group, if the mixture requires special pricing.

Price groups are created by the head office.
Default Sig The SIG, if the mixture is always dispensed with the same SIG instructions.

The default SIG can be overridden when the prescription is being filled.

Mixture information tabs > Method 1: From the F5 - Drug window
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Name Description
Provincial PIN The pseudo DIN the mixture is covered by.

Each province’s provincial plan covers certain mixtures that have assigned pseudo 
DINs (PINs) .

Expiry (Days) The number of days the mixture is good for once it has been compounded, if 
applicable. The systems calculates and prints an expiry  date on the vial label.

Active If deselected, the mixture record is no longer being used in any active prescriptions, or 
is obsolete.

Reportable If selected, the  mixture contains a narcotic component;  the mixture will be tracked in 
the Narcotic Report.

Refrigerated If selected, the mixture requires refrigeration. A message appears during the filling 
stage to remind you that the mixture needs to be stored in a refrigerator subsequent to 
preparation.

Methadone If selected, the record is a methadone mixture, and the “carries” and other methadone-
related dispensing functions are activated.

Mixture Time Use the mixture time chart  to configure the Mixture Fee that will be charged to the 
patient, based on the amount of mixture being dispensed. You can add up to five 
mixture tiers. 

If you selected Bag/Capsules as the method of entering proportions, a single Charge 
(Minutes) field is displayed.

If you selected Percentage or Units as the method of entering proportions, a table is 
displayed. Each row in the table represents a pricing tier:

The first row represents the minimum mixture fee charged to the patient. The Rx 
quantity should equal zero because any dispense quantity greater than zero 
requires a minimum base fee to be charged.

The second row represents the second tier for the mixture fee. The Rx quantity 
entered here should be the threshold value where making more than that quantity 
will mean graduating to the next tiered fee.

The last entry  (the final pricing tier) represents the maximum mixture fee charged. 
Any dispense quantity greater than the Rx quantity listed here will charge the 
maximum mixture fee only.

For more information, see "Setting the minimum and maximum mixture fees" (page 
150) .

Instructions
The Instructions tab records any special instructions that must be followed when compounding the 
mixture (e.g., heating time, use of mixing solutions).

Instructions > Method 1: From the F5 - Drug window
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The following table describes the fields on this tab.

Name Description
Handling 
Instructions

Any instructions that must be followed when preparing the compound.

Batch 
Quantity

The volume of the batch.

If a mixture is dispensed frequently, batch quantities of it may be compounded at the 
store level. The system will deduct quantities dispensed against the value entered 
here. This is the equivalent to the On Hand value for a drug record.

Print 
Instructions 
at Fill

Whether you want instructions to print when the Rx for the mixture is filled (Never, 
Always, or Prompt).

Print both 
Batch and Fill 
Instructions

If selected, both batch and fill will be printed when an Rx for the mixture is filled or 
batched.

Add 
Component 
Names to 
Instructions

If selected, the names of the mixture components listed in the box to the left are 
included in the instructions field.

Comments
The Comments tab displays general comments about the record.

 1.  To insert a new comment, select Ins or press Insert. 

The Comments pop-up is displayed. 

Comments > Method 1: From the F5 - Drug window
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 2.  Select a Topic and enter your comment.

 3.  To show the comment when filling a prescription, select Show On Rx.

 4.  To show a pop-up message during filling that indicates a comment is present, select Alert.

 5.  To include the comment on the hard copy prints during filling, select Print On Hardcopy

This checkbox can only be selected for one comment, as there is limited space on the hardcopy.

 6.  To display a comment during one or more steps in the workflow, select the Edit button adjacent 
to Workflow Alerts, then select one or more workflow steps and select OK.

 7.  Select Save.

Plan
The Plan tab displays the Pseudo DINs that are adjudicated to third parties for purposes of 
reimbursement. Mixture Pseudo DINs must be added and maintained by store-level users.

Plan > Method 1: From the F5 - Drug window
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To add a new plan, select Ins or press Insert. 

The Mixture-Plan Information form is displayed.

The following table describes the fields on this pop-up.

Name Description
SubPlan The third party plan associated with the pseudo DIN from the dropdown menu.
Description A general description or a note associated with the pseudo DIN. If no value is entered, 

the value is set to Default.
Default If selected, the system automatically sends the pseudo DIN to the third party plan 

whenever an Rx is processed for the mixture. This is selected by default.
<Unnamed 
DIN fields>

The first field lists the type of DIN, and the second contains the 8-digit drug 
identification number.

Covered If selected, the associated third party covers the costs of the medication.

Plan > Method 1: From the F5 - Drug window
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Name Description
Mix Type If selected, the third party plan requires submission of a Mix Type that differs from 

what is set on the Mixture Record. This field is commonly used for Methadone 
mixtures billed to Green Shield.

Bill As Pack If selected, the mixture needs to be billed to the third party by packs rather than by 
units.

Fee Schedule The fee category the mixture will be billed as to the third party plan. 
Intervention The applicable intervention code.

Other
The Other tab displays information about when the mixture was created, last changed, and last used in an 
Rx. It also lists the groups to which the mixture belongs.

The following table describes the fields on this tab.

Name Description
Groups The groups the mixture belongs to.

Mixtures can be included in a group for reporting or dispensing purposes. For 
example, a group called “Methadone” might be attached to all methadone mixture 
records. 

Mixture groups are created by head office. 

To add a group, select Ins, then move groups from Available Groups to Selected 
Groups.

Track Mixture Lot 
Number when 
Packaging

If selected, the lot number for each component must be entered/scanned during 
mixture packaging verification (filling).

Track Mixture 
Expiry Date when 
Packaging

If selected, the expiry date for each component must be entered/ scanned during 
mixture packaging verification (filling).

Require 
Ingredient 
Confirmation 
when Packaging

If selected,  the UPC for each component must be scanned during mixture 
packaging verification (filling).

Other > Method 1: From the F5 - Drug window
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Name Description
Refill/Renewal 
Reminders 
Allowed

Whether refill and renewal reminders are allowed.

Refill Reminder 
Rx Default

Whether refill reminders for this drug are enabled by default. If set to Yes, refill 
reminders are automatically sent, and if set to No, they are not. If set to Prompt, 
the user is asked if the Rx qualifies for refill reminders.

Created On The date the mixture record was created.
Changed On The date the mixture record was last modified.
Last Rx On The date an Rx was last filled for the mixture.

Mixture pricing
Mixture pricing is calculated using the following elements:

Price/Minute: the dollar amount charged for each minute of mixture time.

This value is centrally maintained according to provincial standards.

Mixture Fee: this is calculated based on the quantity dispensed in the prescription.

This value is derived from the Mixture Time Chart on the mixture record. 

Cost of the components: the cost of each component.

This is derived from acquisition cost for mixture components (drug records). Acquisition cost is 
maintained through invoice receiving or catalogue feeds.

Markup Strategy: the amount added to cover overhead and profit.

This is set by home office and centrally maintained.

Mixture pricing > Method 1: From the F5 - Drug window
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Setting the minimum and maximum mixture fees
From the mixture record, refer to the Mixture Time chart.

The first line of the chart identifies the minimum fee charged for the mixture; in the chart above, even if 
the pharmacy makes one gram (1g) of mixture, a minimum of 8 minutes is charged. 

The last line of the chart identifies the maximum fee charged for the mixture; in the chart above, even if 
the pharmacy makes 1,000g of mixture, a maximum of 16 minutes will be charged.

The lines (or tiers) in-between the minimum and maximum charge account for prescriptions where the 
dispense quantity lies between the two barrier points. In the chart above, if a prescription has a 
dispense quantity of 100g, 10 minutes of mixture time will be charged.

For more information on these fields, see "General" (page 143).

Setting the minimum and maximummixture fees > Method 1: From the F5 - Drug window
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Setting a flat mixture fee
If the mixture fee should not vary, regardless of the amount dispensed, enter a flat fee. To set a flat fee, 
enter a single line in the Mixture Time chart. For example, in the following chart, any dispense quantity 
greater than zero will be charged 8 minutes of mixture time.

Displaying the mixture breakdown
When you are filling a prescription for a mixture, it is recommended that you review the Mixture 
Breakdown before adjudicating the Rx. The Mixture Breakdown shows the exact dollar amounts for each 
of the elements in the mixture.

Setting a flat mixture fee > Method 1: From the F5 - Drug window
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 1.  From the F12 window, all prescription information should be entered and populated:

 2.  From the prescription sidebar, select Mixture Breakdown, or press ALT+V+M. 

The Mixture Breakdown pop-up is displayed.

The following table describes the fields on this pop-up.

Name Description
Total Base Cost The total acquisition cost of all components.
Embedded Markup and 
Rx Markup

These values are centrally maintained.

Dispensing Fee The regular and customary Rx dispensing fee.

This value is centrally maintained.
Mixture Fee This is based on the Mixture Time chart and the quantity dispensed
Mixture Minutes Used to calculate the Mixture Fee.
Rx Quantity The quantity to be dispensed for the Rx.
Total The total cost of the mixture.
Print Mixture Instructions Select to comments from the Instructions tab of the mixture record as 

well any other information.

Displaying the mixture breakdown > Method 1: From the F5 - Drug window
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Searching for a prescriber record

Method 1: From the F7 - Doctor window

 1.  From the Alt-X Start window, select F7 - Doctor.

 2.  Enter one of the following prescriber search criteria, then select Search:

Last name, first Name.

For example, one of the following: “Doe, Jane”, “doe,j”, “Doe”, or “,Jane” 

A period (.) and the patient quick code.

For example, ".DoeJ”

A 7 or 10-digit phone number.

For example, "800-263-5876" or "263-5876"

A number sign (#) and the third party billing number.

For example, "#123456789"

An asterisk (*) to return all of the patients in the database.

Chapter11

Prescriber records
Prescriber records contain the contact details, licence numbers, and other information about prescribers
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 3.  Double-click the prescriber record. 

The F7 - Doctor window is displayed.

Method 2: From the Alt - X Start window
 1.  From the  Alt - X Start window, enter any of the search criteria in the previous section into the 

Universal Search Field.

 2.  Select F7 - Doctor.

Method 2: From the Alt - X Start window > Method 1: From the F7 - Doctor window

154 © 2025 TELUS Health Kroll User Guide



 3.  If the criteria you entered matches a single prescriber, they are displayed. If it matches multiple 
prescribers, a list of prescribers is displayed. Double-click the applicable prescriber.

The F7 - Doctor window is displayed.

Method 2: From the Alt - X Start window > Method 1: From the F7 - Doctor window
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Method 3: From the F11 - Drop-Off window
 1.  From the F11 - Drop-Off window, search for and select a patient.

The Doctor field is enabled.

 2.  In the Doctor field, enter any of the search criteria described in the previous section, then press 
Enter.

 3.  If the criteria you entered matches a single prescriber, they are displayed. If it matches multiple 
prescribers, a list of prescribers is displayed. Double-click the applicable prescriber.

Performing an advanced prescriber search
 1.  From the F7 - Doctor search window, select Advanced. 

The Advanced Search pane is displayed.

 2.  Enter the applicable search criteria, then click Search.

Method 3: From the F11 - Drop-Off window > Method 1: From the F7 - Doctor window
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Inactive prescriber records
To inactivate a prescriber record, deselect its Doctor Active checkbox. Inactive prescribers do not show 
up in the regular prescriber search, but you can locate them using an Advanced search.

Inactive prescriber records cannot be used in prescriptions. The Active checkbox must be 
selected.

There are various reasons why you may choose to inactivate a prescriber record. For example, a 
prescriber may be inactivated because they have retired, or has been relocated to a different region. 
Inactivating these records allows the regular search to provide more succinct results; this reduces the 
chances of selecting the incorrect prescriber into a prescription.

To locate inactivated prescriber records in the system, perform an Advanced search. Ensure the Inactive 
checkbox or All option is selected. 

Inactive prescriber records are displayed in red font in the prescriber search window.

Creating a prescriber record
 1.  Perform a thorough search to ensure the prescriber does not already exist in the database. 

You are prompted to perform an Advanced search for inactive prescribers.

Inactive prescriber records > Method 1: From the F7 - Doctor window
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 2.  Select or press Insert.

A blank F7 - Doctor window is displayed. 

 3.  Complete the prescriber fields then select Save.

Prescriber record fields
The following table describes the fields in the prescriber record.

Name Description
Last Name, 
First Name

The name of prescriber (do not add any symbols to these fields).

Salutation Dr., Miss., Mr., Mrs., or Ms.
Quick Code An optional code to use when searching the prescriber. For example, you might enter 

a "THOMG" code for “Dr. Gary Thomson”.

This field can also be used to identify doctors working in the same location. For 
example, if you enter “CLINIC” for all doctors working at the nearby clinic, you can 
easily locate them by searching for “.CLINIC”.

Locations If the physician practices in more than one physical location, you can enter more than 
one address for them. 

Primary 
Location

If the you have entered more than one location for the prescriber, select this 
checkbox when the primary location is selected from the Locations section.

Address, City, 
Province, 
Postal, Country

The prescriber's address.

Comments Any comments about the prescribers. For more information, see "Comments" (page 
145).

Phone 
Numbers

The prescriber's phone numbers.

Groups The groups the prescriber belongs to.

Prescribers can be included in a group for reporting or dispensing purposes. For 
example, a prescriber group called “Walk-In Clinic” could be created and attached to 
the prescribers' work at the walk-in clinic.

Prescriber groups are created by head office. 

To add a group, select Ins, then move groups from Available Groups to Selected 
Groups.

Prescriber record fields > Method 1: From the F7 - Doctor window
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General Information tab

The following table describes the fields on the General tab.

Name Description
Designation The type of prescriber.
Specialty The prescriber's specialty.
Dispensing 
Rights

One of the following:

Full Rights: The prescriber can dispense Schedule 1, 2, 3, targeted, controlled and 
narcotic prescriptions.

No Narcs: The prescriber cannot dispense narcotic substances. If they attempt to 
process a narcotic Rx, the system displays a warning message and the process is 
halted.

No Narcs or Controlled: The prescriber cannot dispense narcotic or controlled 
substances. If they attempt to process a narcotic or controlled Rx, the system 
displays a warning message and the process is halted.

Written 
Language and 
Spoken 
Language

The prescriber's written and spoken language. These fields are for informational 
purposes only; they are not tied to any system functionality.

Email The prescriber's email address. Select Send to send an email to that address.
Created On The date the prescriber record was created.
Changed On The date the prescriber record was last modified.
Last Rx On The date an Rx was last filled by this prescriber.
Primary 
License 
Number

The Type and License number of the prescriber's primacy license. Select Override to 
change the Ref ID. For information on where these licenses are maintained, see 
"Licenses tab" (page 160).

General Information tab > Method 1: From the F7 - Doctor window
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Name Description
Signature If your terminal is hooked up to a document scanner, you can load the prescriber 

signature into the system by scanning a written prescription and cropping the 
signature. The signature will be available during “Check” stages, for cross-checking.

To load a prescriber signature, feed the written prescription into the document scanner, 
then select Load from the prescriber record, and  click and drag a box around the 
signature portion of the prescription. Select Save or press Enter to save it.

No Kroll Care If selected, Kroll Care will not be generated for  this prescriber's prescriptions.
No Fax Refills If selected, the prescriber does not accept fax requests for prescription refill. 
No Phone 
Refills

If selected, a warning message appears when Call Doctor is selected from the Rx 
Filling window, or the patient profile, indicating that the prescriber does not accept 
phone requests for refills.

Licenses tab
You can use the Licenses tab to maintain the prescriber's licenses.

When you select Ins or press Insert, the Add/Modify License pop-up is displayed.

The following table describes the fields on the tab and pop-up.

Name Description
Designation The type of prescriber, as set from the General tab.
Filtered If selected, the Type field is filtered to display only those licenses that correspond to 

the prescriber's Designation.
License 
Type/Type

The type of license.

Licenses tab > Method 1: From the F7 - Doctor window
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Name Description
License 
#/License

The license number.

Override If select, the Ref ID field is enabled.
Ref ID The reference ID for the selected Type. This field is read-only.
Licensing 
Body

This  read-only field populated by the system, based on the License Type.

Licenses tab > Method 1: From the F7 - Doctor window
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You can use workflow management to process prescriptions in a structured and standardized manner. In 
this guide, you can see how a typical prescription progresses through the Kroll system, with the following 
workflow elements activated:

Multiple workflow queues

No hardcopy generation

Electronic signature capture

Thermal printing

Workflow management can be tailored to meet the needs of any pharmacy environment. For more 
information, please contact the Kroll sales team.

Start window

Chapter12

Workflow management
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Workflow queues (A)
The following table describes the workflow queues in the sequence they are completed. The queues in use 
may vary by implementation.

Queue Description
ToDo/Data Input  Items in this queue require data to be entered in order to complete the 

record. Use the scanned image of the written prescription as a reference 
and enters the appropriate information. 

Refill prescriptions ordered via an IVR system are placed in this queue for 
processing.

Data 
Verification/Adjudication

A pharmacy team member confirms the data entered in the previous step is 
correct by comparing it to the scanned image of the original written 
prescription. The internal DUE process then commences and any potential 
ADRs are identified and managed. Adjudication occurs if the prescription 
will be paid by the patient’s third party plan.

Packaging The selected prescription is displayed on the Packaging window. The 
pharmacy team member then scans the UPC code on the product to 
confirm the correct item has been selected from the shelf. The pharmacy 
team member can also record the lot number and expiry date for each pack.

Package Verification The selected prescription is displayed on the Package Verification 
window. The pharmacy team member, with vial in hand, compares what is 
on it to the original prescription, the Kroll entry, and the label.

Clinical Verification The pharmacist evaluates the prescription and determines if it is clinically 
correct for the patient.

Incomplete Pickup This queue should never have prescriptions in it. If a prescription is listed, it 
means that something occurred during pickup that needs to be resolved.

Waiting for Pickup Prescriptions stay in this queue until they have been picked up out of Kroll.

Grid (B)
The numbers on the grid represent the number of prescriptions currently located within each queue and 
when they are due to be completed. You can refer to this queue to see where the bulk of the work is, and 
adjust your operations accordingly.

Pickup Grid (C)
This shows how many prescriptions are in the pharmacy's pickup bin and how long they have been there. 
The  Total and Total$ values should equal the total number of prescriptions in the pickup bin, and their total 
coat (actual acquisition cost), respectively.

Start window >Workflow queues (A)
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Drop-off
You can use the F11 - Drop-off window  to enter Rx information while the patient is still in the pharmacy.

 1.  From the F11 - Drop-off window, search for and select the patient, then select the Drop-off 
button.

 2.  Place the written prescription face down in the document scanner and select Import Script 
Image File.

The Scan Image window appears with the scanned image displayed.

Drop-off > Pickup Grid (C)
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 3.  If the written prescription contains multiple items, enter the total number of items in the # of Rxs 
On Page field.

Drop-off > Pickup Grid (C)
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 4.  Select Save. 

The prescription image appears in the Drop-off window.

 5.  Ask the patient when they want to pick up the prescription, and select their response from the Rx 
Status field.

This selection dictates how the Rx will progress through the system.

 6.  Select Add. 

The prescription is added to the work order.

If the pharmacy is not busy, you can complete the Rx fields on the Drop-off window before 
adding the prescription to the work order.

Drop-off > Pickup Grid (C)
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 7.  Repeat the above steps as needed to add all of the patient's prescriptions.

 8.  Select Finalize Work Order.

The prescription record progresses to the next workflow step and the Drop-off window is 
refreshed. You can begin serving the next patient in line.

Workstations
You may choose to implement a structured approach to prescription processing, wherein you assign a 
specific function to each workstation in your pharmacy. For example, your store might have the following 
workstations:

 1.  Drop off workstation, which is equipped with a barcode scanner and image scanner.

 2.  ToDo/Data input workstation

 3.  Data verification/Adjudication workstation

 4.  Packaging workstation, which is equipped with a thermal printer and barcode scanner

 5.  Package verification workstation, which is equipped with a digital signature pad

 6.  Clinical verification workstation, which is equipped with a digital signature pad and thermal 
printer.

 7.  Pickup workstation, which is equipped with a digital signature pad and barcode scanner.

To assign each workflow queue to a separate workstation:

From the applicable workstation, select the F9 - Workflow window, then select the workflow queue(s) 
you want to activate for that workstation.

If you do not have a large number of workstations, you can still designate specific workstations for specific 
tasks by turning on the queues that you want activated at the current workstation. The only limitation is the 
peripheral equipment. For example, the packaging workstation must have a barcode scanner and thermal 
printer associated with it, and the clinical verification workstation must have a digital signature pad and a 
thermal printer associated with it.

In a multi-workstation scenario, it is recommended that at least one workstation be set up as an “all- in-one” 
workstation, so that a single pharmacist working alone can complete all of the workflow steps from one spot 
in the dispensary. The following peripheral equipment must be associated with this workstation:

Thermal printer for vial labels

Thermal printer for receipts, wallet cards, and privacy labels

Barcode scanner

For product scanning at packaging

For prescription scanning at pickup

Digital signature pad

Workstations > Pickup Grid (C)
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Main window
The F12 window displays all the main elements of a prescription, including the name of the individual who 
filled the prescription and any legacy details about the prescription. 

Chapter13

F12 - Fill Rx window
The F12 - Fill Rx window contains all the Rx information that is entered during the prescription filling process. 
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Information bar
The information bar is located along the top of the F12 window, directly below the function keys. Below is a 
description of each field in the information bar.

The following table describes these fields and buttons. The date fields vary according to the status of the 
prescription and the number of times it has been filled.

Name Description
Last Rx 
Number

The last Rx number used to fill the Rx.

Rx Label The mode of the Rx.
Pending 
Adjudication

If present, the Rx is pending adjudication, because the adjudication step has not been 
completed. The field is blank once adjudication is complete.

Rx Start Date The Rx's previous fill date.
Number of 
days since 
first fill

The number of days that have elapsed since the start date.

Latest Fill The fill date of the current prescription.
Number of 
days since 
latest fill

The number of days that have elapsed since the latest fill.  

Qty The quantity that was dispensed since the last time the Rx was filled.
Latest total The amount that was charged the last time the Rx was filled.
Init The initials of the user who last filled the Rx. 
Priority Indicates if the Rx has a due time (pick up time). 

Select an option from the menu to specify a priority, or select F2 to replace this field with 
Date and Time fields and then enter a specific due time. 

Priorities are configured from the store-level Configuration Parameters window.
Due The time remaining before the Rx is due.
Workflow 
Detail

The workflow type.

Information bar >
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Name Description
F2 button next 
to Workflow 
Detail

Displays the Rx Workflow Detail for Rx window. This window contains three tabs:

The Workflow tab displays all of the workflow actions that are connected to the 
prescription, along with the status of each action, the date of completion, the initials 
of the user who completed the action, and any comments that were entered.

The Packaging tab displays information about the drug that was filled in the 
prescription, such owed quantities, quantities packaged, tote number, and delivery 
status.

The Comments tab displays comments that pertain to the workflow action or steps.
Work Order Rxs with the same work order number are presented together as one work order when 

completing the pickup process.
F2 button next 
to Work Order

Select to add this prescription to an existing or new work order or view the other 
prescriptions that belong to the same work order.

Delivery The selected delivery route.
Lookup Used to refresh the F12 window after information has been entered or changed. For 

example, if the plan has changed on the prescription, you can press Enter or click 
Lookup to refresh your changes.

Cancel Displays the window you accessed before the F12 filling window.

Unit Dose
The Unit Dose section is used to identify Rxs that should be taken at a certain time. Kroll supports unit 
dose packaging types including DisPill, PillPak, Dosettes, and a number of generic compliance reports.

To enable unit dose for an Rx, from the F12 page, select View > Unit Dose Info, or select Unit Dose Info 
from the right navigation pane.

The Rx Information window is displayed.

Unit Dose >
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The following table describes the fields in the top panel of this window.

Name Description
Start The first date the medication will be populated on the Unit dose packaging reports.

This is the Start date from the Dates tab in the lower left hand corner of the F12 window. If you 
change this date, the Start date on the Dates tab is updated. 

Stop The last date the medication will be populated on the Unit dose packaging reports.

This is the Stop date from the Dates tab in the lower left hand corner of the F12 window. If you 
change this date, the Stop date on the Dates tab is updated. 

Drug The selected drug.
Sig The Sig that was entered for the Rx.

The following table describes the fields on the Dosing tab.

Name Description
Unit Dose If selected, unit dosing is enabled for the Rx, and the other fields on this tab are enabled.
Frequency The dosing frequency.
Card 
Number

The card number used to group Rxs by unit dose packaging type.

The default value is 1.
Quantity Each box on the grid represents a quantity (dosage) for either Breakfast, Lunch, Dinner, 

and Bedtime.

The Calendar tab displays a monthly schedule of unit dose times and quantities, based on the selected 
frequency and quantity.

Unit Dose >
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Navigation pane
The navigation pane located on the right side of the F12 filling window contains a variety of functions that 
pertain to the Rx.

The options in the Rx and View sections are also available from the menu, under Rx or View. For 
information on these options, see "Rx" (page 173) and "View" (page 175), respectively.

Navigation pane >
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Menu
The following sections describe the options under the Rx, View, Labels, Profile, and Reports menu 
headings.

Rx
The following table describes the options that may be available from the Rx heading, depending on which 
window is displayed when you select this heading, and the status of the Rx.

Name Description
Adapt Rx Select to adapt the selected Rx.
Add Rx Image Select to display the Rx Image window, which you can use to import a script 

image or select an existing image to add to the Rx. 
Allow more than 2 
ODB fees per 
month (Ontario 
Only)

Select to send a fee for all Rxs after the second fill for fee exception drugs. 

Back Date Rx Select to change the fill date of an Rx before it is processed.
Call Doctor Select to create a callback record to remind pharmacy users to contact  the 

prescriber regarding the Rx (for Sig confirmation, refill requests, etc.) A ‘Call 
Doctor is Enabled’ message will appear in the Warnings section of the F12 
window. 

Central Fill Select to send the Rx to Central Fill, where it is dispensed, packaged, and 
shipped back to the store, directly to the patient, or to a nursing home.

Change Rx Pack 
Size Qty

Select to display the Change Rx Pack Sizes form where you can change or 
divide the Rx quantity among pack sizes.

This option is only available if more than one active pack size is available.
Charge to 
Account

Select to charge the prescription to the patient's pre-pay account, via a new 
(open) invoice.

Charge to AR Select to charge the remaining cash amount to the patient's AR account.

This option is only available if the Accounts Receivable module is activated and 
the patient has an AR account.

Counsel Patient 
on Pickup

Select to arrange for patient counseling at pickup. A form appears which you can 
use to select a reason for conducting the counseling session.

Copy to New Rx Select to inactivate the current Rx chain and start a new Rx using the same 
information.

Elston (Ontario 
Only)

Select to enable Elston Pricing for the Rx. This charges the full purchase cost with 
no markup.

Inactivate Rx Select to discontinue an Rx.
Interventions/SA 
Numbers

See the Rx Plan Information option on the "Navigation pane" (page 172).

Menu >
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Name Description
Make Rx Not 
Dispensed                         

Select to mark an over-the-counter item as not dispensed, so it can be logged on 
the patient profile without passing through the different filling stages and 
generating labels and receipts. 

Make Rx Refusal 
to Fill

Select to mark the Rx as Refusal to Fill.

Make Rx Stock 
Transfer                         

Select to mark the Rx as a stock transfer to another pharmacy. 

Make Rx Unfilled                         Select to mark an Rx as unfilled (on hold).
Make this doctor 
that family doctor 
for this patient

Select to make the selected doctor the family doctor for the patient.

Methadone 
Carries

Select to make the Rx a methadone carry.

Change Next Fill 
Parameters

Select to display the Change Next Fill Parameters form. The next time the Rx is 
called up in fill mode, the changes entered in this form are applied. 

Order Drug Select  to display the Place Order form, which you can use to select a vendor and 
the quantity to order. This will place the selected drug in a manual order.

Owe Quantity Select to display the Edit Rx Owe window, which you can use to select the drug 
quantity you will owe the patient on a return pickup. An owing amount is printed on 
the label. 

Part Fill Select if the entire authorized quantity has not been dispensed. A part fill label will 
be generated.

Pickup 
Notification 
(Request)

Select to identify who will receive the pickup notification request.

Print 
Authorization 
Label Now

Select  to print an Authorization Label. The pharmacist will call the doctor and 
record information about the Rx on a hardcopy label for easy attachment to the 
original hardcopy phone refill. 

Print Compliance 
Calendar

Select to print a compliance calendar on the label set, beginning at the start date 
and continuing for the duration of the prescription, as indicated in the days supply 
field. The pharmacist can circle the days the patient needs to take the dose or 
write in the quantity of pills to take. This is typically used for complicated Rxs or 
tapering doses. 

Print Delivery 
Label (Send To)

Select to print a delivery label if your system is not configured to do so for every 
label.

Print Kroll Care 
Now

Select to print the drug information monograph. The content of Kroll Care is 
provided by the First Data Bank (FDB) clinical drug module.

Print Wallet Card 
(Profile)

Select to print a wallet card or patient profile if one is not configured to print on 
every label set.

Reactivate Rx Select to reactivate the Rx.
Transfer Rx from 
Other Store

If a prescription is being transferred from another pharmacy, select this option to 
input information about the transferring pharmacy.

Rx >
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Name Description
Transfer Rx to 
Another Store

f a prescription is being transferred to another pharmacy, select this option to 
input information about the pharmacy that is receiving the prescription.

Trial Rx Select to display the Trial Rx Information window where you can specify the trail 
amount that will be dispensed for the first fill.

View Transfer to 
Another Store

Select to display information about an Rx's transfer to another store.

Workflow 
Comment

Select to add a workflow comment.

View
The following table describes the options that may be available from the View heading, depending on 
which window is displayed when you select this heading, and the status of the Rx.

Name Description
Adjudication Log Select to display the adjudication log.
Adjudication 
Results

Select to display the Adjudication Results window, which you can use to view 
how the Rx was last adjudicated.

Cancel Rx Select this option to reverse an Rx. 
Clinical Interactions Select  to perform a clinical review of the prescription against the rest of the 

patient medication history, from the FDB database. 
Comments from 
previous fill/cancel

Select to display the Comments from previous fill/cancel window, which you 
can use to view the last Rx fill/cancel comment.

Drug Interactions See Clinical Interactions on the "Navigation pane" (page 172).
Generic 
Equivalents

Select  to view the generic equivalents for the selected drug. At the Input stage, 
you can highlight a generic equivalent and click Select to select an alternate 
drug record for the Rx. 

Mixture Breakdown Select to display the Mixture Breakdown window, which provides exact dollar 
amounts for elements that make up the mixture pricing. It is recommended that 
you do this before you adjudicate the Rx. 

Patient Plan 
Information

Select  to display the Patient Plan Information window, which displays the 
patient’s third party plan information. If more than one plan applies to the Rx, 
one tab is displayed across the top of the window for each drug plan. Adjust the 
third party plan information and re-adjudicate the Rx, if necessary.

View >
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Name Description
Plan Information Select  to display the Rx Plan Information window, which you can use to enter 

plan-specific information. If more than one plan applies to the Rx, one tab is 
displayed across the top of the window for each drug plan. 

The following bullets describe some of the fields on this window:

The Special Authorization # field identifies the number associated with the 
special authority that grants full benefit status to a medication that would 
otherwise be a partial benefit or a limited coverage drug.

The Special Services Code field is often used to bill service fees to 
Indigenous Services Canada (ISC).

The value of the Claim Type field is configured according to the parameters 
of the prescription. It should not be changed.

Do not change the value of the Real Time Plan check box as it is set 
according to the third party plans present in the prescription. If it is 
deactivated, you will need to manually bill for prescriptions that could have 
been billed electronically in real time.

The Pseudo DIN field displays the pseudo DIN being sent to the third party 
for the prescription, but you can also override this value to send a onetime 
pseudo DIN with the prescription.

Refill Information Select to display the refill history for the Rx. 
Refill/Modification 
History

Select to display the History of original Rx Number window, which you can 
use to view all changes made to the Rx since its original fill. 

Rx as it was Filled Select   to display the F12 window for the first fill of the Rx. 
Rx Counseling 
History

Select to display the Counseling History window, which shows records of all 
past counseling sessions associated with the Rx. 

Suspensions Select to display the Suspensions for Rx window, from which you can view 
past suspensions that apply to the Rx or insert a new suspension.

Unit dose Info Select to view the Unit Dose Rx Information window for the Rx. 

For more information, see "Unit Dose" (page 170).
Work Order Select to display the work order number.

Rxs filled with the same work order number are intended to be picked up 
together using the pickup application.

Workflow Detail See "View workflow details" (page 86).

Labels
The following table describes the options that are available from the Labels heading. These options  pertain 
to the Rx label that is generated when filling the Rx.

Name Description
Generic Select  to override the first drug name.
Second Drug Name Select  to override the current second drug name. 

Labels >
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Name Description
Half Size Sig If enabled, the Sig prints at half its usual size. This is useful for drug products 

with long Sig instructions.
Preview Label 
Printing Action

Select to preview the label set or Kroll Care.

Message Select a message to be printed on the label. Rx messages are configured via 
Utilities > Labels > User Labels.

Profile Lines to Skip Select to choose the number of profile lines to skip when printing the 
profile/wallet card labels for this Rx.

Profile
You can use the options under the Profile heading to view the patient profiles from the F12 window.

Name For information, see...
All Rxs "All Rxs" (page 71)
Active Rxs "Active Rxs" (page 71)
Refillable Rxs "Refillable" (page 72)
Pricing Profile "Pricing Profile" (page 72)
Not Disp/OTC Profile "Not Dispensed/OTC Rxs" (page 72)
Rxs Filled in Error "Rxs Filled in Error" (page 73)
Active Rxs and Passtimes "Active Rxs with Passtimes" (page 71)
Suspended Rxs "Suspended Rxs" (page 73)
Transactions "Transactions" (page 73)
Perform Clinical Analysis "Perform Clinical Analysis" (page 74)
Therapeutic Equivalents "Display Therapeutic Equivalents" (page 90)

Reports
The following table describes the options that are available from the Reports heading. 

Name Description
Individual report names Select the name of a report to display it.
All Select to display all Kroll reports (not just F12 specific reports).
Search Select to search for a specific report.

Profile >
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Tabs
The tabs provide additional information about the Rx being processed. Use the left and right arrow keys to 
navigate through the tabs.

Tabs >
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Plans

The following table describes the fields on this tab.

Name Description
Rx Plans Select to exclude third party plans from a prescription, or change the order of billing. The 

plans are listed in order of billing.
Plan Pays Displays how much each plan has paid for the current Rx.
Extra Info Displays intervention codes or other options (populated from the Rx Plan Information 

window) for each plan for the current Rx.
Next Disp 
Qty

The new dispense quantity for the next refill. This is especially useful for trial prescriptions 
where the first order has a lower dispensing quantity than the next.

Min 
Interval 
Days

Used for narcotic prescriptions to prevent refilling until a specified number of days have 
elapsed.

Enable 
Auto Refill

Select  to enable auto-refill on Rxs. When the days supply of the Rx has elapsed, the Rx is 
displayed in the To Do queue for processing.

Max Disp 
Qty

The maximum quantity of drug that can be dispensed.

Rx 
Comment

Displays the number of comments added to the Rx. 

Select the button to display the comments tab. Enter comments in the text box.
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Pricing
The pricing tab displays information regarding the pricing strategy used to calculate the Rx. pricing 
strategies are set in Edit > Plans/Pricing.

The following table describes the fields on this tab.

Name Description
Strategy The read-only name of the pricing strategy being used in the Rx that is set up in Edit > 

Plans/Pricing. 
Unit Dose 
Strategy

The read-only name of the unit dose pricing strategy being used in the Rx and that is set 
up in Edit > Plans/Pricing.

Acq Cost A read-only calculation based on the purchase price of the drug card.
G.P. The read-only gross profit percentage is calculated using: (Rx Total $$$ - ACC)/RX total 

$$$)
Unit drug 
cost

The read-only  cost per pill. This is based on the following calculation: Drug pack 
size/Purchase Cost of the drug card.

Manual 
Price

Select this check box to override the pricing. The Cost, Markup, Fee, Mix Fee and SSC 
fields will be enabled. Manual pricing should only be used in emergency situations; 
incorrectly priced prescriptions should be reported to the TELUS Health for investigation 
of the root cause.

Pricing row The individual pricing breakdown for the Rx.
Cost The read-only dollar amount calculated by the system as set up in the pricing strategies 

specific to cost.
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Name Description
Markup The read-only dollar amount calculated by the system as set up in the pricing strategies 

specific to markup.
Fee The read-only dollar amount calculated by the system as set up in the pricing strategies 

specific to fee.
Mix Fee The read-only dollar amount calculated by the system as set up in the pricing strategies 

and/or the mixture card specific to the fee.
SSC The Special Services Code fee.
Total The read-only dollar amount calculated by the system as set up in the pricing strategies 

specific to the sum of all the fields.
Discounts The discounts that have been applied to each price field for waiving cost differences 

during adjudication.
Net 
Amounts

The net amount (original pricing – discount)  applied to each price field.

Dates

The following table describes the fields on the Dates tab.

Name Description
Written The date the Rx was processed. You can change it to the date the prescription 

was written.
Dispensing allowed 
period Start and Stop 
dates

The period during which the prescription can be dispensed.
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Name Description
Administration 
period Start and Stop 
dates

The date the Rx was processed. For New Rxs, you can change this to the date 
the patient will start taking the medication.

Drug expiry A drug expiry date for the prescription, if applicable. This date is printed on the 
vial label for the patient's information. This option is especially useful for liquid 
antibiotics.

Ingest The ingest date for methadone prescriptions.
Copy Information The read-only Therapeutic start date, as well as the Rx numbers of the 

original Rx and its copy.
Transferred In and 
Out dates

The read-only dates a prescription was transferred in and out.

Comments
You can add comments and notes from the Plans and Comments tabs. From the Comments tab, you can 
select additional attributes that are not available on the Plans tab.
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 1.  To insert a new comment, select Ins or press Insert, then select Comment.

The RX Comment pop-up is displayed. 

 2.  Select a Topic and enter your comment.

 3.  To show the comment when filling a prescription, select Show On Rx.

 4.  To show a pop-up message during filling that indicates a comment is present, select Alert.

 5.  To include the comment on the hard copy prints during filling, select Print On Hardcopy

This checkbox can only be selected for one comment, as there is limited space on the hardcopy.

 6.  To include the comment on any refills for this prescription, select Keep Comment for Refills.

 7.  To copy the comment to a new prescription, if the original prescription is copied, select Keep 
Comment for Copied Rxs.

 8.  To display a comment during one or more steps in the workflow, select the Edit button adjacent 
to Workflow Alerts, then select one or more workflow steps and select OK.

 9.  To choose which workflow the comment is applied to, select Edit, the select the applicable 
workflow.

If you select more than one workflow, it will only be displayed on the first workflow 
unless you escape out of the Rx and return to it for the next workflow.
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 10.  Select Save.

Indications
The Indications tab allows you to identify what condition(s) the prescription is treating. 

Select Ins to display a list of ICD-10-CA and/or FDB conditions. Search for the applicable condition, 
highlight the record, and click Select.

Images
You can use the Images tab to import a script image or indicate a reason for not including a script image.

Do one of the following:

If a work order does not have a written Rx that accompanies it, enter the reason why in the No Script 
Image Reason field, or
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To add an image, select + then select the Import Script Image File or Select an Existing Image and 
select the image you want to add.

Other

The following table describes the fields on this tab.

Name Description
Admin Sites The area on the patient's body that the drug is administered.
Max Dosage The max dosage of drug that can be administered per time measurement, such as 

hour or day. You can enter two max dosages.
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Name Description
Doctor 
Authorization 
Received

This should always be selected, as it indicates that prescriber authorization to 
dispense the prescription has been received.

Include in 
Narcotic report

Select to include the Rx in the narcotic report even if it is not a narcotic prescription.

No Doc 
ERenewal

If selected, doctor eRenewal is prohibited,

Transaction 
Comment

Displays any comments specific to the transaction. This can be a user comment, 
system comment, or a comment transferred from the To Do comment section. This 
comment will not be transferred to refills or copied Rxs.

Warnings
The Warnings section displays  important information and problems that pertain to the Rx.

The following table describes the icons shown in this section.

Icon Type Description
Error 
message

There is a problem with the Rx and you cannot move it to the next filling stage.

Warning 
message

There is a potential issue with the Rx, and addressing this issue may prevent 
input errors. Rxs can be finalized while these messages are present.

Information 
message

This is a general message. Rxs can be finalized while a message of this type is 
present.
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Filling a Prescription
This section explains the procedure for filling a prescription from the F12 window.

Patient Details
 1.  Enter one the following search criteria in the Patient Search field, then press Enter:

Last name, first Name.

For example, one of the following: “Doe, Jane”, “doe,j”, “Doe”, or “,Jane” 

A period (.) and the patient quick code.

For example, ".DoeJ”

A 7 or 10-digit phone number.

For example, "800-263-5876" or "263-5876"

A number sign (#) and the third party billing number.

For example, "#123456789"

An asterisk (*) to return all of the patients in the database.

If more than one patient matches the search criteria, a list of matching patients is displayed; 
otherwise, the matching patient record is displayed.

 2.  To select a patient record, do one of the following:

Highlight the patient record and press Enter or select F12 - Return to Rx.

Enter the line number corresponding to the applicable record and press Enter.

Double click the patient record.
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 3.  Select Rx.

The patient’s information is displayed in the patient fields.

Patient Details >
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Drug/Mixture Details
 1.  Enter one the following search criteria in the Drug Search field, then press Enter:

Brand/Generic Name, Strength/Pack Size (e.g. Apo-Metformin, 500/360)

DIN (5-8 digits)

UPC (11-12 digits)

A period (.) and the Drug Quick Code (e.g. TYLE3)

# symbol and the Catalog Item Number (e.g. #78945)

A list of matching drugs/mixtures  is displayed

 2.  To select a drug or mixture record, do one of the following:

Highlight the drug or mixture record and press Enter or select F12 - Return to Rx.

Enter the line number corresponding to the applicable record and press Enter.

Double click the drug or mixture record.
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 3.  Select Rx.

The drug or mixture information is displayed in the drug fields.
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Prescriber Details
 1.  Enter one the following search criteria in the Doc Search field and press Enter:

Last name, first Name.

For example, one of the following: “Doe, Jane”, “doe,j”, “Doe”, or “,Jane” 

A period (.) and the patient quick code.

For example, ".DoeJ”

A 7 or 10-digit phone number.

For example, "800-263-5876" or "263-5876"

A number sign (#) and the third party billing number.

For example, "#123456789"

An asterisk (*) to return all of the patients in the database.

The list of matching prescribers is displayed.

 2.  To select a prescriber record, do one of the following:

Highlight the prescriber record and press Enter or select F12 - Return to Rx.

Enter the line number corresponding to the applicable entry and press Enter.

Double click the prescriber record.
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 3.  Select Rx.

The prescriber's information is displayed in the prescriber fields.

Sig Details

 1.  In the Sig field, enter the code for the appropriate administration instructions.

A read-only description is displayed below this field. 

You can edit the sig codes and descriptions from Edit > Sig Codes.

 2.  Select the Route of Admin for the drug product, such as oral or topical.

 3.  Select the Dosage Form of the drug product, such as capsule or tablet.
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Dispense details

 1.  In the Init field, enter your user initials.

Your system may be configured to automatically populate this field.

 2.  In the Dispense Qty field, enter the dispense quantity for the prescription.

If you enter a dispense quantity, followed by a ‘P’,  the dispense quantity will be multiplied by the 
pack size.

 3.  Enter the Days supply for the dispense quantity you entered.

 4.  If  drug cannot be substituted, select a Prod Sel. 

 5.  In the O/W field, optionally select how the Rx was received into the pharmacy. 

 6.  Enter the number of vial Labels to be printed. 

If you enter 2 or more, you can select F2 to split the labels from the Label Splits pop-up. 

If you select Split quantity on labels, the quantity will be divided by the number of labels.

 7.  The value of the Auth Qty field is set based on the values of the Disp Qty and Refills fields. If 
this field is blank, enter the total authorized quantity for the prescription.
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 8.  The Rem Qty field is automatically populated with read-only information pertaining to the 
number of pills not dispensed, based on the authorized quantity. The field to the right indicates 
the remaining refills based on the dispensed quantity that is currently populated.

To change this number, select the Rem Qty button, then change the values of the fields on the 
Specify number of repeats for a new Rx pop-up.

 9.  The G.P.% (Gross Profit percentage) field displays read-only information that is based on the 
following calculation: (Rx Total $$$ - ACC)/Rx total $$$.

 10.  The Acq Cost (acquisition cost) field displays a read-only value based on the purchase price on 
the drug card.

 11.  The Cost field displays a read-only dollar amount calculated using the pricing strategies specific 
to cost.

 12.  The Markup field displays a read-only dollar amount calculated using the pricing strategies 
specific to markup.

 13.  The Fee field displays a read-only dollar amount calculated using the pricing strategies specific 
to fee.

 14.  The Total field displays a read-only dollar amount calculated using the pricing strategies specific 
to the sum of all the fields.
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Processing the Rx
After the Rx fields are populated, select F12 - Fill Rx to assign an Rx number to the prescription. 

This must be completed whether you are logging an Unfill, a Stock Transfer, a Not Dispensed, filling a 
new Rx, or saving changes on a modify. A prescription number is not created when you are modifying 
an Rx.

The Rx will progress through the workflow actions available for your selected workflow type. 

To change the workflow actions, contact TELUS Health.

Prompt for AR
The AR prompt is displayed if the following is set up for your store:

The AR module is enabled.

The patient has an AR account.

The Charge Rxs field in File > Configuration > Store > AR is set to Prompt.

If these criteria are not met, this workflow action is skipped.

The AR prompt asks you if you want to charge the Rx.

If you select Yes, the cash remainder will be charged to the patient’s AR profile.

If you select No, nothing will be charged to the patient’s AR profile.

Refill Reminder and Auto Refill prompts
You may be asked whether you want to enroll the patient in the Refill Reminder and Auto Refill programs,  
mark the Rx as an auto refill Rx, or send refill reminders.

For information on  the Refill Reminder and Auto Refill programs, see the Auto Refill Functionality guide.

Pickup notification prompt
You may be asked whether you want the patient to be notified when their Rx is ready for pickup. 

Prompt for medication reviews
Depending on your province and store configuration settings, you may be prompted to perform a 
medication review if the patient is eligible.

For information on medication reviews, see the Electronic Medication Reviews Quick Tips and Paper 
Medication Reviews Quick Tips documents.
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Perform Local DUE
When you are filling an Rx, you can review the First Data Bank (FDB) clinical interactions analysis for a 
patient’s profile. This occurs within the Perform Local DUE workflow action. The analysis is based on 
information in the patient profile and the selected drug.

The results of this analysis are displayed in the Clinical Reports window, under separate tabs across the 
top of the window. Which tabs are displayed depend on the settings in File > Configuration > Store > 
FDB. Click Next to proceed through the tabs.

There is also an option to print the clinical report by selecting File > Print, as well as an option to counsel 
the patient at pickup from the Rx menu.

A Proceed button is displayed if an interaction needs to be viewed. You cannot bypass a required tab.
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A Finish button is displayed on the last tab. Select it to close the Clinical Reports window.

Depending on you store configuration settings, you may be required to manage interactions. After you 
select the Finished button on the Clinical Reports window,  a Clinical Issue Summary window is 
displayed.
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Allocating inventory
Allocating inventory is the process of obtaining the dispensing amount from the on hand quantity for the 
selected drug. This action happens in the background; no prompts are displayed unless insufficient 
inventory is available.

Adjudication to Real Time Insurance
After the prescription has been approved locally, the next step is to complete adjudication and bill the 
online insurance plan(s). Each Rx adjudicates to the plan(s) listed within the Plans tab, in the sequence 
they appear in the Rx.

In the example below,  three plans are listed. This Rx will first bill RAMQ, then DSQ, and the remainder will 
be billed to cash, which is the final amount the patient pays.
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If the patient has more than one instance of the same plan, the plan code is displayed with the 
plan order in brackets.

Adjudication Response window
The Adjudication Response window is displayed when you are billing electronic online plans at the 
Complete Adjudication stage. It is displayed for each plan the Rx is being billed to, until the total cost has 
been fully paid.

The following table describes the fields on this window.

Name Description
Submitted The pricing breakdown of what is billed to the plan.
Accepted The pricing breakdown of what is accepted from the plan.
Difference The difference between what was submitted and accepted from the plan for each cost 

field.
Total The entire Rx Total calculated in Kroll.
Prev Paid The sum of payments towards this Rx that were billed before this plan.
Plan Pays The total amount this specific plan has paid.
Pat Pays The amount the patient must pay.

If the Trouble button is displayed, and you select it, the Rx is placed in the Trouble queue for a specified 
amount of time. This moves the Rx out of the queue priority so that other Rxs can be processed. An 
Escalate Rx to Trouble window is displayed, where you can enter a reason for sending the Rx to the 
Trouble queue. Enter a date and time in the Keep Rx in Trouble Until fields.
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To access the Trouble queue, call up the F9 - Workflow window and select Trouble from the right 
navigation pane.

If you select Cancel Rx, the Rx is reversed.

Rejection messages
If a plan rejects a claim, the Adjudication Response pop-up displays a rejection code and the reason the 
claim was rejected. Select the Interventions button to display a list of available intervention codes that you 
can use to potentially override the rejection, or select Enter custom Free Form code to enter your own 
code.

If you select Back to the Rx, the Adjudication Response window closes, and you are directed back 
to the F12 window to make changes to the Rx. When you have made your changes, click F12 to retry 
the adjudication.

If you select Bill Manually, the remainder of the cost is manually billed to the plan rather than being 
billed online. In this case, the pharmacy is required to submit a claims invoice to the insurance 
company in order to receive payment.
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If you select Trouble, the Rx is placed in the Trouble queue for a specified amount of time. This moves 
the Rx out of the queue priority so other Rxs can be processed. An Escalate Rx to Trouble window is 
displayed where you can enter a reason for sending the Rx to the Trouble queue. Enter a date and time 
in the Keep Rx in Trouble Until fields.

You can access the Trouble window from the F9 - Workflow window, by selecting Trouble from the 
right navigation pane.

If you select Cancel Rx, the Rx is reversed.

Cost differences
The Adjudication Response pop-up appears if there are cost differences between what was submitted to 
the insurance company and what was accepted from the plan. From here, you must provide a reason for 
each pricing field that contains a cost difference. If this is not the last Rx plan before cash, you will be asked 
if you want to charge the cost difference to the next third party.

If you select No, the system will waive the cost difference on the Rx.

If you select Yes, you will be able to change the cost difference amount.

If you click OK, the system will ask the same question for any remaining cost difference field(s), and 
then send the difference to the remaining online plan, or charge the patient.

Completing the prescription
When the above steps are completed successfully, the Rx has been billed and processed successfully. A 
label is then printed.

Cost differences >
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You can use the cycle count feature to manage the quantities of drugs on-hand. This feature enables you 
to maintain an accurate inventory and efficiently track incoming and outgoing products. You can count 
‘sections’ of inventory, such as specific schedules, manufacturers, drug types and therapeutic classes.

The cycle count process is a convenient way for inventory values to be verified during quiet periods; it is not 
intended solely for use in year-end inventory counts.

Only pharmacists and pharmacy managers have permission to adjust inventory counts.

 1.  From the Alt-X Start window, select Utilities > Drug > Drug Inventory Counts.

The Cycle Counts window is displayed. 

 2.  Select Create New.

Chapter14

Cycle Counts
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 3.  Select an option from the Create Cycle Count prompt.

Pre-select Drugs to Count
 1.  If you select Pre-select drugs to count, the Generate Drug Count List form displays the 

options available for the specific types of drugs that can be counted.

Pre-select Drugs to Count >

203 © 2025 TELUS Health Kroll User Guide



 2.  To select criteria for the pre-selected drugs:

Select the F2 button next to each field. 

From the Available column, select the applicable option, then select Insert. 

The item is added to the Selected column.

Repeat this step for each field you want to select criteria for.

Select Exclude to exclude a category from the cycle count.

Use the Drug pack has not been cycle counted in the last [x] days field to specify a date 
range.

Select Include only Drug Packs with UPC, if necessary.

Use the On Hand Qty checkboxes to specify on on-hand quantity.

Select a Drug Pack Status to specify if you want to perform the cycle count for Active, 
Inactive, or Either type of drug.

Any fields left blank default to (All). 

Pre-select Drugs to Count >
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 3.  Select Search.

The Generate Drug Count List window is displayed.

 4.  At this stage you can rename the drug count, and use the Limit results to option to specify the 
number of results you want to display. 

Pre-select Drugs to Count >
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 5.  Select Start Counting.

The selected drugs are placed used in the count.

 6.  Select Count Drugs.

The first drug in the count appears in the Cycle Count Pack form. 

 7.  In the Quantity Counted field, enter the number of pills that are in the stock bottle you just 
counted.

If you counted the drug by number of packagers, you can enter this value followed by the letter P 
(e.g., 3P to specify three packagers).

 8.  Select Add Qty.

Pre-select Drugs to Count >
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The Quantity Counted value appears in the Total Quantity Counted pane. 

 9.  Repeat this step for each pack you have counted for that drug.

 10.  Repeat step 9 for each drug you want to count. 

Pre-select Drugs to Count >
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 11.  Select Cancel to close the Cycle Count Pack form.

The Cycle Count window shows a status of ‘Reconciled’ for each drug you just counted, and an 
updated Count value.

 12.  To recount a drug, highlight the drug record and select Reconcile. 

The drug appears in red text and shows a status of Recount Required.

Highlight the drug record again and click Count Drugs.  After all of the drug packs have been 
counted, the cycle count shows a status of Counted.

 13.  To view the counts for a drug, call up the Cycle Count window, right-click the drug for which you 
want to view counts, and select Show All Counts.

The All Counts window displays all counts for the selected drug. 

Pre-select Drugs to Count >
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 14.  Select Close to close the All Counts window.

Scan and go - start counting now
 1.  Enter a Cycle Count Name, then select OK.

The Cycle Count window is displayed. 

 2.  Select Count Drugs.

The Cycle Count Pack form is displayed.

Scan and go - start counting now >
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 3.  Scan the first drug to be counted.

If the drug does not have a UPC, select the F5 button next to the Drug field and complete a 
regular drug search. 

The Cycle Count Pack form displays information about the scanned drug.

 4.  In the  Quantity Counted field, enter the number of pills that are in the stock bottle you just 
counted. 

If you counted the drug by number of packagers, you can enter this value followed by the letter P 
(e.g., 3P to specify three packagers). 

Scan and go - start counting now >
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 5.  Select Add Qty.

The Quantity Counted value appears in the Total Quantity Counted pane. 

 6.  Repeat steps 4 and 5 for each pack you counted for that drug.

Scan and go - start counting now >
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 7.  Repeat steps 3 to 5 for each drug you want to count. 

 8.  Select Cancel to close the Cycle Count Pack form.

The Cycle Count window shows a status of ‘Reconciled’ for each drug you just counted, and an 
updated Count value.

 9.  To recount a drug, highlight the drug record and select Reconcile. 

The drug is displayed in red text and it shows a status of Recount Required.

 10.  Highlight the drug record again and select Count Drugs. 

Repeat the previous steps as needed to recount the drug. After all drug packs have been 
counted, the cycle count shows a status of Counted.

 11.  To view the counts for a drug, call up the Cycle Count window, right-click the drug you want to 
view counts for, and select Show All Counts.

The All Counts window appears, displaying all counts for the selected drug. 

Scan and go - start counting now >
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 12.  Select Close to close the All Counts window.

Printing the Drug Inventory Count Report
 1.  After all drugs have been counted, call up the Cycle Count window for the selected cycle count 

and select Print Report.

 2.  Select the applicable printing options from the Drug Inventory Count Report form and select 
Print. 

The report is generated.

Printing the Drug Inventory Count Report >
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Creating  a drug order
You can create a drug order automatically or manually. You can also order a drug directly from its card.

Automatic orders (perpetual inventory)
For drugs to be automatically ordered, the Enable automatic drug ordering checkbox must be selected 
via File > Configuration > Store > Order.

The value of the Base ordering on field determines when automatic ordering is triggered.

If you select Min/Max, automatic ordering is triggered when the On Hand value on the Ordering tab is 
below the Minimum Qty.

If you select Days Supply, automatic ordering is triggered when the On Hand value on the Ordering 
tab is below the Minimum Days. This value is determined by the average sales levels of the drug.

Chapter15

Drug orders
This section describes how to set up File Transfer Protocol (FTP) vendor ordering and receiving. 
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When you select Utilities > Drug Ordering > Generate Orders, the system checks for drugs with 
automatic ordering enabled and  On Hand values lower than their Minimum values, and adds these to an 
order similar to the following:

Automatic orders (perpetual inventory) >
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Manual orders
If Manual ordering is selected, you can choose which items you want to order.

Method 1: Ordering from the Drug Order Form
 1.  From the menu, select Utilities > Drug Ordering > Generate Orders.

The Drug Order Form is displayed.

 2.  Select Add Item.

The Insert Order Item window is displayed.

Manual orders >
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 3.  Search for items using one of the following criteria:

Description

Drug Identification Number (DIN)

Item Number

Pack Size

UPC

The method used to search for drugs in the wholesale catalog is differing from 
the method used to search for drugs in Kroll. For example, searching for Altace 
10mg by typing “Altace, 10” in the search field will not yield any results.

 4.  Highlight the drug and select OK to add it to the order.

Method 1: Ordering from the Drug Order Form >
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 5.  Enter the quantity you want to order, then select OK.

The Insert Order Item pop-up is displayed again, so you can select additional items to add to 
your order.

Ordering from the drug card
You can also order a drug directly from its card.

 1.  From the drug card, select the Ordering tab.

 2.  Select Place Order beneath the Available Vendor Items list.

Ordering from the drug card >

Kroll User Guide © 2025 TELUS Health 218



 3.  Select the appropriate Vendor, enter a Quantity, and select Save.

Your order is added to the Outstanding Orders list in the bottom left hand corner of the Drug 
window.

Min/Max versus days supply ordering
There are two ways to set reorder points for drug products: Min/Max ordering and days supply ordering. In 
both cases, the applicable drug is placed on order when the On Hand value drops below the Minimum 
value, if automatic ordering is set up for the drug. If you enter a Maximum value, the system orders that 
number of drugs. 

When Min/Max ordering is activated, the  Days fields of the Ordering tab of the drug card are greyed out 
because you have manually populated the minimum and maximum values. When Days Supply ordering is 
activated,  the Minimum and Maximum fields are greyed out and the Days fields are editable.

The following sections describe the benefits and drawbacks of each type of reordering.

Min/Max versus days supply ordering >
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Min/Max ordering
You can use the Minimum value to control the exact point at which a drug is reordered.

The Minimum and Maximum values do not change once they are set because the values are 
independent of usage. This is particularly useful for drugs that need to be overstocked or under-
stocked.

Minimum and Maximum values have to be set manually for each drug record because dosage 
formats and usage will vary from product to product. Minimum and Maximum values do not change 
once they are set, so users must manually adjust min/max values during spikes or dips in product 
usage.

Days supply ordering
The Min/Max fields are calculated values based on the days supply. These reorder points are dynamic 
values that increase or decrease depending on how often the drug is dispensed within the days supply 
indicated. This is particularly useful for cyclical drugs like allergy medications that are dispensed 
frequently during some parts of the year, but less during others.

As the Minimum and Maximum fields are calculated values, you have less control over the exact point 
the drug is placed on order. You cannot overstock or understock.

Applying min/max ordering to a drug
All drugs default to use days supply overriding, but you can manually apply min/max ordering to specific 
drugs as needed.

 1.  From the  F5 - Drug search window, select the applicable drug record.

 2.  Select the Ordering tab.

 3.  Set the  Base Ordering On field to Min/Max. 

The Days fields are greyed out. The  Minimum and Maximum fields become editable.

Applying min/max ordering to a drug > Min/Max ordering
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Potential drawbacks of days supply ordering
The Minimum and Maximum fields are not open for manipulation as they are now calculated values; this 
means users have less control over the exact point the drug is placed on order.

The Minimum and Maximum values change depending on how frequently the drug is dispensed; therefore, 
this may be a problem for products the pharmacy wishes to overstock or under-stock.

Sending a drug order
 1.  From the menu, select Utilities > Drug Ordering > Generate Orders.

The Drug Order Form is displayed.

 2.  Select Place Order.

The Create PO pop-up is displayed.

Optionally select View Vendor to view the read-only vendor settings. 

Potential drawbacks of days supply ordering > Days supply ordering
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 3.  Select Create or press Enter.

The following pop-up is displayed:

 4.  Select Yes.

If you select No, the order is saved as pending. To send it later, select it from Utilities > Drug 
Ordering > Communication with > [Vendor name].

The selected vendor's Drug Ordering window is displayed.

 5.  Select Start or press Enter from Drug Ordering > Communication with > [Vendor name]. This 
will begin the process of sending the PO to the vendor.

Sending a drug order > Days supply ordering
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 6.  As the purchase order is being sent to the vendor, the Activities portion of the window will begin 
to populate with the status of actions being taken.

 7.  When the order has been transmitted successfully, click Finish or press Enter to close the 
communication window.

Resending and ordering
You may need to resend an order if it is not transmitted on the first try.

 1.  From the Alt-X Start window, select Utilities > Drug Ordering > Communicate With >
[Vendor] > Recreate Purchase Order.

The communication form for the selected vendor is displayed. 

 2.  Select Show Sent Orders.

 3.  Select the order that needs to be re-sent.

Resending and ordering > Days supply ordering
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 4.  Select Create Order or press Enter.

If an existing order is still waiting to be sent, you are asked whether you want to append your 
order to the existing order, or replace it.

You are then prompted to confirm re-sending the order. Select Yes or Press Y.

The new order file details are displayed.

Resending and ordering > Days supply ordering
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Each vendor has a unique naming convention for invoice files.

Receiving a drug order
Once the pharmacy physically receives their drug order from the wholesaler, the order must be received 
into Kroll so that the On Hand and Pricing values are updated. An order can be received electronically (i.e. 
based on the vendor’s invoice download) or manually (i.e., based on the purchase order you generated).

The process of retrieving invoice files consists of three tasks:

 1.  Checking for invoice files

 2.  Retrieving invoice files

 3.  Processing invoice files

This last task is executed after logging out of the vendor’s server.

Checking for invoice files
The information panel shows the Checking for Invoice File(s) task is in progress.

When the Checking for Invoice File(s) task is complete, the information panel shows a status of 
Completed, along with the number of invoice files that were found.

If no files were found, the Retrieving Invoice File(s) task is skipped since there are no files to retrieve. 
Later, the Processing Invoice File(s) task is skipped as well.

Receiving a drug order > Days supply ordering
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Retrieving invoice files
If invoice files are found during the Checking for Invoice File(s) task, the Retrieving Invoice File(s) 
activity is automatically initiated. As soon as each file is retrieved, the information panel shows the 
corresponding filename. You can follow the progress of each file being retrieved on the top progress bar; 
the bottom progress bar shows the percentage of invoices that has been retrieved.

The invoice files are temporarily saved in the designated vendor directory, until they are updated in Kroll.

If an invoice file was retrieved from the vendor’s server, but was not processed because you cancelled it, it 
is picked up in the next communication process.

Processing invoice files
If invoice files were found and retrieved, the Processing Invoice File(s) activity is automatically initiated. 
At this point, the communication process tries to match information in the invoice file to a purchase order in 
Kroll. When the process finds a match between an invoice file and a Kroll PO, a window similar to the 
following is displayed:

Retrieving invoice files > Days supply ordering
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The top panel on this window shows a list of retrieved invoice files with associated PO numbers. Refer to 
the message  to the right of the PO number to help decide which file to process.

Use the checkbox in the upper left hand side of the window to select or deselect all invoice files/POs in the 
list. The indicator in the upper right hand side identifies the number of PO(s) that have been selected.

The  information in the bottom panel is related to one of the invoice files shown in the top panel. The table 
on the left displays the information contained in the invoice file. The table on the right displays all the items 
within a PO in Kroll. You can resize the panels to adjust how much information is displayed.

Processing invoice files > Days supply ordering
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In the above window, the invoice file on the left (i0002559) is associated with PO 2559 on the right. The 
invoice file contains only four items. The idea is to allow you to compare information inside the invoice file to 
information in the PO before the file is processed. Selecting any item on either side of the grid highlights the 
corresponding item on the opposite side, if available.

For example, in the right-hand grid above, item 00148619 (NOVO-TRIMEL 40MG/5ML SUSP), which is 
highlighted in red, was ordered for one pack (Ord Qty column). Comparing this to the left grid, you can see 
that the received quantity (Rcv Qty column) is also one pack, which means everything ordered was 
received.

In the right-hand grid below, item 00407627 (PMS-FLUOROMETHOLONE 0.1%), which is highlighted in 
aqua, was ordered for four packs, but the invoice file indicates that the vendor only sent three packs. A 
tooltip indicates “Short-Partial quantity shipped”.

Processing invoice files > Days supply ordering
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In the right-hand grid below, item 000481124 (APO-PROPRANOLOL 20MG), which is highlighted in aqua, 
is out of stock and nothing was shipped, although the left-hand grid indicates that one pack was ordered. A 
tooltip indicates “[Vendor name] Short (No Stock)”.

In the right-hand grid below, item 02170538 (PMS-CLARITHROMYCIN 500MG TABS) was ordered, but 
the invoice file on the left indicates that the vendor sent item 02170530 as a substitution. A tooltip indicates 
“Substitute for 02170538 – substitution”. The vendor only sends substitutions for customers who provide 
consent to do so.

Processing invoice files > Days supply ordering
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When the Processing Invoice File(s) task does not find a matching PO in Kroll, you must decide what to 
do with the PO. The following table describes the options you can choose:

Name Description
Treat as 
no stock 
received

The invoice file is received, taking into consideration that no equivalent PO exists in Kroll. 
On-hand quantities are not updated; catalog prices are updated as necessary. Select this 
option if an order was placed outside of Kroll for items for without inventory and prices that 
are monitored in Kroll (e.g. OTC items).

Treat like 
non-PO 
receive

The invoice file is received, taking into consideration that no equivalent PO exists in Kroll. 
On-hand quantity and prices for associated drug packs, if available, are updated. Select 
this option if an order was placed outside of the Kroll application for items with inventory 
and prices that are monitored in Kroll (e.g., Rx order sent directly from the vendor’s 
website).

Skip this 
PO

The invoice file is not processed. It remains outstanding.

To set a default action for this option, go to Utilities > Drug Ordering > Edit Vendor List > [Vendor 
name] > Receiving and select the appropriate option from the Default Action when PO not found 
dropdown list.

Processing invoice files > Days supply ordering
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If you do not select an invoice file/PO equivalent, the invoice sits in Utilities > Drug Ordering > Electronic 
Invoice Receiving with no Received On date.

Processing an invoice

 1.  Update the purchase order information in Kroll.

In this step, the purchase order status is set to “Received” or “Partially Received”.

This step is not executed when the file or PO is configured to be treated like a non-PO receive, or 
a no stock received.

Processing invoice files > Processing an invoice
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 2.  Update the drug pack prices.

In this step, the system looks at the Receiving settings set in Utilities > Drug Ordering > Edit 
Vendor List > [Vendor name] > Receiving to determine if and where drug pack prices are 
updated. 

This step is not executed when the file/PO is configured to be treated as “no stock received”.

 3.  Adjust the drug pack inventory.

In this step, the on-hand quantity of a drug pack is adjusted if the following settings are in place:

Perform Inventory Adjustment in File > Configuration > Store > Order must be turned 
on.

No Inventory Adjustment in the Drug > Ordering tab must be deselected. This step is not 
executed when the file/PO is configured to be treated as “no stock received”.

 4.  Update the catalog prices.

In this step, the system looks at the Catalog File Loading rules set in Utilities > Drug Ordering 
> Edit Vendor List > [Vendor name] to determine if and where drug pack prices are updated 
via the catalog.

When the Processing Invoice File(s) task is complete, the status shows as Completed and the 
information panel displays the message “### End of Activities ###”. Two new buttons, Retry 
and Finish, are displayed at the bottom of the communication window to indicate that 
communication has finished. 

Processing invoice files > Processing an invoice
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 5.  Do one of the following:

Select Finish or press Enter  to close the communication window. 

Select Retry or press CTRL+R to start another communication with the vendor.

Processing invoice files > Processing an invoice
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The prescription filling process is a well-defined series of steps that pharmacy users carry out to produce 
prescriptions for their patients. Kroll is designed to work with the established prescription filling process to 
provide the safest, most efficient, and reliable prescription services to patients. The steps for filling vary 
according to the workflow you implemented. In this document, the process 

Drop-Off

Data Entry

Packaging

Pharmacist Verification

Pickup

If at any point during the workflow, you do not want to finalize a step, you can select one of the following 
buttons:

Save for Later: the F9 - Workflow window is displayed.

Cancel Rx: the prescription is reversed, and marked as Cancelled in the patient profile. Cancelled Rxs 
can be filled later.

Reject: the Rx is rejected and the application returns to the previous stage while still maintaining the 
work order priority sequence.

Trouble: the Rx is removed from the work order priority queue.

Drop-off
The following steps must be performed at the drop-off stage to ensure patient safety and to proceed to the 
next Rx processing stage in the system:

 1.  Search for and select a patient record

 2.  Review the patient's medication history

 3.  Indicate a prescription due time (i.e., pick up time),

Chapter16
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 4.  Select a status for the prescription (i.e., Fill, Unfill, Not Disp, Stock Transfer)

 5.  Scan the written prescription into the system

 6.  Indicate the number of drugs on the written prescription

Pharmacy assistants, pharmacy technicians, and pharmacists can drop-off prescriptions into the system 
as follows:

 1.  From the ALT+X Start window, select F11 - Drop-Off or press F11.

 2.  Search for and select the applicable patient record (see Searching for a Patient from the F11-
Drop Off window). 

 3.  Select a wait time from the Priority field.

To enter a custom wait time, select F2, then enter a custom Date and Time.

The Delivery field defaults to Pickup.

 4.  After an Rx barcode sticker has been attached to the written prescription, feed it into the 
document scanner and select Import Script Image File or Select Script Image. If the 
prescription was faxed to the pharmacy, select Import Script Image from fax scan to select 
and attach a faxed image to the work order.

If you are unable to scan the script image into the system, you can instead enter a Drug/Mix, 
Doctor, Dispense Quantity, Days Supply, and Sig.

 5.  After the image has been scanned into the system, you can use the following tools to adjust it: 
Crop, Flip, Rotate, and Fit to Window. 

 6.  Select Save or press Enter  to insert the image into the Drop-off window.

New Rxs > Drop-off
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 7.  Enter the number of medications on the written prescription in the # of Rxs On Page field. 

This tells the system how many Rxs are associated with the Rx image.

 8.  To Clear (i.e. delete) or Re-Scan a script image, select Clear Script Image from the right 
navigation pane. 

This removes the existing image and allows you to re-scan the old image or scan a new image.

 9.  Select an Rx Status:

Fill: Process and dispense the Rx

Unfill: Put the Rx on hold

Not Disp: Mark the Rx as OTC to Profile

Stock Transfer: Mark the Rx as a stock transfer to another pharmacy

 10.  Optionally enter workflow-specific notes in the Note tab near the bottom of the window. 

These notes are displayed at each Rx filling stage for the prescription.

 11.  Select Add to create the work order. 

The Rx is displayed in the Workorder items pane.

 12.  Repeat steps 10-11 for each Rx you want to add to the work order for that patient. 
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 13.  When you have added all the Rxs, select Finalize Work Order.

A blank F11-Drop-Off window is displayed.

Tracking a work order after drop-off
Once a work order for a new Rx has been dropped off, it proceeds to the enter stage. You can access the 
enter queue from the F9-Workflow window.

To access the F9-Workflow window from the ALT+X-Start window, select F9-Workflow or press F9.

The dropped order appears in the enter queue in the applicable due-time column. The list of Rxs in 
Progress on the lower half of the window shows which orders are coming up next in the selected 
queue. The entries on the lower half of the window are for information purposes only; you cannot 
change the work order due time.

Data Entry
During the Data Entry stage, you enter prescription information such as Drug, SIG, Dispense quantity and 
intervention codes into the system for processing. Extra care should be taken at this point to ensure the 
work order passes through the Check quickly without having to make time-consuming changes later on. 
Typically, the enter stage is completed by a pharmacy assistant, but it can also be completed by licensed 
technicians and pharmacists.

Tracking a work order after drop-off > Drop-off

237 © 2025 TELUS Health Kroll User Guide



 1.  From the Alt-X Start window, select F9 - Workflow.

 2.  Select Data Entry to display the data entry queue.

 3.  Select Get Work to view the work orders that need to be input. 

Work orders are always presented to you in priority sequence according to the due time assigned 
to the work order. 

Data Entry > Drop-off
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 4.  Select Get Work to view the next work order that needs to be entered, or double click a specific 
row to select that prescription.

The Rx Order window is displayed. 

Data Entry > Drop-off
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 5.  Complete this form as needed, then select OK.

Make any necessary changes to the fields on the main window, then select F12 - Save 
Changes.

The Clinical Reports window is displayed.

 6.  Review the information on the tabs.

You can select a tab to display it, or use the Next and Back buttons to navigate between them.

 7.  If there is a reason you should not fill the Rx at all or at this time, select Reject or Trouble 
respectively, otherwise proceed to the next step.

 8.  Select Finished.

The Rx Order window is displayed again.

 9.  Review it and select OK.

 10.  Select F12 - Fill Rx.

A confirmation message is displayed indicating that the Create Rx Order was successful. 

 11.  Select OK.

A confirmation message is displayed indicating that the Dispense Rx was successful. 

 12.  Select OK.

You are prompted to print the applicable dispensary label.

The Rx you worked on is now ready for packaging.

If you are not ready to package it, and you return to the F9 - Workflow window, the Rx is now in 
the Packaging queue.

Data Entry > Drop-off
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F12 window tabs
The following sections describe the tabs at the bottom of the F12 window.

Plans
You can use this tab to exclude third party plans from the prescription, or change the sequence in which the 
plans are billed. Plans are billed in the sequence they are listed.

The following table describes the fields on this tab.

Name Description
Next Disp 
Qty

The new Dispense Quantity for the next refill. This is especially useful for trial 
prescriptions wherein the first order has a lower dispensing quantity than the next.

Min Interval 
Days

This is used for narcotic prescriptions to prevent refilling until a specified number of days 
have elapsed.

Max Disp 
Qty

The maximum quantity that can be handed out at each dispense.

Comments Any comments specific to the prescription.

Pricing
The Pricing tab displays information about the pricing strategy used to calculate the Rx. Pricing strategies 
are set by the home office and cannot be modified; however, if a price needs to be overridden, you can 
select the Manual Price checkbox to enable the Cost, Markup, Fee, Mix Fee, and SSC fields, and then 
adjust their values. 

F12 window tabs > Plans
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Manual pricing should only be used in emergency situations. Please report incorrectly priced prescriptions 
to the Pharmacy Support Helpdesk for resolution.

Dates

The following table describes the fields on this tab.

Dates > Plans
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Name Description
Written This is automatically populated with the date the Rx was processed, but can be 

replaced with the date the prescription was written.
Dispensing 
allowed period

The period during which the drug can be dispensed.

Administration 
period

The period during which the drug can be administered.

Drug expiry The drug expiry date for the prescription, which is printed on the vial label. This 
option is especially useful for liquid antibiotics.

Ingest The ingest date for methadone prescriptions.
Copy 
Information

 

Therapeutic 
start

The period during which the therapy is applied.

Transferred In or 
Out

The date the prescription was transferred in or out.

Comments
You can add comments and notes from the Plans and Comments tabs. From the Comments tab, you can 
select additional attributes that are not available on the Plans tab.

Comments > Plans
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 1.  To insert a new comment, select Ins or press Insert, then select Comment.

The RX Comment pop-up is displayed. 

 2.  Select a Topic and enter your comment.

 3.  To show the comment when filling a prescription, select Show On Rx.

 4.  To show a pop-up message during filling that indicates a comment is present, select Alert.

 5.  To include the comment on the hard copy prints during filling, select Print On Hardcopy

This checkbox can only be selected for one comment, as there is limited space on the hardcopy.

 6.  To include the comment on any refills for this prescription, select Keep Comment for Refills.

 7.  To copy the comment to a new prescription, if the original prescription is copied, select Keep 
Comment for Copied Rxs.

 8.  To display a comment during one or more steps in the workflow, select the Edit button adjacent 
to Workflow Alerts, then select one or more workflow steps and select OK.

 9.  To choose which workflow the comment is applied to, select Edit, the select the applicable 
workflow.

If you select more than one workflow, it will only be displayed on the first workflow 
unless you escape out of the Rx and return to it for the next workflow.

Comments > Plans
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 10.  Select Save.

Indications
The Indications tab allows you to identify which condition the prescription is treating. 

When you select Ins or press Insert, a list of ICD- 10-CA and/or FDB conditions is displayed.

Highlight the indication you want to apply to the prescription and click Select.

Indications > Plans
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Images
Select the Images tab to display the script image that was scanned during drop-off. Select View Image to 
view the scanned image and + to add a new image.

Other

The following table describes the fields on this tab.

Name Description
Admin Sites The area on the patient's body that the drug is administered.
Max Dosage The max dosage of drug that can be administered per time measurement, such as 

hour or day. You can enter two max dosages.
Doctor 
Authorization 
Received

This should always be selected, as it indicates that prescriber authorization to 
dispense the prescription has been received.

Include in 
Narcotic report

Select to include the Rx in the narcotic report even if it is not a narcotic prescription.

Images > Plans
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Name Description
No Doc 
ERenewal

If selected, doctor eRenewal is prohibited,

Transaction 
Comment

Displays any comments specific to the transaction. This can be a user comment, 
system comment, or a comment transferred from the To Do comment section. This 
comment will not be transferred to refills or copied Rxs.

Packaging
During the packaging stage, you prepare the Rx packs.

 1.  From the Alt-X Start window, select F9 - Workflow.

 2.  Select Packaging.

 3.  Select Get Work to view the next work order that needs to be packaged, or double click a 
specific row to select that prescription.

Work orders are always presented to you in priority sequence according to the due time assigned 
to the work order. 

Packaging > Plans
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 4.  Double-click the Rx you want to package.

If the patient has other Rxs available to package, you are asked whether you want to call them up 
as well. If you select Yes, you will be prompted to package all of the Rxs.

The Package Rx window is displayed.

 5.  To view a list of the additional Rxs in the patient's work order, select the F2 button next to the 
Work Order field.

Packaging > Plans
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 6.  If you do not have enough inventory to fill the entire prescription:

Select Owe.

The Edit Rx Owe pop-up is displayed.

Enter the number to Owe Later.

Adjust the values of the other fields as needed.

Select OK.

 7.  In the DIN or UPC field, enter the DIN or UPC, then select Lookup.

A DIN or UPC match should be found.

 8.  Adjust the Qty as needed.

 9.  Enter an Expiry Date and Lot.

 10.  Select Package.

The packaging information is added to the Packaging Details section.

Packaging > Plans
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 11.  Repeat steps 7 to 10 until you have added all of the packs, as specified by the Qty field. 

When you have fulfilled the quantity, a All Drug Packs have been packaged message is 
displayed and the Packaged button is enabled.

 12.  Select Packaged.

You are prompted to print the applicable dispensary labels.

The Rx you worked on is now ready for pharmacist verification.

 13.  If it is not ready for pharmacist verification, and you return to the F9 - Workflow window, the Rx is 
now in the Pharmacist Verification queue.

Pharmacist Verification
The pharmacist verification stage must be performed by a pharmacist or licensed technician. This is the 
final check that is made before the prescription is bagged and filed in the pickup drawers. During this stage, 
you should verify the filled prescription against the written prescription and the electronic drug image 
displayed on the window.

 1.  From the F9 - Workflow window, select the Pharmacist Verification queue.

The Rxs that are ready to be verified are displayed. 

Pharmacist Verification > Plans
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 2.  Select Get Work to view the next work order that needs to be verified, or double click a specific 
row to select that prescription.

The Clinical Verification window is displayed. 

 3.  Verify that the packaged prescription matches the electronic drug image.

You can select the tabs to display the Rx or its images, or the financial information, workflow, or 
packaging.

The list at the bottom displays all of the patient's Rxs. To view more information about a specific 
Rx, right click its row and select Detail.

 4.  Select Approve.

You are prompted to print the applicable dispensary labels.

The Rx is now ready for pickup.

Pickup
During the prescription pick up stage, you verify the identity of the person picking up the prescriptions, 
identify the number of prescriptions that need to be retrieved from the pickup bins, and identify the location 
of a prescription.

Pickup > Plans
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 1.  Select F10 - Pickup.

The Pickup window is displayed.

 2.  Select the prescriptions the patient is picking up, then select Pickup # Items.

A confirmation window is displayed.

 3.  Select Confirm # Items.

The selected Rxs are now complete.

Pickup > Plans
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Refillable Rxs can be filled for patients who  had their previous prescription filled at the same pharmacy 
location. Typically, refill information is entered when the prescription is initially filled, and patients can 
choose if they want to enrol in the Refill Reminder program, which notifies them when their prescription 
refills are ready. 

From the F3 - Patient window
 1.  From the Alt-X Start window, select F3 - Patient.

 2.  Enter one of the following patient search criteria, then select Search:

Last name, first Name.

For example, one of the following: “Doe, Jane”, “doe,j”, “Doe”, or “,Jane” 

A period (.) and the patient quick code.

For example, ".DoeJ”

A 7 or 10-digit phone number.

For example, "800-263-5876" or "263-5876"

A number sign (#) and the third party billing number.

For example, "#123456789"

An asterisk (*) to return all of the patients in the database.

 3.  Double-click the patient record.

The F3 - Patient window is displayed.

 4.  Select Refillable Rxs from the right navigation pane.

 5.  Use the space bar to highlight the medication(s) the patient would like to refill, then select F - 
Refill or  select  Extra Functions and select Add To Rx To Do List.

Chapter17
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 6.  Select a Due Date for the Rxs. 

A prescription is added to the Enter queue.

 7.  Complete the workflow.

From the F11 - Drop-Off window

With Rx Number

 1.  From the ALT+X Start window, select F11- Drop-Off or press F11.

 2.  Enter the prescription number in the RxNum field, then select Lookup.

The Rx is displayed in the F11 - Drop-Off window. 

From the F11 - Drop-Off window >With Rx Number
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 3.  Enter a Due time.

The prescription is added to the Enter queue.

 4.  To add the Rx to the Workorder Items list, select Add.

 5.  Select Finalize Work Order to move the prescription to adjudication.

If any DUR messages are present, the pharmacist will need to resolve them before moving the 
prescription  to the filling queue.

Without Rx Number

 1.  From the F11- Drop-Off window, perform a patient search.

 2.  From the right navigation pane, select Refillable Rxs 

The patient's profile is displayed. 

From the F11 - Drop-Off window >Without Rx Number
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 3.  Use the space bar to highlight the Rx(s) you want to refill, then select F - Refill or press the F key 
on your keyboard.

The selected Rxs are displayed in the Workorder Items list on the F11 - Drop-Off window. 

 4.  To edit any of the information in an Rx:

Double-click the Rx to display it in the F11 - Drop-Off window. 

Make the necessary changes and select Update.

 5.  Select Finalize Work Order.

From the F11 - Drop-Off window >Without Rx Number
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Patients may not want all of their prescriptions filled when they drop them off. For documentation purposes, 
these prescriptions are put on hold and referred to as Unfilled Rxs. Unfill Rxs pass through Drop-Off, 
Enter, and Check  processing steps.

Chapter18
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After a prescription has been processed, you can modify its prescription comments, refills, and other fields 
that do not have clinical or financial impacts.

Method 1: From the F3 - Patient window
 1.  From the Alt-X Start window, select F3 - Patient, then search for and select a patient record.

The patient profile is displayed. 

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar  to tag the Rx(s) you want to modify. 

 4.  Select M - Modify or press the M key.

 5.  Select F12 - Save Changes.
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Method 2: From the Alt-X Start window
 1.  Enter the Rx number in the Universal Search field and select Modify Rx.

The Rx is displayed in the F12 window in Modify mode.

 2.  Update the editable fields as needed.

 3.  Select F12 - Save Changes.

Method 2: From the Alt-X Start window >
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The Copy Rx function allows you to copy information from an existing prescription to a new prescription. 
This function is often useful when the doctor renews a patient’s existing medications and there is no 
change in dosage or SIG.

It is not recommended to copy a prescription when the dose, SIG, or prescriber has changed, because 
copying a prescription creates a  link between the new and old prescriptions, as a result of which the original 
prescription is set to “Inact (Copied)” and cannot be transferred out.

From the F3 - Patient window
 1.  From the Alt-X Start window, select F3 - Patient, then search for and select the patient.

The patient profile is displayed. 

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar  to tag the Rx(s) you want to copy. 

Chapter20
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 4.  Select Extra Functions > Copy to New Num and Make Unfilled.

The Copy to a New Number and Unfill Rxs pop-up is displayed.

 5.  Enter or select at least one value on this pop-up, then select Apply.

The copy is displayed in the F12 window as a New Rx. 

 6.  Select a due time and change the prescription as needed.

 7.  Select F12 - Fill Rx.

 8.  Complete the workflow. 

From the F3 - Patient window >
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When you cancel a prescription, you reverse it, which includes reversing any claims sent to third party 
plans. You may need to cancel a prescription if, for example, there is a change in dispensing quantity, the 
wrong SIG was entered, or the patient no longer wants it.

Method 1: From the F3 - Patient window
 1.  From the Alt-X Start window, select F3 - Patient, then search for and select a patient.

The patient profile is displayed. 

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar to tag the Rx(s) you want to modify. 

 4.  Select C - Cancel or press C.

The system prompts you with various messages for cancelling the prescriptions.

These messages vary depending on the type of prescription you are cancelling
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Method 2: From the Alt-X Start window
 1.  Enter the Rx number in the Universal Search field and select Cancel Rx.

A prompt appears, asking if you are sure you want to cancel the Rx.

 2.  Select Yes.

Method 2: From the Alt-X Start window >
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If a patient is no longer using a certain medication as part of their medication therapy, the associated 
prescription should be manually inactivated. Prescriptions are automatically inactivated when they are 
copied to a new prescription number or if they are transferred out of the pharmacy.

 1.  From the Alt-X Start window, select F3 - Patient, then search for and select the patient.

The patient profile is displayed. 

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar to tag the Rx(s) you want to modify. 
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 4.  Select I - Inactivate or press the I key.

You are prompted to enter an optional reason for inactivating the Rx. 

 5.  Select OK to continue. 

The status of the prescription  in the patient profile is set to 'Inact'.

Inactivate Rx >
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 1.  From the Alt-X Start window, select F3 - Patient, then search for and select the patient.

The patient profile is displayed. 

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar on your keyboard to tag the Rx(s) you want to modify. 

 4.  Select Extra Functions > Reactivate Rx.

Chapter23
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 5.  The Reactivate Rx window displays the selected Rx(s). The Status indicates if an Rx is eligible 
to be reactivated.

Reactivate Rx >
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Over-the-counter medicines that are taken by the patient are included in the patient profile for drug 
interaction analysis. In Kroll, these "OTC to profile records" are known as Not Dispensed Rxs because 
the pharmacist did not dispense a prescription.

Drop-Off
 1.  From the ALT+X Start window, select F11- Drop-Off or press F11.

 2.  Search for the patient and select a Due time.

 3.  Use the document scanner to scan any counseling notes about the OTC product  into the system.

 4.  Set the Rx Status to Not Dispensed.

 5.  In the Doctor field, enter the name of the pharmacist on duty.
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 6.  Select Add to add the work order to the Workorder items list.

 7.  Select Finalize Work Order.

Enter
During the Enter stage,  you enter prescription information such as Drug, SIG, Dispense Quantity, and 
Intervention Codes into the system for processing.

 1.  From the Alt-X Start window, select F9 - Workflow.

 2.  Select Enter to display the enter queue.

 3.  Double-click the Not Dispensed Rx record.

The F12 window displays the Rx details entered at Drop-Off.

 4.  Enter any missing Rx information, such as the Dispense Quantity and Intervention Codes.

 5.  To specify a stop date, select the Dates tab and enter an Rx Stop date. 

If the store is connected to a Drug Information System, you may be required to enter a stop date.

 6.  Select F12 - Fill Rx or press the F12 key.

Enter >
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Fee for service prescriptions are billed to third parties for professional service rendered by the pharmacist 
to the patient.  They include prescription adaptation services, medication reviews, refusals to fill, and 
smoking cessation. Since these services are intangible and do not involve the dispensing of a drug 
product, some of the elements of prescription processing may be eliminated. Fee for service prescriptions 
should always be filled after the service has been provided to the patient.

Drop-Off
 1.  From the ALT+X Start window, select F11- Drop-Off or press F11.

 2.  Search for the patient and select a Due time.

 3.  Set the Rx Status to Fill.
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 4.  Select Add to add the work order to the Workorder items list.

 5.  Select Finalize Work Order.

Enter
Fee for service drug records typically have a DIN or Pseudo DIN used for billing, but do not have UPC, 
counseling, drug monograph, or ordering tabs, as these do not apply for services rendered to a patient.

 1.  From the Alt-X Start window, select F9 - Workflow 

 2.  Select Enter to display the enter queue.

 3.  Double-click the Rx record.

The F12 window displays the Rx details entered at Drop-Off. 

 4.  Use the Drug Search field to search for and select the applicable professional service.

Depending on what you select, the system may send a Special Services Code, Intervention 
Code, Rx prefix, etc. to third parties as a part of billing requirements.

The  Drug Price Group field may specify a pricing strategy to apply to the drug record  for 
prescriptions filled for the service.

 5.  In the Doctor field, enter the name of the pharmacist who provided the professional service.

Enter >
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 6.  To view any intervention codes or special service codes that will be submitted to third parties as 
part of the claim, select Plan Information from the right navigation pane to display the Rx Plan 
Information window.

 7.  Enter any remaining Rx information.

 8.  Select F12 - Fill Rx or press F12.

Enter >
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Prescriptions can be transferred into or out of the pharmacy. In both cases, information regarding the 
transfer is recorded in the system.

Transferring an Rx from another store
Transfers received from other pharmacies are treated as new prescriptions and must go through the same 
stages as new prescriptions.

Drop-Off
 1.  From the ALT+X Start window, select F11- Drop-Off or press F11.

 2.  Search for and select the patient.

 3.  Feed the transfer report into the document scanner and select Import Script Image File.

 4.  Select Add to add the work order to the Workorder items list.

 5.  Select Finalize Work Order.

Enter
 1.  From the Alt-X Start window, select F9 - Workflow .

 2.  Select Enter to display the enter queue.

 3.  Double-click the Rx record.

The F12 window displays the Rx details entered at Drop-Off. 

 4.  Select Transfer Rx From Another Store from the right navigation pane.

The Transfer Rx from other store window is displayed. 
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 5.  In the Search for a store field, begin typing the name of the originating pharmacy. If a matching 
pharmacy is located, either double-click the entry or highlight the entry and press Enter.

If no matching pharmacy is found, select New to insert a new transfer pharmacy record, then 
complete the Create Store form and select OK.

 6.  In the Pharmacist Name field, enter the name of the pharmacist on duty.

 7.  Enter any available Rx information in the Rx information from other store fields.

 8.  Select OK.

 9.  Complete the remaining Rx fields and select F12 - Fill Rx.

Transferring an Rx to another store
 1.  From the  F3 - Patient window, search for and select a patient.

 2.  Select All Rxs from the right navigation pane.

 3.  Use the space bar to tag the Rx(s) you want to transfer.

Transferring an Rx to another store >
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 4.  Select Extra Functions > Transfer Rx to Another Store.

The Transfer Out Rx(s) window is displayed.

 5.  In the Search for a store field, begin typing the name of the pharmacy to which you want to 
transfer the Rx. 

Transferring an Rx to another store >

Kroll User Guide © 2025 TELUS Health 275



 6.  If a matching pharmacy is located, double-click the entry, or highlight it and press Enter.

If no matching pharmacy is found, select New to insert a new transfer pharmacy record, then 
complete the Create Store form and select OK.

 7.  In the Pharmacist Name field, enter the name of the pharmacist on duty.

 8.  Select Transfer Out Eligible Rxs.

A prompt appears, asking if you want to print the transfer report.

 9.  Select Yes or No accordingly.

The Rx shows a status of Inact (Transferred Out) in the patient profile.

Transferring an Rx to another store >
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Patient merges
 1.  From the Alt-X Start window, select Utilities > Merge > Patients.

The Transfer Patient Profiles form is displayed. 

Chapter27
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You can merge two different patient, drug, or prescriber records into a single, unified record. 
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 2.  From the New Patient to be transferred TO field, search for and select the patient record you 
want to keep. 

The patient’s address is added to the form.

 3.  From the Old Patient to be transferred FROM field, search for and select the patient record 
you want to merge.

The patient’s address is added to the form. 

 4.  Select Transfer.

A prompt appears, asking if you are sure you want to merge the two patients. 

 5.  Select Yes.

 6.  Select Cancel to close the Transfer Patient Profiles Form.

Drug merges
 1.  From the Alt-X Start window, select Utilities > Merge > Drugs.

The Merge Drugs form is displayed. 

Drug merges >
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 2.  Enter the drug names in the respective New Drug to be merged TO and Old Drug to be 
merged FROM fields and select Lookup.

 3.  From the list of search results, select the drug you want to merge, then click Select. Click Select 
again.

A second list of search results is displayed.

 4.  From the second list, select the drug you want to merge from, then click Select. Click Select 
again.

The Merge Drugs Form is displayed again, with both drugs shown.

 5.  Select Transfer.

A prompt is displayed, asking if you are sure you want to merge the drugs. 

Drug merges >
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 6.  Select Yes.

The Merge Pack Size form appears, asking you which drug pack you want to keep and if you 
want to merge the on-hand quantities for both drugs. 

 7.  Select From Drug to retain the drug pack for the drug you merged from, or To Drug to retain the 
drug pack for the drug you merged to.

 8.  Select Merge On Hand Quantities if you want the on-hand quantities for both drugs to be 
merged.

A prompt appears, asking you to confirm the number of prescriptions that were transferred to the 
new drug, and  if you want to delete the old drug from the system. 

If you select Yes, the old drug is deleted and drug you merged to remains. 

If you select No, the drug you merged from remains in the system.

Prescriber merges
 1.  From the Alt-X Start window, select Utilities > Merge > Doctors.

The Merge Doctors form is displayed. 

Prescriber merges >
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 2.  From the New Doctor to be transferred TO field, search for and select the prescriber record 
you want to keep. 

The prescriber’s address is added to the form.

 3.  From the Old Doctor to be merged FROM field, search for and select the prescriber record you 
want to merge.

The prescriber’s address is added to the form. 

 4.  Select Transfer.

A prompt appears, asking if you are sure you want to merge the two prescribers. 

 5.  Select Yes.

 6.  Select Cancel to close the Merge Doctors Form.

Prescriber merges >
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The privacy and security of patient credit card information in Kroll complies with Payment Card Industry 
(PCI) regulations. Access to credit card information is limited to individuals belonging to groups for which 
the   Allow Credit Card Password Management permission is enabled. 

For more information, see Permissions.

Creating a credit card access password
 1.  From the Alt-X Start window, select Utilities > Credit Card Password Manager.

The Credit Card Password Manager window is displayed. 

 2.  Select Create new Credit Card Access Password.

The Create New Credit Card Password form is displayed.

Chapter28
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 3.  Enter the credit card password in the New Password and Verify New Password fields, then 
select OK.

Passwords must be at least seven characters in length and contain both alpha and numeric 
characters.

The Credit Card Password Manager window shows an Expiry date of three months from 
today’s date. 

 4.  Select Close to exit the window.

Entering patient credit and debit cards
 1.  From the patient profile, select Patient > View Credit Cards.

The Credit Cards panel is displayed. 

 2.  Select Ins or press the Insert key.

The Patient Credit Card Information form appears with the patient’s address information filled 
in. 

Entering patient credit and debit cards >
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 3.  Select a Card Type.

 4.  If you selected Credit Card:

Select the Card Type and enter the Card Number, Expiry Date, and Cardholder Name. 

Select Save.

Entering patient credit and debit cards >
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 5.  If you selected EFT:

Enter the Bank Number, Transit Number, and Account Number.

Select Save.

 6.  Enter the credit card password in the Password field and select OK.

The credit or debit card is added to the list on the Credit Cards panel. 

Modifying a credit and debit card records
 1.  From the patient profile, select Patient > View Credit Cards.

The Patient Credit Card List window is displayed. 

 2.  Select the card you want to modify and select or press F2.

 3.  Update the card information and select Save.

 4.  Click Close to exit the Patient Credit Card List window.

Modifying a credit and debit card records >

285 © 2025 TELUS Health Kroll User Guide



Deleting a credit or debit card record
 1.  From the patient profile, select Patient > View > Credit cards.

The Patient Credit Card List window is displayed. 

 2.  Select the credit card you want to modify and select Del or press Delete.

A prompt appears, asking if you are sure you want to delete the credit card record. 

 3.  Select Yes.

 4.  Select Close to exit the Patient Credit Card Information window.

Deleting a credit or debit card record >
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You can access the Kroll reports from the menu, by selecting Reports and then the type of report, or  by 
selecting Reports > Search and entering part of the report name.

The following types of reports are supported in Kroll 10:

Patient

Rx

Drug

Doctor

Nursing Home

Administration

Other

Old

Common daily reports
This section outlines the most commonly used daily reports.

Pharmacy End of Day report
The Pharmacy End of Day report shows a snapshot of the prescription totals for the day.

 1.  To generate this report, select File > Exit or press Alt + F + Q.

A prompt appears, asking if you want to print this report.

Chapter29

Reports

Kroll User Guide © 2025 TELUS Health 287



 2.  Select Yes.

Network Totals report (Adjudication Totals From Network)
At the end of the day, the Network Totals report shows the real-time totals for the third party plans. The 
Pharmacy Day End report and Network Totals report should balance.

You are prompted to generate the Network Totals report after the Pharmacy End of Day report is 
generated.

Network Totals report (Adjudication Totals From Network) >
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Common weekly reports
This section outlines the most commonly used weekly reports.

Adjudication Totals report
The Adjudication Totals report shows the amounts Kroll has recorded as being paid by third parties. 
Unlike the Network Totals report, the Adjudication Totals report does not communicate in real time to 
the third party plans.

 1.  From the menu, select  Reports > Rx > Adjudication Totals.

The Adjudication Totals report form is displayed.

 2.  On the Selection tab, use the Date Range, Starting, and Ending fields to specify a date range.

 3.  To select the plans you want included in the report, select the F2 button next to the Plans field.

Common weekly reports >
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 4.  Select the Options tab to specify the report parameters. 

 5.  Use the Group By options to specify how the report will be organized.

Adjudication Totals report >
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 6.  Click Preview to preview the report or Print to generate a printout of the report.

Daily/Monthly Totals report
The Daily/Monthly Totals report summarizes the total dollar values for the date range specified on either 
grouping them daily or monthly based on your selections in the report. It is important to note that this is a fill-
based report, meaning it will only reconcile with other fill- based reports.

Daily/Monthly Totals report >
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 1.  From the menu, select Reports > Rx > Daily/Monthly Totals Report.

The Daily/Monthly Totals Report form is displayed. 

 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

 3.  Optionally select the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report.

 4.  To generate the report for specific patients only, select the Patient button and select Add. 
Search for and select each patient you want included in the report.

 5.  To generate the report for specific nursing homes only, select the Home button and select Add. 
Select the Home and applicable Ward and select OK.

Repeat this step for each home you want to include in the report.

Daily/Monthly Totals report >
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 6.  Select Preview to preview the report or Print to generate a printout of the report.

Plan Summary report
The Plan Summary report summarizes the total dollar values, including cash, generated for all plans 
within a specified date range.

 1.  From the menu, select Reports > Rx > Plan Summary.

The Plan Summary Report form is displayed.

 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

Plan Summary report >
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 3.  Optionally select the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report.

 4.  To generate the report for specific nursing homes only, select the Home button and select Add. 
Select the Home and applicable Ward and select OK. 

Repeat this step for each home you want to include in the report. 

 5.  Select Preview to preview the report or Print to generate a printout of the report.

Plan Summary report >
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Other common reports
This section outlines some other commonly used reports.

Claims Invoice report
The Claims Invoice report captures the prescriptions filled to non-real time plans (i.e., manual billing 
plans).

 1.  From the menu, select Reports > Rx > Claims Invoice.

The Claims Invoice report form is displayed.

Other common reports >
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 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

 3.  To select the patient groups you want included in the report, select the F2 button next to the 
Patient Groups field.

 4.  To generate the report for specific patients only, select the Patient button and select Add, then 
search for and select each patient you want to include.

 5.  To generate the report for specific nursing homes only, select the Home button and select Add. 
Select the Home and applicable Ward and select OK. 

Repeat this step for each home you want to include on the report.

Claims Invoice report >
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 6.  Select the Options tab to specify the report parameters. 

 7.  Use the Group by options to specify how the report will be organized.

Claims Invoice report >
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 8.  Select the following checkboxes:

Print cost, fee & markup:  required when manually submitting to a plan for payment.

Print total: the total must be provided to the plan.

Print prev paid/3rd party pays: needed for a manual bill plan if a previous online plan has 
paid part of the  claim.

Print co-pay: needed for the manual bill plan if there is a pre-set deductible for that plan. 

For example, the manual plan might pay 80% and the patient 20%.

Show subplans instead of plans: includes manual bill plans that are part of other plans. 

For example, a manual bill plan created under the Assure plan, is a sub plan of Assure.

Include same-range cancels: if the prescription has been cancelled and then rebilled, the 
cancel for the initial number and the rebill with the new Rx number are both displayed.

Include items where plan pays $0.00: includes  manually billed plans.

Include data for real-time plans:  includes data from real time plans that may have paid a 
portion of the prescription previously or were set to bill manually.

Claims Invoice report >
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 9.  Select Preview to preview the report or Print to print it. 

The second page of the printed report shows the total number of Rxs billed and reversed, and the 
net amounts due. It also includes the cost, markup, fee total, copay, and third party amounts. 
This is typically kept for pharmacy records.

The last page is the Report Summary. This page is typically kept by the pharmacy to track what 
they have submitted.

Claims Invoice report >
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Narcotic report
The Narcotic report is used to track the reportable and forced reportable drugs that have been dispensed 
by the pharmacy.

 1.  From the menu, select Reports > Drug > Narcotic Report.

The Narcotic Report form is displayed.

 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

 3.  To add drug schedules to the report, select the F2 button next to the Drug Schedule field.

Narcotic report >
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 4.  Use the Show drop-down list to specify if you want the report to show all Rxs, or only those Rxs 
with or without doctor authorization.

 5.  Use the Sort By drop-down list to change how the report is sorted.

 6.  Select Preview to preview the report or Print to print it. 

Narcotic report >
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Profit/Loss report
The Profit/Loss report is used to identify profit and loss margins. You can print this report for all Rxs for a specific 
profit and loss amount or percentage, within a specific date range. It also shows discounts applied during the 
adjudication process.

 1.  From the menu, select Reports > Rx > Profit/Loss.

The Profit/Loss report form is displayed.

 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

 3.  Use the F2 button next to the Plans field  to select the plans you want to include in the report.



 4.  Select the Options tab to specify the report parameters.

 5.  Select the following checkboxes, as applicable:

Print same day cancels:  includes Rxs that were cancelled the same day they were filled.

Exclude cancelled Rxs:  excludes cancelled Rxs from the report.

Show discount:  includes discounts applied to prescriptions during the adjudication process.

Show Initials: includes the initials of the user who filled the prescription.

Include fee in Rx Total calculation: includes the fee in the total $ calculations.

Summary only: prints a summary (no details) of the options enabled.

Print Rxs where Profit Amount > than #: opens up fields to include profile, loss or discounts, amounts 
or percentages that are >, <, =, >=, or <= than a specific dollar amount.

Print Rxs where Total > than 0:  includes Rxs where the total is >, <, =, >=, <= the specified dollar 
amount.

Print only Rxs with manual price: includes only those prescriptions that have been set up with a 
manual price override.

 6.  Optionally change the Fee For Service selection.
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 7.  Select Preview to preview the report or Print to print it.
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 1.  From the menu, select Reports > Patient > Patient Medical History.

The Patient Medical History report form is displayed.

 2.  Use the Date Range, Starting, and Ending fields to specify a date range.

Chapter29

Medical History report
The Medical History report shows the contents of the patient’s profile.
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 3.  To select the patient groups you want to include in the report, select the F2 button next to the 
Patient Groups field.

 4.  To generate the report for specific patients only, select the Patient button and select Add. 
Search for and select the patients you want to include in the report.

 5.  To generate the report for specific nursing homes only, select the Home button and select Add. 
Select the Home and applicable Ward and select OK.

Repeat this step for each home you want to include in the report.

 6.  Select the Options tab to specify the report parameters.

Medical History report >
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 7.  Select the following checkboxes, as applicable:

Print Store Logo: prints the store logo on the report.

Print Billing Info: includes patient billing information such as the patient plan and billing 
number.

Include Inactive Rxs: includes inactive prescriptions.

Display Refills: select to display refills.

Group Refills: select to group refills together.

Print disclaimer: prints a disclaimer at the bottom of every page.

Print disclaimer only at end of report: prints the disclaimer at the end of the report only.

 8.  Select Preview to preview the report or Print to print it. 

Medical History report >
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Rx for Drug/Doctor Group Report
The Rx for Drug/Doctor Groups report is used to find a particular dispense for a specific drug, doctor, 
drug group, or doctor group. This report is especially useful for drug recalls.

 1.  From the menu, select Reports > Rx > Rx for Drug/Doctor Groups.

The Rx for Drug/Doctor Groups Report form is displayed.

Rx for Drug/Doctor Group Report >
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 2.  From the Selection tab:

Select All active Rxs to generate the report for all currently active Rxs, or Rxs filled to 
specify a Date Range, Starting date, and Ending date.

Optionally use the Rx Lot Number field to specify the lot numbers you want to include in the 
report.

Optionally select the F2 button next to the Plans field to select the plans you want to include 
in the report.

Rx for Drug/Doctor Group Report >
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 3.  From the Patient tab:

To generate the report for specific patients only, select the Patient button and click Add. 
Search for and select each patient you want to include in the report.

To generate the report for specific nursing homes only, select the Home button and then 
select Add. Select the Home and applicable Ward and select OK. Repeat this step for each 
home you want to include in the report.

Optionally select the F2 button next to the Patient Groups field to select the patient groups 
you want to include in the report.

Rx for Drug/Doctor Group Report >
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Optionally select the F2 button next to the Provinces/States field to select the provinces or 
states you want to include in the report.

Rx for Drug/Doctor Group Report >
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 4.  From the Drug tab:

Optionally select the F2 button next to the Drug Groups field to select the drug groups you 
want to include in the report.

Optionally select the F2 button next to the Drug Schedule field to select the drug schedules 
you want to include in the report.

Optionally select the F2 button next to the Drug Departments field to select the drug 
departments you want to include in the report.

Rx for Drug/Doctor Group Report >
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To generate the report for specific drugs only, select the Add button below the Drug field, 
then search for and select drug you want to include in the report.

The Remove button removes individual items from the Drug list, and the Clear button 
removes all items from the Drug list.

 5.  From the Doctor tab:

Optionally select the F2 button next to the Doctor Groups field to select the doctor groups 
you want to include in the report.

To generate the report for specific prescribers only, select the Add button below the Doctor 
field, then search for and select prescriber you want to include in the report.

The Remove button removes individual prescribers from the Doctor list, and the Clear 
button removes all prescribers from the Doctor list.

Rx for Drug/Doctor Group Report >
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 6.  From the Options tab:

Use the Group By options to specify how the report will be organized.

Select Include Fee For Service Rxs, Exclude Fee For Service Rxs, or Only Fee For 
Service Rxs to specify how you want the report to handle Fee For Service Rxs.

Rx for Drug/Doctor Group Report >
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The most common fields that should be enabled are described below:

Print Unfills: Includes all unfills (Rxs placed on Hold).

Print Not Dispensed: Includes all Rxs marked as Not Dispensed (i.e. OTC Rxs).

Print Inactive: Includes all Rxs with a status of Inactive.

New Rxs only: Prints new prescriptions only.

Show Drug: Prints the drug name.

Show Lot#: If you maintain lot numbers in your drug cards, selecting this option includes 
them in the report

Show Rx Details: Prints the Rx quantity, the status, the first fill, the remaining quantity, 
the authorized quantity and the current fill date.

Financial Breakdown: Includes all of the financial details of prescriptions.

Separate Special Services Fee: Separates the SSC field (Special Services Fee Field) 
from the other cost fields.

Print Sig Codes: Prints with the sig code for prescriptions.

Sort by Province/State: Sorts by  province or state.

Page break on new Prov/State: Prints patients in the same province or state on 
separate pages.

Show Patient Address Information: Includes the patient address and telephone 
number.

Show Extended Patient Information: Prints nursing home, ward, and postal code 
information.

Show Room and Bed Number: Includes the bed number assigned to patients in 
nursing homes.

Show extended Doctor Information: Includes doctors' license numbers, phone 
numbers, and addresses.

Checked by: Prints a signature line at the bottom of the report.

Group by options: Groups report data either by drug (which works well if you have 
selected more than one drug), Patient (works well also if you have selected more than 
one Patient) or by Rx # (which will group in chronological order of dispense by Rx 
number).

Page Break: Use to select items to print on separate pages.

Fee for Service: Includes or hides fee for service items.

Sort By: Sorts this report. This is enabled only when grouping by patient. 

 7.  Select Preview to preview the report or Print to generate a printout of the report.

Rx for Drug/Doctor Group Report >
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Drug Inventory Listing report
The Drug Inventory Listing report lists drugs and their inventory values. Its details vary according to the 
options you choose. You can opt to show a total value of inventory in the pharmacy or a line for each drug.

 1.  From the menu, select Reports > Drug > Drug Inventory Listing Report.

The Drug Inventory Listing Report form is displayed.

 2.  From the Selection tab, optionally use the F2 buttons next to the various fields to select the drug 
groups, price groups, manufacturers, drug schedules, vendors, drug tiers, and department 
groups you want to include in the report.

Drug Inventory Listing report >
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 3.  From the Options tab:

To specify what drug packs will be included in the report, select Active, Inactive, or Either 
from the Pack Status section.

To specify what on-hand values will be included in the report, select Less Than Zero, Equal 
To Zero, and/or Greater Than Zero from the On Hand (per pack) section.

Include ‘no inventory adjustment’ packs: select to print all drugs not flagged for inventory 
adjustment (i.e. during the “Receive “process).

Show only packs not dispensed since [x]: select to include only those drugs that have not 
been filled since the date entered.

Print packs with an inventory value greater than [x]: select to print all drugs with an 
inventory value greater than the number entered.

Show only Drugs with an On hand Qty [Greater or Less] than [x] days supply: select 
to print any values greater or less than the days supply selected.

Show inventory total only: select to print the inventory value only, not a detailed list.

Drug Inventory Listing report >
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Show inventory waiting to be packed or picked up: select to include drug inventory that 
is waiting to be packed or picked up.

Show only Drugs excluded from Kroll price updates: select to present a list of drugs that 
have been excluded in Kroll price updates. The  Only allow manual price changes 
checkbox on the drugs card is selected for these drugs.

Sort: select F2 to choose the sequence in which records are displayed on the report.

Printer, Tray, and Copies: select the printer, tray, and number of copies you want to print.

Drug Inventory Listing report >
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 4.  From the Options 2 tab:

Show quickcode: select to print any quickcode assigned to a drug. 

Sort by quickcode: select to sort records by their quickcodes.

Show manufacturer, Show DIN, Show pack size, and Show acquisition cost: select to 
show the drug manufacturer, drug identification number, drug pack size, and drug acquisition 
cost, respectively.

Manufacturer fields: select these to include the dollar value listed on the applicable 
manufacturer field of the drug card.

Show on hand min and Show on hand max: Select to include the min and max on-hand 
values, respectively. These values appear when inventory controls are set to min/max.

Show days supply: select to include days supply values. This field is enabled when the 
inventory control is set to days supply.

Show average daily usage: select to include the average daily usage.

Show brand and generic names: select to print the brand and generic names of the drugs.

Drug Inventory Listing report >
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Show UPC: select to include the UPC for each individual drug.

Show Last Used Date: select to print the last time the drug was filled in a prescription.

Show Central Maintenance Flag: select to include a column that indicates whether each 
drug is centrally maintained.

Show Blank Line after On Hand Quantity: select to present a line after each on-hand 
value. This is often used to record the number of tablets counted during the fiscal inventory 
process.

 5.  Select Preview to preview the report or Print to generate a printout of the report.

Drug Inventory Listing report >
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Drug Inventory History report
The Drug Inventory History report presents a historical snapshot of drug inventory values based on the 
options you choose.

 1.  From the menu, select Reports > Drug > Drug Inventory History.

The Drug Inventory History Report form is displayed.

 2.  From the Selection tab:

Select  a Date Range or enter Starting and Ending dates.

Use the F2 buttons next to the various fields to select the manufacturers, drug groups,  drug 
schedules, drug pricing groups, and inventory changes you want to include in the report.

Printer, Tray, and Copies: select the printer, tray, and number of copies you want to print.

Drug Inventory History report >
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 3.  From the Selection 2 tab:

Use the F2 buttons next to the Drug Tiers and Drug Departments fields to select the drug 
tiers and drug departments you want to include in the report.

To generate the report for specific drugs only, select the Add button below the Drug field, 
then search for and select the appropriate drugs.

Select the Remove button to remove individual drugs from the Drug list, or the Clear button 
to remove all of the drugs.

Drug Inventory History report >
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 4.  From the Options tab:

Print each drug pack on a new page: select to print each pack size on a separate page.

Select the Show DIN: select to include the Drug Identification Numbers of the  selected 
drugs.

 Show Schedule: select to include the drug schedule.

 Show Reportable: select to include the reportable flag from the drug card.

Show Acq cost: select to include the drug acquisition cost.

Show Primary Vendor’s Item Number: select to include the  item numbers from each 
drug's primary vendor.

Drug Inventory History report >
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Show Secondary Vendor’s Item Number: select to include the  item numbers from each 
drug's secondary vendor.

Show dollar value of Units moved: select to include the dollar value of the units moved.

Show Manufacturer: select to include the manufacturer’s short code, for example APX for 
Apotex.

Show Brand/Generic Type: select to print the type of drug, for example: Generic Multi 
Source, Generic Single source, Brand, Brand single source, or Brand Multi source.

Show reason for Inventory Change: select to print the reason for the inventory change, 
and the time the change was made.

Wrap Full Reason: select to wrap the reason text if it exceeds the width of the page.

 5.  Select Preview to preview the report or Print to generate a printout of the report.

Drug Inventory History report >
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Rx Totals report
The Rx Totals report prints the number of new Rxs, repeat Rxs, total Rxs, and percentage totals based on 
the options you select.

 1.  From the menu, select Reports > Rx > Rx Totals.

The Rx Totals Report form is displayed.

Rx Totals report >
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 2.  From the Selection tab:

Select  a Date Range or enter Starting and Ending dates.

To generate the report for specific patients only, select the Patient button and select Add, 
then search for and select each patient you want to include in the report.

To generate the report for specific nursing homes only, select the Home button and select 
Add, then select the Home and applicable Ward and select OK. Repeat this step for each 
home you want to include in the report.

Use the F2 button next to the Patient Groups and Plans fields to select the patient groups 
and plans you want to include in the report.

Printer, Tray, and Copies: select the printer, tray, and number of copies you want to print.

Rx Totals report >

Kroll User Guide © 2025 TELUS Health 327



 3.  From the Doctor tab:

Select the F2 button next to the Doctor Groups field to select the doctor groups you want to 
include in the report.

To generate the report for specific prescribers only, select the Add button below the Doctor 
field, then search for and select each prescriber you want to include in the report. 

Rx Totals report >
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 4.  From the Drug tab:

Use the F2 buttons next to the Drug Price Groups and Drug Groups field to select the drug 
price groups and drug groups you want to include in the report.

Rx Totals report >
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 5.  From the Users tab:

Use the  F2 button next to the Users and User Groups fields to select the users and user 
groups you want to include on the report.

Rx Totals report >
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 6.  From the Options tab:

Summary only: select to print a summary only of the selected information

Show address information: select to include the patient or doctor address.

Show percentages of total: select to include the percentage of the total Rxs and the total 
dollar value.

Print NH-inactive patients: select to  include inactive nursing home patients.

Rx Totals report >
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Print deceased patients: select to include patients who were set to deceased within the 
report's timeframe.

Print discharged patients: select to include patients who were discharged from a nursing 
home within the report's timeframe.

Include unfilled Rxs: Select to include unfilled Rxs in the report's Rx count.

In the Group By section, select the category by which you want to group records.

In the Show section, select All to include All Rxs, or  Top [x] to include only the specified 
number of top records.

 7.  Select Preview to preview the report or Print to generate a printout of the report.

Price Tree report
The Price Tree report provides all the pricing information setup in the Kroll system, including pricing 
strategies, patient price groups, drug price groups, and the pricing strategies attached to the plans.

Price Tree report >
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 1.  From the menu, select Reports > Other > Price Tree Report.

The Price Tree Report form is displayed.

 2.  Select the items you want included in the report.

Price Tree report >
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 3.  Click Preview to preview the report or Print to generate a printout of the report.

Price Tree report >
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Sig Code Listing Report
The Sig Code Listing report prints all sig codes you set up in Kroll.

 1.  From the menu, select  Reports > Other > Sig Code Report.

The Sig Code Listing Report form is displayed.

 2.  Select a Language.

 3.  Select a Sort by option. 

If you select Token, the actual sig code is printed on the report (i.e., BID). If you select Text, the 
sig code definition is printed on the report (i.e., ‘twice a day’).

 4.  If you selected a language other than English on the Selection tab, and you want the report to 
show the English translation, select Show equivalent default language translations on the 
Options tab.

Sig Code Listing Report >
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 5.  Select Preview to preview the report or Print to generate a printout of the report.

Future Usage report
The Future Usage report prints the prescriptions due for refill within a specified time frame. It is useful 
when preparing medication orders specifically for inventory you do not readily keep on hand.

Future Usage report >
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 1.  From the menu, select Reports > Rx > Future Usage Report.

The Future Usage Report form is displayed.

 2.  From the Selection tab:

Use the Date Range, Starting, and Ending fields to specify a date range.

To generate the report for specific patients only, select the Patient button and select Add. 
Search for and select the patients you want to include in the report.

To generate the report for specific nursing homes only, select the Home button and select 
Add. Select the Home and applicable Ward and select OK.

Repeat this step for each home you want to include in the report.

Select the F2 button next to the Patient Groups field to select the patient groups you want to 
include in the report.

Future Usage report >
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 3.  From the Selection 2 tab:

Use the F2 buttons next to the various fields to select the plans, drug groups,  manufacturers, 
drug departments, patient auto refill status, and patient auto refill notifications you want to 
include in the report.

Future Usage report >
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 4.  From the Options tab, select the parameters you want applied to the report.

 5.  Select Preview to preview the report or Print to generate a printout of the report.

Future Usage report >
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Compliance Label report
The Compliance Label report works in conjunction with the Unit Dose feature found at the prescription 
level. You can use it to create compliance labels for 7-day pill packs that can be affixed to  Jones Box 
compliance packages, thus replacing the need to print a label for every Rx.

 1.  From the menu, select Reports > Patient > Compliance Label.

The Compliance Label report form is displayed.

Compliance Label report >
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 2.  From the Selection tab:

Enter the Effective Date of the first package, if it differs from today's date.

In the # of Weeks field, enter the number of cycles you want to run the report.

To generate the report for specific patients only, select the Patient button and click Add. 
Search for and select the patient you want to include in the report.

To generate the report for specific nursing homes only, select the Home button and select 
Add. Select the Home and applicable Ward and select OK.

Repeat this step for each home you want to include in the report.

Use the F2 button next to the Patient Groups field to select the patient groups you want to 
include in the report.

Compliance Label report >
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 3.  From the Selection 2 tab:

To include all of the Rxs in the patient profile in the report, select All Rxs, otherwise select 
Show only or Exclude and then select an Rx type.

To add all Unit Dose unfills in the patient profile included in the report, select Include unfills. 

This is especially helpful if you have copied to a new number and put a prescription on hold.

To include Rxs marked as ward stock for nursing home patients, select Include ward stock.

Use the F2 button next to the Cards field to select the cards you want to include in the report 
(optional). 

This is used for prescriptions that have been separated by a card number.

To include Rxs filled on a particular date only, select Show only meds filled on and enter 
the specific date.

Compliance Label report >
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 4.  From the Options > General tab:

Optionally change the Pass Time fields, which are set by default.

In the Panels section, specify the number of panels you want printed on each page. This is 
particularly important if you have pre-defined compliance labels in a 2, 4, or 6-panel layout.

Use the X Offset and Y Offset controls to adjust the layout of the report; X Offset controls 
left justification and Y Offset controls vertical alignment.

To include a check list for packaging the compliance packages, select Print Compliance 
Checklist.

Use the  Sort By field to specify how you want the report to be organized.

Use the Med Sort field to specify the order in which the compliance label will be printed.

Compliance Label report >

Kroll User Guide © 2025 TELUS Health 343



 5.  From the Options > Header tab: 

Select the Header style.

To change the position of the patient and store information on the report, select Swap 
Patient and store info.

To include the family doctor on the report, select Print family doctor.

This information comes from the Family Doctor field on the patient card.

To replace the patient's address with the nursing home information, select Replace patient 
addr. with NH info.

To print the patient's name in large font, select Print large patient name.

To include the effective date of the compliance package, select Print effective date.

To include the assigned card numbers in the unit dose section of the prescription, select 
Print Card Numbers.

To print page numbers in the upper right hand corner of the report, select Print “Page x of 
y”.

Compliance Label report >
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 6.  From the Options > Body tab, select the options you want included in the report.

The options on this  tab vary according to the selected Panel style. The following image shows 
the options available for Style 1. 

Compliance Label report >
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 7.  From the Options > Central Fill tab:

Optionally select Send to Central Fill, then do the following:

Select the Central Fill host Packager.

In the Resub batch #, enter the number of the batch you want to resubmit.

 8.  Select Preview to preview the report or Print to generate a printout of the report.

Compliance Label report >
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Report discrepancies may occur if multiple systems are used to measure various pharmacy metrics. This 
section explains how to identify and resolve discrepancies, and how to minimize them in the future.

Fill and adjudication dates
Each Rx has multiple date components, including one fill date, which may have been backdated. Each plan 
associated with the Rx also has an adjudication date:

For paper plans, the adjudication date is typically equal to “today”. 

For real-time plans, the adjudication date is returned by the third party.

Each Rx may have multiple real-time third party plans, in which case, the adjudication dates will fall on 
different days. In most cases, the fill and adjudication dates match. It is those exceptions that can appear to 
throw off certain reports. This is especially true with backdated Rxs; the fill date may be set to an earlier 
day, but the adjudication date is still “today”.

When you are comparing reports, refer to the report header to determine if the report was based on the fill 
or adjudication date. Do not compare a fill date report against an adjudication date report. They might 
initially match up, but over a large period, they likely will not.

Most Rx-based reports use the fill date and most plan-based reports use the adjudication date. 
The Plan Summary report, which  was created to enable retail clients to  count the number of 
Rxs filled for each plan, is an exception. It is effectively an Rx-based report that is broken down 
by plan, which is usually based on the adjudication date. As a single Rx can contain multiple 
plans, the Rx is counted once. The Rx is attributed to either the first paying plan or the primary 
plan, depending on which option you select. Do not compare this report to other plan-based 
reports, as it will not balance. Please note the disclaimer on the bottom of this report, which 
asks that you do not use this report to reconcile your third party claims.

Chapter30

Report discrepancies explained
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Reversals and net totals
All of the reports include reversal amounts, which are subtracted from the forward amounts to provide the 
net totals. Typically, Rxs that were filled and reversed within the report date range are excluded from the 
totals. If you see a reversal amount, it means the Rx was reversed during the report period but was 
originally filled prior to the report period. For example, an Rx that was filled in January and reversed in 
February is included in a January report as a forward claim and a reversal in a February report, but is 
excluded from a report that encompasses both January and February.

Most reports identify these prior period reversals as Reversals or Prior Day Reversals, which should be 
read as prior period reversals.  The Adjudication Totals report differs; it separates reversals into “same day” 
and “prior day” reversals. Even if this report is run for a monthly period, Rxs reversed on a day other than 
the day they were filled are counted in the “Prior Day” column. This report  is intended to match exactly with 
the values returned by real-time third party plans when requesting on-line daily summaries. If you  compare 
this report against another adjudication date-based report, the reversals count may not match, as the other 
reports use the entire report date range to determine if a reversal falls outside of the entire range.

Backdates
If you run two reports based on a fill date and for the same date range--one immediately after the 
completion of a period, and one at a later date--the reports may not match due to backdates. A backdate is 
the only way that a report run in the past can effectively be changed in the future.

When reconciling reports, especially fill-based reports, always use reports that are printed on the same 
date and at approximately the same time. If you have specific reporting periods and an Rx is backdated to a 
previous period, you might want to manually record this Rx on a form so it can be properly reconciled. Kroll 
records the real date (today) when a backdate takes place and this is noted on some of the reports.

Date-based adjudication reports are not affected by backdating, as the adjudication date for 
the Rx's plan is always today, unless the real time third party should happen to return a 
different date, as it might for an Rx filled after midnight, Eastern time.

Claims Invoice report

Net amount representation
When a claim is submitted to a third party insurer, the amount billed on the invoice may include the local 
patient co-payment amount, depending on the insurer.

By default, Kroll includes the co-payment amount in the Net column, as this is the preference of most third 
party insurers. The net amount is also shown in the summary sections of the report. All other Kroll reports 
show the amount being billed to that third party, exclusive of the local patient co-payment. If any of your 
third parties are set to the default and you attempt to match the report summary of the Claims Invoice 
report with another report showing the amount billed to the third party, the amounts will not appear to match 
if co-payments are involved.

Reversals and net totals > Net amount representation
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If your paper plans need to use the non-default configuration (that the net amount should not include the 
co-payment value), please contact TELUS Health for assistance in setting up each third party to use the 
paper claim Net amount reporting option for each affected plan. Only if all third party plans are set to the 
non-default setting will the report’s grand total Net amount balance with other plan-based Kroll reports. As 
this is unlikely, you will not be able to match the Net amount on this report with that on other reports.

When running this report, do not select the Include data for real-time plansoption. Other reports, such as 
the Adjudication Totals report, are more suitable for reporting real-time plan totals. 

Third party plan imbalances
For each third party claim,  the  cost, mark up, fees, totals, and other cost values are shown, unless you hid 
them via the report form. These values are entities of the Rx as a whole, so if the same Rx has another plan 
that is being billed during the same date range used by the report,  the same cost values are shown for that 
plan. These values are subtotalled for each plan. In the overall report summary, each plan is shown and the 
grand total for the report is the sum of all the subtotals.

For example, if you had a single Rx for $100 that was billed to two different plans, both of which are 
included in this report, then the subtotal for each plan would show total of $100 for each claim, and the 
report grand total would add these together to produce a grand total of $200. This anomaly in this report’s 
grand totals means the grand total will not balance with other reports.

Reconciling
Reconciliation is the process of balancing one report against another. For fill date-based reports, you can 
run the following on the same day for any range and they should all balance:

Daily/Monthly Totals

Rx Breakdown

Rx Totals

Profit/Loss

For adjudication date-based reports, run the following:

Plan Breakdown (do not check any of the “Exclude” options)

Adjudication Totals (do not exclude “zero-amount” claims)

When running the Claims Invoice report, it is best to deselect Include items where plan pays 0.00 and 
Include data for real-time plans as this helps to eliminate most tertiary plan billing that will misrepresent 
the grand totals, as noted above. The grand total on this report matches the manual plan amounts on the  
Plan Breakdown and Adjudication Totals reports.

Summary
The following key points were noted above:

Do not compare fill date-based reports with adjudication date-based reports. When in doubt, look at the 
report header to determine which date is being used.

Do not compare the Plan Summary report with other reports.

Always compare reports printed on the same date. Refer to the Printed On date on the report header.

Third party plan imbalances > Net amount representation
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Be aware of how previous-period reversals are reported. Always use the “Net” amount columns when 
comparing reports.

Summary > Net amount representation
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This section explains each of the configuration settings that are available in the Kroll application. The 
configuration windows are accessed via File > Configuration.

Store- and head office-level configuration
The store- and head office-level configuration windows are similar, but not identical. There are some small 
differences, especially for chain locations. In the head office configuration window, you can right click a 
setting to lock it down so it cannot be changed at the store level. Locked settings are shown in red on the 
head office-level configuration window and disabled on the store-level window.

Chapter31

Configuration
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This is used to enforce business rules for chains that want stores to have the same level of access to the 
settings.

General

The following table describes the configuration settings on the General tab.

Name Description
Allows Column 
Configuration

Enables users to change the appearance of the pre-set columns on the F3, F5 and 
F7 windows. *

Enable NH / 
Batch

Enables users to access to the basic nursing home module, which means they can 
use batch filling, as well as plain paper MARs and TMRs.

Always show 
scan

If selected, the Scan button is enabled for searches. If this button is selected, the 
user's changes are saved and the  search window is displayed.

General >
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Name Description
Prompt to exit 
when closing 
fill application

If selected, when users  exit Kroll, they are prompted to confirm they want to exit, and 
asked whether they want to print the Day End Label and the Network Totals. 

Use Unit Dose 
Packaging

If selected, users can choose the unit dose packaging at the patients card level. 
They can then set the type of unit dose and the cycles when medication is to be filled, 
and set up specific strategies for pricing on unit dose prescriptions. 

Show alert 
when services 
are down

If selected, a warning is displayed to users when the pharmacy server is down.

Use separate 
delivery hours 
of operation

If selected, the store's delivery hours are shown separately from its hours of 
operation.

Use automatic 
capitalization

If selected, the first character of each word is capitalized when filling out a form.

Enabled Ctrl-
Print window to 
Print 
Screenshot

If selected, the print window function is enabled.

Language The default language for all patient records. You can change this for individual 
patient records.

Country The default country for all patient and prescriber records. You can change this for 
individual patient and prescriber records.

Area code The default area code for all patient and prescriber records.   If this is set and a patient 
or prescriber is added,  this area code prefix is automatically added to all seven-digit 
numbers.

You can change this for individual patient and prescriber records.
Regular The next prescription number the system will use when filling a regular prescription.
Narcotic The next prescription number the system will use when filling a narcotic prescription.
Fiscal Starts The day the store's fiscal year starts on.
GST, PST, HST The tax percentages.

Most Rxs are non-taxable, except for veterinary prescriptions, as well as some 
charges to AR accounts.

GST Number The government sales tax number for tax purposes.
Method The type of name used to identify the workstation.
Explicit Name The name of the workstation.
Pharmacy # The pharmacy number.
Store Name The name of the pharmacy.
Address 1, 
Address 2, City, 
Postal

The pharmacy's address.

Phone, Phone 2 The pharmacy's phone number.
Fax, Fax 2 The pharmacy's fax number.

General >

Kroll User Guide © 2025 TELUS Health 353



Name Description
Email The pharmacy's email address.
Web page The pharmacy's web page.
Latitude and 
Longitude

The longitude and latitude of the store location.

Sort Rx transfer 
stores by

The sequence in which to sort stores that are available for transfer.

Online 
Appointments 
Pharmacy 
Message

A message displayed to patients when they are booking appointments with the 
pharmacy.

Global Store 
Logo

The store's logo.

Rx # Prefix A prefix applied to Rxs for the specific store.
Corporate ID The store's corporate ID.
Default time 
scale

The default appointment duration.

Patient

Patient >
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1 - General tab
The following table describes the configuration settings on the Patient > 1 - General tab.

Name Description
Provincial plan Your province, for use on the F3 Patient window.
Provincial plan 
label

The default plan name, for use on the F3 Patient window.

Quick code label A code that can be used when searching for drugs from the F3 - Patient window. 
This field can also be used to store reward card numbers.

Quick code type The program the quick code represents.
Prompt to create 
AR account for 
NH patients

If selected, the user is prompted to create an AR account for a patient when the 
patient is assigned to a nursing home.

Automatically 
close autofill 
batch if 
successful

If selected, the batch fill window is closed after the batch is completed.

Require gender 
on patient card

If selected, the gender field on the patient profile is required.

Require postal 
code on patient 
card

If selected, the postal code field on the patient profile is required.

Allow duplicate 
quick codes

If selected, quick codes can be reused.

Creatinine 
Clearance 
equation

The method used to calculate creatinine clearance is calculated.

Include copied 
patient in 
original patient's 
family

Whether patients will be linked from the F3 window (always, never, or prompted).

Default clinical 
conditions

The default clinical condition database.

Hide cancels in 
all profiles

If selected, cancelled Rxs are hidden in the patient profile.

Hide cancels in 
Rx detail

If selected, cancelled Rxs are hidden in the Rx detail.

Hide cancels in 
the "Active" 
(Shift-F5) profile

If selected, cancelled Rxs are hidden from the Active Rxs view.

Hide expired Rxs 
in the "Active" 
(Shift-F5) profile

If selected, expired Rxs are hidden from the Active Rxs view.

Patient > 1 - General tab
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Name Description
Hide stopped 
Rxs in the 
"Active" (Shift-
F5) profile

If selected, stopped Rxs are hidden from the Active Rxs view.

Retain highlight If selected, any Rxs highlighted in the patient profile will remain highlighted after 
you modify them.

Ignore provincial 
plans

If selected, provincial plans are ignored when searching for patients.

Ignore clinical 
plans

If selected, clinical plans are ignored when searching for patients.

Prompt to print 
labels when 
inactivating Rxs 
from profile or 
Rx screen

If selected, a prompt is displayed, asking if you want to print a label set when 
inactivating an Rx.

Prompt to 
complete 
delivery order

If selected, you are prompted to complete a delivery order, if applicable.

Prompt to select 
allergy 
ingredients 
when selecting 
FDB medication 
names

If selected, you are prompted to select allergy ingredients when you select FDB 
medication names.

Prompt to add 
new or modified 
plans to existing 
Rxs

If selected, a prompt is displayed on the F12 window when a new plan has been 
entered into the patient's profile but has not been used for previous Rxs.

Prompt for 
Billing/Delivery 
on alternate 
addresses

If selected, a prompt is displayed for billing/delivery when an alternate address is 
used.

Prompt for 
patient privacy 
consent

If selected,  a patient privacy consent message is displayed when information is 
added to the patient profile. This message is displayed until the pharmacy records 
whether the patient has given consent to record their information locally or on the 
network. Users can choose Unknown, Written, Verbal, or No Consent. Once an 
option is selected, the privacy consent message no longer displays for that patient.

Require patient 
privacy consent 
to fill Rx

If selected, users must respond to the patient privacy consent message before they 
can fill a prescription.

Require 
guardian 
consent for 
patients under 
age X

The age under which patients need guardian consent.

Patient > 1 - General tab
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Name Description
Enable consent 
for authorized 
agent

If both this checkbox and the Configuration > Kroll > Modules > Enhanced 
consent checkbox are selected, consent records are inserted, deleted, or revoked 
when an agent is inserted, deleted, or revoked.

Enable delivery 
authorization

If selected, delivery authorization is enabled.

Prompt for 
delivery consent

If selected, the user is asked if they want to complete the delivery consent.

Patient 
Document 
Retention

If selected, patient documents are retained as per the criteria set below.

Type The type of date used when calculating the retention period.
Retain 
documents for X 
years and X 
months

The number of years and months documents are retained.

Retain the 
following patient 
reports when 
run

If selected, selected patient reports are retained after they are run.

Default unit dose 
patient price 
group

The unit dose patient price group used by default.

For retail 
patients and  For 
NH patients

The default patient card tab for retail patients and NH patients, respectively.

Enable bill by 
default on first 
new alternate 
address

If selected, the patient's AR account is automatically billed to the alternative 
address entered on the F3 window.

Require postal 
code on 
alternate 
addresses

If selected, the postal code must be entered when an alternate address is entered.

Patient > 1 - General tab
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2- Agent tab

The table on this tab is used to specify the permissions granted to authoritative and non-authoritative 
caregivers. The types of relationships that represent authoritative caregivers for adults and minors are 
identified using the fields at the bottom of this window. The relationships that are not selected  are 
considered non-authoritative caregivers.

Patient > 2- Agent tab
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Drug

The following table describes the configuration settings on the Drug tab.

Name Description
Selling The label for the selling cost.
Enable Pack Pricing If selected, pack pricing is enabled for the selected label.
User Cost 1, User Cost 2, 
User Cost 3, User Cost 4, 
User Cost 5

One of these fields is automatically assigned as the purchase price; the 
next four can be adjusted. Their values vary depending on which vendor 
is used or if provincial pricing is used instead. For example, in an Ontario 
pharmacy, you might see:

User Cost 0 Label – McKesson

User Cost 1 Label – K&F

User Cost 2 Label – ODB (BAP) – This is locked down for Ontario

User Cost 3 Label – ODB (MAC) – This is locked down for Ontario 
(BAP = Best available Price MAC = Maximum Allowed Cost)

Fee per minute The default amount that will be charged per minute for preparing a 
mixture. This must be entered in cents.

Drug > 2- Agent tab
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Name Description
Don't charge fees for 
mixtures less than or 
equal to X minutes

If  a mixture takes less than or equal to this time to make, no charge is 
applied for its preparation, by default.

Percentage of mix fee to 
be added to the upcharge 
X%

The percentage of the mix fee to be hidden in the markup of the Rx.

Default mixture time set The default time assigned to mixtures.
Allow changes to mixtures 
with Rx usage

If selected, you can make changes to the mixture card with each Rx.

User Field 1, User Field 2, 
User Field 3

The names of the user fields displayed on the "Other tab" (page 127)

Prompt when absolute 
value of On Hand, Min Qty, 
Max Qty or Pricing fields 
is greater than X

If the value of the On Hand, Min Qty, Max Qty or Pricing fields is greater 
than the value of this field, an exception error is displayed when doing an 
automatic order.

OTC price group The default drug price group to apply to all OTC schedule drugs.
Default quick price plan The default plan for the quick price plan.
Automatically assign fake 
DINs to new drugs

If selected, fake DINs are assigned to new drugs if DINs are not entered. 
If a drug product has a DIN, ensure it is entered in the F5 drug window.

Next DIN to be assigned The first number in the range of fake DINs to assign to new drugs without 
real DINs.

Prompt to create DIN link 
if DIN changes

When a DIN on a drug card changes, this option links the DINs under 
Edit > Din Links on the F5 window. This ensures that when you search 
for a drug by DIN, the old DIN is still linked to it.

Show all drug pack tiers in 
scan by default

If selected, when searching for drugs in the F5 window, multiple tiers are 
shown.

Use secondary drug pack 
tiers for mixture pricing

If selected, the system chooses the secondary tier to price mixtures.

Check for 
interchangeability 
preference

If selected, the drug database is checked for interchangeable drugs.

Only apply to drugs with 
positive on hand

If selected, and a lower priority drug with a positive on-hand value is 
selected during drug refill, the user is not prompted to select a higher 
interchangeable product.

Only update On Hand Qty 
when merging a drug pack 
into a CM drug pack

If selected, on hand quantities are only updated when you merge into a 
centrally maintained drug pack.

Doctor

Doctor > 2- Agent tab
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If Use Physician Listing is selected, users can select a doctor from the menu under Doctors > Doctor 
Listing.

Rx
The following section describes the configuration settings available on the Rx tab.

General

The following table describes the configuration settings on the Rx > General tab.

Name Description
Days Before an 
Rx expires section

The expiry date for different types  of prescriptions (regular, narcotic, controlled, 
targeted, and birth control), based on the date the prescription was written and first 
dispensed. In some provinces, this is automatically populated because the 
provincial legislation states that an Rx expires after a specified number of days. 
Typically, expiry values are set for narcotic, controlled, and targeted prescriptions.

Warn X days 
before Rx expires

The number of days before a prescription is to expire that a yellow yield sign is 
displayed on the Rx window. The default is 90.

Rx > 2- Agent tab
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Name Description
Warn if patient is 
over 65 or under 
25 and not set up 
for provincial plan

If selected, a warning is displayed if the patient is 65 years or older and no 
provincial plan is selected in their profile.

Display price 
change 
notification

If selected, a prompt is displayed if the last Rx had a manual price. You will need to 
decide if you want to use the old manual price or the new calculated price.

Warn if a refill 
price changes by 
> X%

Displays a warning message in the Rx window if the price of the Rx has changed 
by more than the specified percentage. The default value is 5%.

Check profile for 
drug on next Rx

Whether to check the patient record to determine if they took the drug before.

Only show 
LUP warning if 
expiring in less 
than X days

The start of the expiration range for LUP warnings. The default is 120 days.

Warn if days 
supply < X on 
refills for 
provincial plan

Displays a warning if the days supply is less than the specified number for refills 
on provincial plans. This is used if the provincial government does not accept 
certain a days’ supplies.

Automatic "Call 
Doctor" when 
adding repeats

If selected, a ToDo to call the doctor is created when repeats are added to an 
existing Rx.

Enable "Return 
Recycled Rx Drug 
Inventory" 
function

If selected, drugs can be returned to the inventory. This is only available in some 
provinces.

Default product 
selection

The default product selected (none, prescriber's choice, patient's choice, 
pharmacist's choice, or existing therapy).

Inactivate old Rx 
when copying if 
new Rx is Unfilled

If selected, when a new Rx is brought to the pharmacy, the old Rx is inactivated 
and can no longer be filled.

Show Pack Size 
form

If selected, a prompt is displayed on the F12 window when there is more than one 
pack size that is active on the drug card that belongs to the same tier.

Show search 
hints in Rx form

If selected, the yellow hint boxes are shown on the F12 filling window, in the 
patient, drug, and doctor sections.

Tab stop on Rx 
Drug Pack and 
Doc Location

If selected, you can press Tab while filling an Rx to cycle through the fields, and 
stop on drug pack and doctor location.

Create a todo 
refill reminder if 
methadone ingest 
dates skip days 

If selected, a refill reminder and a refill to do item are created whenever there is a 
gap in-between the patient’s ingest dates.

General > 2- Agent tab
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Name Description
Prevent Fill if Rx 
Expired section

If any of the checkboxes in this section are selected, prescriptions cannot be 
refilled if the name of the checkbox is true. For example, if Rx is expired is 
selected, expired prescriptions cannot be refilled.

Toggle Unit Dose 
status when 
Batch Fill Status 
changes

To stop sending Rxs to Automed/Pacmed, or prompt the user, set this to Yes or 
Prompt, respectively. This only applies to profiles/batches 

Allow drug 
changes, Allow 
sig changes, 
Allow mixture 
changes

Use these options to specify if changes can be made to the drug, sig, and mixture 
parts of a prescription, for refills and unfilled Rxs.

Restrict drug 
changes to 
generics

If selected, only generic drugs can be changed.

Allow Sig 
changes after Rx 
adjudication

If selected, you can change the sig code for the Rx even if the Rx has already 
been adjudicated.

Allow Auth Qty 
changes after Rx 
adjudication

If selected, you can change the authorized quantity for the Rx post-adjudication.

Rx User Field 1 The label used for the RX User Field 1, which is displayed on the F12 > Other tab.
Allow Free Form If selected, the Rx User Field 1 accepts free form text.
Allow fill if plan is 
expired

If selected, the pharmacy can send an Rx to the drug plan even if the drug plan is 
marked as expired on the F3 window.

Clear Days 
Supply when Disp 
Qty changes

If selected, and the quantity dispensed changes, you must re-enter the days’ 
supply.

Clear Ingest Date 
when refilling or 
copying an Rx

If selected, the ingest date is cleared when a methadone prescription is being 
entered, so a new ingest date can be entered.

Allow adding 
plans after 
adjudication 
complete

If selected, plans can be added after a claim is adjudicated.

Prevent adding 
refills to Rxs that 
have already been 
refilled 

If selected, you cannot change the authorized quantity on an Rx once the Rx has 
already been filled.

OR only allow 
adding refills on 
same day as first 
fill 

If selected, you can change the authorized quantity only on the day the Rx was 
originally filled.
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Name Description
Automatically set 
Rx Lot Number 
from Drug on 
Non-Workflow 
Rxs

If selected, the lot number is automatically set for drugs that do not go through 
workflow packaging.

Allow free form 
Pseudo DIN at Rx 
plan level

If selected, you can add a free form DIN and plan information at the Rx level.

Enable Retail Rx 
Refill 
Synchronization

If selected, patients' Rx fill dates can be synchronized, if they are eligible.

Minimum  Rx Sync 
Proposed Days 
Supply

The minimum threshold for Rx synchronization. The system will not suggest 
synchronizing to an Rx that would cause the current prescription’s days’ supply to 
be anything less than this value.

Maximum Rx 
Sync Proposed 
Days Supply

The maximum threshold for Rx synchronization. An existing prescription with its 
next refill due beyond this many days is not considered a candidate for 
synchronization.

Note that this value is further reduced by the days’ supply of the current Rx. For 
example, if this is set to 90 days but the current Rx is only for an initial 30-day 
supply, only those existing Rxs with due dates of 30 days or less are eligible for 
synchronization.

Include Overdue 
Rxs due in past X 
days

The number of days in the past an Rx can be overdue and still be included in the 
Rx. If this field is set to 0, past due Rx are excluded.

Prevent Refill, 
Inactivate, 
Transfer Out and 
Suspend if 
Workflow is Not 
Complete cut off)

If selected, Rxs cannot be refilled, inactivated, transferred out, or suspended if the 
workflow is not complete.

Use narcotic 
numbers

If selected a separate range of numbers is used for narcotic prescriptions.

Use narcotic 
numbers and Rx 
Num prefix for 
targeted drugs

If selected, uses narcotic numbers for targeted prescriptions.

Max refills for 
narcotics

Specifies how many refills are permitted for narcotic Rxs.
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Pricing

The following table describes the configuration settings on the Rx > Pricing tab.

Name Description
Provincial (Formulary 
Drugs) and Make this 
plan

The plan that is used for formulary drugs when filling the Rx, and its 
priority in relation to the Clinical Provincial plan.

Clinical Provincial and 
Make this plan

The clinical provincial plan that is used and its priority in relation to the 
provincial plan. The clinical provincial plan only sends Rx data.

Narcotic Monitoring The  narcotic monitoring plan.
If patient has provincial 
plan but Rx is cash, use 
provincial plan pricing

If selected, the provincial pricing strategy is used instead of the cash 
strategy when dealing with patients that have a provincial plan but are 
paying for a cash Rx.

If Purch + X% is greater 
than Cost+Markup then 
charge Purchase+ X%

If the checkbox is selected and a value is entered in the field, the amount 
charged is adjusted as described.

Ignore for provincial plan If selected, the markup is ignored for provincial plans.
Apply the difference to 
the

Whether to apply the difference to the cost, markup, or fee.
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Name Description
Prevent fill if section The pricing conditions under which a prescription will not be filled (Rx has 

a negative gross profit and Drug price field is blank).
Warn if there are lower 
priced formulary items

If selected, users are warned if a cheaper interchangeable product is 
available.

Only for provincial plan If selected, the search for lower priced formulary items is only run in the 
provincial plan.

Warn if Gross Profit is 
less than X%

If selected, you are warned if the overall gross profit of the prescription is 
less than the selected amount.

Warn if drug pack cost is 
older than X days

If a value is entered, a warning is displayed on the Rx warnings tab if the 
drug cost has not been updated since the specified number of days.

Allow copay adjustment 
after adjudication

If selected, you can alter the amount charged to the patient by opening the 
Rx in modify mode, right clicking on the copay/price amount beside the 
cash total, and adjusting the copay amount. The original copay amount 
returned by the plans cannot be exceeded.

Always use formulary 
cost level if applicable

If selected, the formulary cost is always used, even if the patient or doctor 
is selected from the Rx card.

Don't use formulary 
pricing if product 
selection is "Patient's 
Choice" or "Physician's 
Choice."

If selected, the formulary pricing strategy is overridden if the patient or 
doctor is selected on the Rx card.

Use Aggressive ODB 
Frequency Of Dispensing 
Fee Adjudication

If selected:

The fee is not prediscounted

If the patient is eligible for UN intervention code, and the drug is 
subject to UN intervention code, the UN intervention code is always 
sent.

If the claim is rejected with a 65 intervention code erro), the system 
automatically removes the UN intervention code and retries the claim.
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Prompting

The following table describes the configuration settings on the Rx > Prompting tab.

Name Description
Prompt to use drug 
subs

If selected, and a drug sub is available, a prompt is displayed on the F12 fill 
window asking if you want to use the drug sub.

Automatically use 
drug Subs

If selected, the drug sub that is entered on the F5 drug window is automatically 
used.

Use drug subs when 
batching

If selected, the drug sub that is entered on the F5 drug window is automatically 
used with prescriptions included in a batch.

Prompt if doctor 
refused repeat When 
Cancelling Rx

If selected, a prompt is displayed on the F12 fill window when cancelling an 
Rx, asking you if doctor refused the repeat. If yes, the system removes any 
authorized quantity remaining on the prescription.

Prompt for 
comments when 
cancelling an RX

If selected, a prompt is displayed on the F12 fill window when cancelling an 
Rx, asking you to enter the reason the Rx is being cancelled. If Always 
require comment is selected, the comment is required.

Prompt for 
comments when 
inactivating an Rx

If selected, a prompt is displayed on the F12 fill window when inactivating an 
Rx, asking you to enter the reason the Rx is being inactivated. If Always 
require comment is selected, the comment is required.
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Name Description
Prompt for repeats 
when copying an Rx

If selected, when copying an Rx, a prompt asks for the number of repeats for a 
new Rx.

Prevent copying an 
inactive Rx to a new 
number

If selected, inactive Rxs cannot be copied.

Prompt to copy to 
new number if 
refilling an Rx with 
no repeats

If selected, a prompt is displayed when an Rx with no remaining quantity is 
displayed.

Prompt to copy 
“Mistake” Rxs to a 
new number

If selected, you are asked if you want to copy mistake Rxs to a new number.

Prompt to retain Min 
Interval Days when 
copying an Rx

If selected, you are asked whether you want to copy the Min Interval Days of 
an original Rx to its copy.

Prompt to batch NH 
home Rxs

If selected, you are asked to enter the nursing home patient’s prescriptions in a 
batch.

Remove manual 
price for batched Rxs

If selected, the manual price is removed from batch-filled prescriptions.

Show thermal/dot 
matrix label config 
on autofill

If selected, the configuration options for autofilled Rxs are displayed.

Prompt for Due Date 
on autofill batches

If selected, a prompt is displayed for each Rx in an autofill batch, requesting 
the due date.

Prompt for Tx 
comment on autofill 
batches

If selected, you are prompted to enter a Transaction Comment for autofill 
batches.

Require a reason for 
backdating Rx

If selected, the user must enter a reason when backdating an Rx.

Prompt before 
submitting to manual 
plan

If selected, a prompt is displayed when a user submits a claim to a manual 
plan, asking them to confirm this action.

Require pharmacist 
login when undo 
Transfer older than X 
days

If selected, the pharmacist must log in to undo a transfer out that is older than 
the specified number of days.

Participate in the 
Pharmacy Access 
program, Use station 
name subdirectories 
for Pharmacy 
Access,  XML path, 
and Days back

Configure these fields if your store is using a drug information interface such 
as Access Point.
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Name Description
Enable Rx Canada 
program 
(RxGateway)

If selected, when an Rx is filled, an xml file is created in the KrollWin directory, 
in the RxGateway subdirectory.

Prompt for 
Medication Review

If selected, the user is asked whether they want to complete a medication 
review.

Track Medication 
Review Rejection 
Reasons

If selected, Kroll tracks the reasons users reject medication reviews.

Enrol Patients for 
Pickup Notification

Whether patients are automatically enrolled in the pickup notification service. If 
Ask is selected, you are prompted to ask the patient if they would like to enroll 
in the pickup notification service.

Enrol NH Patients for 
Pickup Notification

Whether  nursing home patients are automatically enrolled in the pickup 
notification service. If Ask is selected, the system asks the user whether they 
would like to use the route code from the Rx.

Save Route code 
from Rx as default 
value if no default 
value is set

Whether the route code from the Rx is always used, if there is no default. If Ask 
is selected, the system asks the user whether they would like to use the route 
code from the Rx.

Save Rx Dosage 
Form as default if no 
default set

Whether  the form code from the Rx is used if there is no default. If Ask is 
selected, you are asked if you want to use the form code from the Rx.

Prompt when not 
dispensing as drug’s 
pack size

If selected, and you are filling a prescription for a drug that is dispensed as a 
pack and the Rx quantity is not a multiple of the drug pack size, a message to 
that effect is displayed. You can continue filling for this Rx quantity or multiply 
the Rx quantity by the pack size. If the you choose to continue filling the Rx 
quantity, you are asked whether you want to split the quantity between 
different pack sizes, switch to a different pack size, or ignore.

Prompt if Doctor 
Authorization 
Received for Narcotic 
Rxs

If selected, you are asked whether you received doctor authorizations for 
narcotic Rxs.

Prompt if there is not 
enough inventory to 
fill the Rx

If selected, you are warned when there is not enough inventory on hand to fill 
the Rx. You can choose to owe the patient, split the quantity between different 
pack sizes, switch to a different pack size, or ignore. 

Prompt to print script 
image for 1st fill of 
an unfilled Rx

If selected, you are asked whether you want to print the script image the first 
time an unfilled Rx is filled.

Prompt for AADL 
plan information if 
SA number is NOT 
set

If selected and the Rx lacks a special authorization number, you are prompted 
for the AADL plan information.

This only applies to certain drugs in certain jurisdictions.

Prompt to use 
manual price from 
last refill

If selected and the price for the previous fill was manually entered, you are 
prompted to select  either the new or old price.
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Name Description
Check for high 
intensity drugs

If selected, a check is performed for high intensity drugs.

Show local patient 
profile on fill

If selected, the patient’s local profile is displayed when F12 is selected on the 
Rx window.

Nursing Home

The following table describes the configuration settings on the Rx > Nursing Home tab.

Name Description
Check for bad cycles when creating a batch If selected, newly created batches are scanned for 

bad cycles.
Allow entering pass time quantities if Unit 
Dose is not checked

If selected, you can  add passtimes to the ATN box on 
the F12 window unless the Unit Dose feature is not 
being used.

Exclude non-numeric passtimes from Unit 
Dose automatic dispenser daily dosage 
calculations

If selected, non-numeric passtimes are excluded from 
the Unit Dose automatic dispenser daily dosage 
calculations.

Background Rx Filling

The following table describes the configuration settings on the Rx > Background Rx Filling tab.
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Name Description
Enable 
background Rx 
filling

If selected, the background Rx filling feature is enabled.

Autofill ToDo Rx 
in background

If selected, the background Rx service can fill all ToDo prescriptions.

Autofill ToDo 
Rxs at

If selected, you can to schedule a time when the background Rx service will begin 
filling ToDo items.

Autofill ToDo 
Rxs by User

If selected, you can select the user that the service will autofill the items.

Send autofill 
success/failure 
mail to

The mail group to which the autofill success/failure mail messages are sent.

Autofill IVR Rxs 
in background

If selected, the background Rx service is used to fill all prescriptions received by the 
IVR.

Autofill IVR Rxs 
in Background 
When Store is 
Open

If selected, the background service only fills IVR prescriptions when the store is 
open.

Autofill IVR Rxs 
in Background 
When Store is 
Closed

If selected, the background service only fills IVR prescriptions when the store is 
closed.

Hold IVR 
prescriptions for 
X seconds 
before autofilling

The amount of time the background Rx service waits before filling prescriptions that 
came from the IVR.

Autofill IVR Rxs 
by user

The name of the user the background Rx service uses to fill IVR prescriptions.

Autofill 
scheduled NH 
Batches in 
background

If selected, the background Rx service completes NH batches.

Autofill 
Scheduled NH 
Batches by User

The name of the user the background Rx service uses to fill NH prescriptions.

Send NH batch 
success/failure 
mail to

The mail group to which the pharmacy sends NH batch success and failure 
messages are sent.

Process 
workflow in 
background by 
user

The name of the user who will process the workflow in the background.
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Name Description
Process Rx 
status updates 
in the 
background

If selected, a status update query is sent to Alberta Netcare S2S when a patient 
profile is viewed.

Process pro-
file queries in 
the back-
ground

If selected, a patient profile query is sent to Alberta Netcare when:

When viewing a local patient profile.

As soon as the patient Rx is filled in from the Rx filling window. 

A user searches for a patient, then selects F12 from the patient profile to fill a 
new Rx.

An Rx is being refilled from the Start window.

The patient profile query is sent in the background.
Minimum query 
wait time

How long you must wait for a profile query to complete (when applicable) before 
being allowed to cancel the request and proceed without viewing the network 
profile.

Maximum 
process count

The number of background sessions. The more sessions you use, the more 
requests you may be able to process  at the same time, but you may consume more 
CPU time and memory.

Process keep 
alive time

How long a background session stays running without receiving a command before 
it is terminated. A larger value means new sessions are not opened as often, which 
can make requests faster, but also means that more memory is consumed during 
idle time.

Send failure 
notifications to

The mail group that will receive notifications.
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Workflow

The following table describes the configuration settings on the Rx > Workflow tab.

Name Description
Workflow selection matrix The preconfigured Workflow matrix.
Require Rx Due Date when filling If selected, a due date is required when filling a 

prescription.
Require data re-verification when 
modifying

If selected,  you must review data for any of the items 
selected on the list.

Default delivery route type The default delivery route type.
Enable Store Delivery delivery route type 
and Enable Mail Order/Courier delivery 
route type

If selected, these route types can be selected from the 
Rx window.

Allow Patient to choose Pickup route type, 
Allow Patient to choose Store Delivery 
route type, Allow Patient to choose Mail 
Order/Courier route type, Allow Patient to 
choose Central Fill Ship to Patient route 
type

Patients can choose any of these routes that are 
selected.
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Name Description
Allow workflow queue filtering If selected, you can filter Rxs by current workflow stage 

from the Workflow window.
Decode 2D bar code on inbound 
documents/faxes and Decode reference 
number bar code when importing script 
image

If selected, the 2D bar code on inbound 
documents/faxes and the reference number bar code 
on script images are decoded. This option is useful if 
you want to automate the reconciliation of your 
inbound documents and your network scanner does 
not support TWAIN.

Allow postponing adjudication If selected, when data transmission fails, adjudication 
is postponed so it can be resent later.

Prevent script image reference reuse for 
[x] days

The number of days that must elapse before a barcode 
image can be rescanned.

Require script image reference for script 
images

If selected, script images must have a script image 
reference.

Require script image, or reason for no 
script image, on New Rxs and Require 
script image, or reason for no script 
image, on NH Rxs

If selected, new and NH Rxs, respectively, must have 
script images or reasons why script images are 
excluded.

Exclude Stock Transfers (no Schedule N 
and G)

If selected, script images are not required for stock 
transfers.

Show detached script window when filling 
new Rxs

If selected, the Rx window is superimposed when you 
are filling a new Rx.

Use current time of day for Rx start time If selected, the current time is used as the Rx start 
time.

Force scanning pickup bin after placing 
every Rx

If selected, you must scan a pickup bin when filling an 
Rx so it becomes associated with that bin.

Show items picked up in last [x] hours The  number of hours picked up items remain in the 
picked up window.

Force confirmation scanning of 
prescriptions

If selected, you must scan the Rx barcode on pick up.

Allow confirmation scanning of work order If selected, work orders can be scanned.
Track person picking up Rxs If selected, you must ask the person picking up the Rx 

how they are related to the patient.
Require address of person picking up Rxs 
(Rx for themselves), Require address of 
person picking up Rxs (Rx for someone 
else)

If selected, you must obtain the address of the person 
picking up the Rx for themselves, or for someone else, 
respectively.

Require photo I.D. # of person picking up 
Rxs (Rx for themselves), Require photo I.D 
. # of person picking up Rxs (Rx for 
someone else),

If selected, the patient or the person picking up the 
prescription must provide a photo ID number.

Enable electronic signature at pickup If selected, patients can use electronic signature to 
sign for their prescription deliveries.

Workflow > 2- Agent tab

374 © 2025 TELUS Health Kroll User Guide



Name Description
Only for narcotic monitoring drugs If selected, electronic signature is enabled only for 

narcotic monitoring drugs.
Only for drug schedules If selected, electronic signature is enabled only for the 

selected drug schedules.
Track relationship when person picking up 
Rxs for someone else

If selected, if someone other than the patient picks up a 
prescription, you must specify their relationship to the 
patient.

Allow patient search by scanning Rx 
number bar code

If selected, you  can perform a patient search by 
scanning an Rx barcode.

Allow pharmacist to undo a pickup up to 
[x] days ago

The maximum number of days after a prescription was 
picked up that a pharmacist can undo the pickup.

Enable Pickup / Undo Pickup from start 
screen

If selected, the F10 pickup button on the start window 
and the undo pickup option under the Utilities menu are 
enabled.

Require pharmacist authorization to cancel 
a picked up Rx

If selected, Rxs that have been picked up require 
pharmacist authorization to be cancelled.

Show package details on packaging 
verification screen

If selected, the lot and expiry date information entered 
on the packaging screen is available on the verify 
packaging screen.

Show DIN on packaging screen If selected, the DIN is shown on the Packaging 
workflow window.

Allow Manually Mark as Scanned at POS If selected, you can  manually set the Scanned At POS 
Date  if the Rx was picked up.

Configure Default Rx Comment Workflow 
Alerts

Select this button to select the default Rx comment 
workflow alerts.
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Counselling

The following table describes the configuration settings on the Rx > Counselling tab.

Name Description
Allow editing counseling 
time

If selected, you can edit counseling times when filling an Rx, prior to 
saving the record.

Use These Default 
Responses, Counselling, 
By, and Method

If the check box is selected, the values set in the Counselling, By, and 
Method fields are used as the default responses for the Rx counselling.

Users permitted to 
finalize accepted 
counseling section

The selected types of users can finalize accepted counseling.

Visible Tabs section The selected tabs are visible during Rx verification. By default, all tabs are 
enabled.

On new Rx, On refills, On 
drug changes, For drug-
based followups

The counseling window is displayed for the selected types of Rxs.

Only flag if patient hasn't 
had the drug in the last 
[x] days

Patients that have exceeded the set days since they last had the 
prescribed drug are automatically selected for counseling.
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Name Description
Allow user to turn OFF 
automatic counseling for 
an Rx

If selected, the pharmacist can opt a patient out of automatic counseling.

Require document scan 
to complete paper 
medication review

If selected, you must scan the Med Review document to confirm that you 
have completed the Med Review step.

Enable electronic 
medication reviews

If selected, electronic (paperless) medication reviews are enabled.

Include cover sheet for 
minor ailment summaries 
and referrals

If selected, a cover page is included when a minor ailment summary or 
referral is sent to a doctor.

Require electronic 
signature section

The selected types of Rxs require electronic signature during the Rx 
verification steps.

Prompt to print letter If selected, the user is asked whether they want to print the physician 
letter.

Edit templates Select this button to edit, add, or delete a patient letter.
Since last review If selected, the default date range for the medication review starts at the 

date of the last review and continues to the current date.

Since last review and  In the last [x] months are mutually exclusive.
In the last [x] months The number of months back in time to begin the default date range for 

either minor ailments or medication reviews (depending on which of the In 
the last [x] months fields is selected).
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Immunization

The following table describes the configuration settings on the Rx > Immunization tab.

Name Description
Enable electronic immunizations If selected, immunization documentation is completed 

electronically rather than manually, using paper.
Require electronic signature for 
Pharmacists

If selected, the pharmacist must record an electronic signature 
using a digital signature tablet. The electronic signature 
functionality must be set up to use this functionality.

Require UPC Verification of 
Vaccine Product

If selected, the user must scan or enter the UPC number 
associated with the administered vaccine.

Allow to use non-influenza 
immunization products obtained 
externally

If selected, the pharmacist can accept non-influenza 
immunization products for injection in the following two scenarios:

The patient brings in a product that was dispensed from 
another pharmacy.

The patient is required to take more than one injection of a 
product on separate days, and is returning to the same 
pharmacy  with the second or third vaccine of the same 
product.
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Name Description
Print immunization wallet card If selected, the patient's immunization wallet card is printed.
Allow to use non-influenza 
immunization Rxs dispensed [x] 
days ago

The number of days in the past that a Rx can be dispensed and 
treated as a recently dispensed Rx.

Message on Receipt for patients 
eligible for Influenza shots

The Influenza marketing message that is printed at the bottom of 
receipts for retail and nursing home patients.

Record immunization when filling 
an immunization product or fee 
Rx not already linked to an 
immunization

If selected, when a user is filling an Rx for an immunization or fee 
Rx that is not linked to an immunization, the user is prompted to 
enter the immunization information in the Immunizations data 
entry window.

CeRx

The following table describes the configuration settings on the Rx > CeRx tab.

Name Description
Copy Sig Code when creating local Rxs from network Orders If selected, the Sig from the 

network order is used when a local 
Rx is created.

Prompt to remind me [x], Automatically turn prompting off 
when [x]% of weekly Rxs are eRx, and Automatically prompt 
on non-eRx when [x]% of weekly Rxs are eRx

These three fields define the 
conditions under which local 
authorization reminders are 
displayed.
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Auto-Refill/Reminders

The following table describes the configuration settings on the Rx > Auto-Refill/Reminders tab.

Name Description
Prompt to enrol retail 
patients in Refill Reminder / 
Auto Refill

If selected, the user is asked whether they want to enroll a retail 
patient in refill reminder/autorefill when the patient's profile is loaded.

Prompt to enrol NH patients 
in Refill Reminder / Auto 
Refill

If selected, the user is asked whether they want to enroll a nursing 
home patient in refill reminder/autorefill when the patient's profile is 
loaded.

Never consider Pickup Date 
when calculating refill 
reminder dates, always use 
Fill Date

If selected, the fill date is used when calculating reminder dates.

Allow refill/renewal 
reminders for Drugs

The default reminders for drug cards for which specific reminders are 
not set.

Allow refill/renewal 
reminders for Mixtures

The default reminders for mixture cards for which specific reminders 
are not set.

Default Rx refill reminder 
flag for Drugs

Whether the Reminder checkbox is enabled on the Fill window, for 
drugs with refill reminders. If set to Prompt, the user is asked whether 
they want to enable refill reminders for this prescription.
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380 © 2025 TELUS Health Kroll User Guide



Name Description
Default Rx refill reminder 
flags for Mixtures

Whether the Reminder checkbox is enabled on the Fill window, for 
mixtures with refill reminders. If set to Prompt, the user is asked 
whether they want to enable refill reminders for this prescription.

Create refill reminders [x] 
days before Rx due date

The number of days before the Rx due date that refill reminders are 
sent to the patient.

Don't create refill reminders 
[x]% of Days Supply has 
passed

The percentage of the days supply that should be used up before refill 
reminders are sent to the patient.

Create renewal reminders [x] 
days before Rx due date

The number of days before the Rx due date that renewal reminders 
are sent to the patient.

Don't create renewal 
reminders [x]% of Days 
Supply has passed

The percentage of the days supply that should be used up before 
renewal reminders are sent to the patient.

Send refill and renewals 
reminders to the patient at 
[x] when Rx fill time not 
available

The time of day refill and renewal reminders are sent to the patient. 
Keep in mind that you will receive a number of requests after this time.

Carry forward refill/renewal 
reminder date calculations 
on Copy to New

If selected, the refill/renewal reminder date calculations are copied 
when an Rx is copied. For example, if a refill is due in 20 days, and the 
prescription is copied, should the new prescription be due in 20 days?

Prompt to enable Rxs for 
Auto Refill

If selected, the user is prompted to enable the Rxs for automatic refill.

Add Auto-Refill Rxs to ToDo 
if no refills remaining

If selected, auto-refill Rxs are moved to the ToDo queue if they do not 
have any refills remaining.

Create Auto Fill ToDos [x] 
days before Rx due date for 
first fills

The number of days before the Rx due date that the first autofill of an 
Rx is added to the ToDo queue.

Create Auto Fill ToDos [x] 
days before Rx due date for 
subsequent fills 

The number of days before the Rx due date that subsequent autofills 
of an Rx are added to the ToDo queue.

Don't create Auto Fill ToDos 
before [x]% of Days Supply 
has passed

The percentage of the days supply that should be used up before 
autofill ToDos are created.

FDB
First Data Bank (FDB) provides Kroll with a database that has allergy and interaction checking, drug 
information leaflets and much more. 
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Rx tab

The following table describes the configuration settings on the FDB tab.

Name Description
Perform FDB 
clinical analysis 
when filling Rxs

Select to perform FDB clinical analysis when filling Rxs.

Don't check Rx 
interactions older 
than [x] days

The maximum number of days that can pass before Rxs are no longer checked.

Allergy and Cross-
Sensitivity 
Checking

If selected, patient allergies and drug sensitivities are checked when filling an 
Rx.

Force confirmation 
fields

If selected, users must confirm the applicable action.

Require 
authentication

If selected, users must authenticate their identities when performing the 
applicable analyses.

Drug-Drug 
Interactions

If selected, the system checks for interactions between drugs.

Max SL The maximum security level. Level 3 is high and level 1 is low.
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Name Description
Include Alternative 
Therapy 
Interactions

If selected, the FDB (First Databank) Therapeutic Advisor is used to detect 
potential drug-drug interactions with alternative therapy products.

Force confirmation 
for Severity at or 
above [x]

A number representing the minimum severity level of the applicable type of 
analysis that must be confirmed.

Drug/Disease 
Contraindications

If selected,  the system checks to ensure the prescribed drug will not adversely 
affect the patient’s existing medical conditions.

Duplicate Therapy If selected, a warning is displayed if the patient is taking more than one of the 
same type of drug for the same therapy.

Include same DIN 
(if active)

If selected, filling different strengths of the same drug prompts a duplication of 
therapy warning.

Force confirmation If selected, you must enter your login credentials before completing an Rx.
FDB display zoom 
factor

The factor by which the FDB information is magnified when it is displayed.

Precautions If selected, the precautions are displayed.
Min / Max Dosage 
Checking

If selected, the minimum and maximum dosages are displayed.

Dose Range 
Checking

If selected, the dose range is displayed.

Drug Indications If selected, the appropriateness of the drug therapy for a specific medical 
condition is assessed based on current medical evidence. 

Drug Side Effects If selected, drug side effects are displayed.
Drug/Food 
Interactions

If selected,  monographs on potential drug-food interactions are displayed to 
assist clinicians in educating the consumer about potential interactions that may 
occur between certain drugs and foods.

Drug/Mix and Patient
The Drug/Mix and Patient sub-tabs contain the same fields.

Drug/Mix and Patient > Rx tab
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The following table describes the configuration settings on the FDB > Drug/Mix and FDB > Patient tabs.

Name Description
Allergy Checking If selected, allergy 

checking is 
performed on drugs 
and mixes.

Show empty reports If selected, empty 
reports are 
displayed.

Drug-Drug Interactions, Drug/Disease Contraindications, Duplicate 
Therapy, Precautions, Min / Max Dosage Checking, Dose Range 
Checking, Drug Indications, Drug Side Effects, and Drug/Food 
Interactions

The types of allergy 
information that are 
displayed.

Max SL The maximum 
security level. Level 
3 is high and level 1 
is low.

Adjudication
The following section describes the configuration settings available on the Adjudication tab.

Adjudication > Rx tab
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General

The following table describes the configuration settings on the Adjudication > General tab.

Name Description
Use the Cost/Markup/Fee 
parameters (on the Retail/Nursing 
Home tabs) if there are other plans

If selected, the cost/markup/fee parameters set on the Retail 
and Nursing Home tabs are used if other drug plans are 
present.

Prompt to rollback copay for last Rx 
plan

If selected,  the copay from the primary plan is automatically 
sent to the next plan, so you can adjust the final copay once 
the Rx has been sent through all plans.

Always prompt to rollback copay for 
provincial plan

If selected, a prompt is displayed, asking if users want to 
waive part or all of the copay amount before it is sent to the 
next plan.

When rolling back Cost, Markup Fee 
and Copay Adjustments, apply the 
rollbacks section

The sequence in which rollbacks are applied.

Automatically switch routes when 
they are down

If selected, automatically switches to the secondary route 
when the primary route is down.
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Name Description
Allow marking fiscal plans down if 
there is only one route, Allow 
marking clinical plans down if there 
is only one route

If selected, the financial plans and clinical plans, respectively, 
are marked down if only one route is available for adjudication.

For Copay strategy Rxs filled in 
Past 28 Days, anchor period start 
date on [x]

The anchor start date for Rxs filled in the last 28 days.

Do not sent DA/DB to ESI when 
previous plan rejects claim with 
these codes

If a previous claim rejects with one of these codes, the DA/DB 
is not sent to ESI (Express Scripts).

Do not sent DA/DB to plans (except 
ESI) when previous plan rejects 
claim with these codes

If a previous claim rejects with one of these codes, the DA/DB 
is not sent to any plans except ESI (Express Scripts).

Ignore these warning messages The warning messages that will be ignored.
Ignore batched CeRx warnings with 
a severity less than or equal to, 
Ignore batched NeCST warnings 
with a severity less than or equal to

The level after which batched CeRx and NeCST warnings are 
displayed (e.g. if Moderate is selected, Low and High 
warnings are displayed). If no option is chosen, you must 
correct any severity level that is returned during batching.

Ignore these NeCST warning 
messages

The NeCST warning messages that will be ignored.
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Retail/Nursing Home
The Retail and Nursing Home tabs contain the same settings. Users must configure both tabs, depending 
on the settings that apply to the pharmacy. Users can select different values for retail Rxs and nursing 
home Rxs; the selected parameters will apply regardless of whether Rxs are filled manually or in a batch.

The following table describes the configuration settings on the Adjudication > Retail and Nursing Home 
tabs. The last two fields are only available on the Nursing Home tab.

Name Description
If the Cost + Markup difference is < = $ 
[x] then discount the difference 

Differences greater than or equal to the amount specified 
are passed onto the patient. This value must match the If 
the Fee + MixFee difference is < = $ [x] then discount 
the difference value.

0 or blank means Do Not Discount.
If the Cost + Markup difference is > = 
$[x] then force pharmacist to review

Differences greater than or equal to the amount specified 
prompt the pharmacist to review the prescription. The 
default value is $0.01.

0 or blank means the difference is passed onto to the 
patient.

If the Fee + MixFee difference is < = $ 
[x] then discount the difference

Differences less than or  equal to the amount specified are 
passed on to the patient. This value must match the If the 
Cost + Markup difference is < = $ [x] then discount 
the difference  value.

0 or blank means Do Not Discount.
If the Fee+MixFee difference is > = $[x] 
then force pharmacist to review 

This value must match the If the Cost + Markup 
difference is > = $[x] then force pharmacist to review 
value.

0 or blank means the difference is passed onto to the 
patient.
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Name Description
Automatically Credit Copays if less 
than or equal to $[x]

If selected, the credit copay value is set to zero if the 
amount returned is equal or less than the pre-set amount.

For CASH Rxs filled in a BATCH, 
charge a fee for [x] Rx(s) in the [y], For 
CASH Rxs filled manually, charge a fee 
for [x] Rx(s) in the [y]

The number of cash Rxs [x] to be charged during a specific 
date range [y], for cash Rxs filled in a batch or manually.

Labels
The following section describes the configuration settings available on the Labels tab.

General
You can use the General tab  to configure the label settings for retail and nursing home Rxs. Select the 
Advanced button to define additional label mappings and create new stocks. This tab also contains 
controls for adjusting the printer offsets.

The following table describes the configuration settings on the Labels > General tab. 
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Name Description
Regular Labels 
(retail/nursing home)

The label types that the settings on this page are applied to.

Advanced Select to configure the settings for the selected label.
Print labels for “not 
dispensed” Rxs

Whether labels are printed for Rxs that have not been dispensed.

Print labels If selected, labels will be printed  for each Rx.
Print labels for cancelled 
Rxs

Whether labels are printed for cancelled Rxs.

Preview labels If selected, label previews are displayed before the label is printed.
Print labels for unfilled Rxs If selected, labels are printed for unfilled Rxs.
Print laser labels on unit 
dose Rxs

If selected, laser labels are printed when unit dose is selected in the Rx.

Print labels for cancelled 
Rx when rebilling

If selected, labels are printed for the cancelled Rx when rebilling.

Adjust printer label offsets Select to adjust the left and top offsets of the printers.
Offset fields The offsets for various labels.
First drug name, Second 
drug name

The information that prints as the drug's first and second name, 
respectively, on the vial label.

Narcotic RxNum prefix The prefix added to the Rx number for narcotic drugs.
Bold first drug name If selected, the  first drug name is bolded on the vial label.
Prefix second drug name If selected, the second drug name is prefixed to the first drug name.
Print salutation with 
patient's name

If selected, the salutation set on the F3 - Patient window is shown on 
the vial label.

Print * after Rx num for 
robotic interface

If selected, and an Rx is filled by a robotic interface, pill counter, etc.,  an 
asterisk is inserted after the Rx number to indicate the Rx is being filled 
by the machine.

Show profile and label 
reprints as filled

If selected, a status of ‘filled’, rather than ‘reprint’ is displayed on the 
hardcopy.

Show thermal label 
configuration on print

If selected, a label configuration window is displayed before labels are 
printed.

When prompted to print a 
label, remember my answer 
for all labels

If selected, when the user is asked whether they want to print a label, 
their answer is used for all of the labels.

Print in colour If selected, labels are printed in colour.
Show profile and label 
reprints as filled

If selected, the profile and label reprints are shown as filled.

Header section The pharmacy’s address information as it appears on laser labels.
Logo  
Print headers section If a type of label is selected, the header is printed on it.
For patient 'Label Header' 
comments, replace [x]

The portion of the text entered on the Configuration > Workstation > 
Labels tab that will be used for the label header. For more information, 
see "Labels" (page 443).
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Vial 
The options on this tab vary depending on whether  laser labels, dot matrix labels, or thermal printer labels 
are configured on the General tab. The options available for laser labels are described below.

The following table describes the configuration settings on the Labels > Vial tab. 

Name Description
Print original Rx number If selected, the  system prints the original Rx number for each 

prescription filled in a chain.
Print pharmacist initials If selected, the pharmacist's initials are printed on the vial label.
Print manual drug expiry 
(don't use drug expiry 
date)

If selected, a blank expiry label is printed on the bottom of the vial label 
so you can write in an expiry date.

Print drug DIN (don't use 
Pseudo DIN)

If selected, the DIN is printed on the vial label, instead of the pseudo DIN 
that was used for billing.

Always print 2 vial labels If selected, vial labels are always printed in sets of two.
Always print on all vials on 
each page

If selected, vial labels are printed for each label set; none are blank.

Print vial labels for Touch 
OTC Rxs

If selected, vial labels are printed for touch pickup OTC Rxs.
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Name Description
Print pass times on NH 
laser labels

If selected, the  passtime is printed on a regular label if the patient is in a 
nursing home.

Print refills on label if zero If selected, refills are printed as zero if the patient does not have repeats 
left on the prescription.

Print refill expiry If selected, the refill expiry date is printed.
Print refill info on unlimited 
refills

If selected, the refill information is printed on unlimited refill Rxs.

Print qty remaining instead 
of refills

If selected, the pill count is printed in the refill position instead of the 
number of refills left.

Use NH-style vials for 
NH patients section

If selected, nursing home-style vial labels are used for nursing home 
patients. The selected information is printed on these labels.

Print methadone label on 
vial 2

If selected, a methadone label is printed on the second vial label for 
methadone prescriptions so the signatures of the patient and the 
witness can be recorded.

Bold sig If selected, the sig line on the vial label is bolded.
Print native language if 
printing foreign sig

If selected, the SIG is printed in the native language on the hardcopy.

Print sig before drug info If selected, the SIG is printed before the drug information on the vial.
Print narrow vials (my 
labels have pre-printed 
child warnings)

This field applies to provinces in which child warnings are required to be 
printed. This provides a narrow label to make room for the pre-printed 
child warning.

Print child warning on NH-
style laser label

If selected, a warning is printed on the left hand side of the vial label 
stating to keep out of reach of children.

Watermark darkness The watermark opacity as a percentage.
Print CF host Rx was sent 
to

If selected, the name of the Central Fill host is printed at the bottom of 
the vial label.

Print DSQ ids If selected, DSQ (Dossier Santé Québec) IDs are printed.
Print vials for unfills If selected, vial labels are printed for unfilled prescription. If deselected, 

the system defaults to printing a hardcopy but no vial label.
Print watermark for unfills If selected, a watermark is printed diagonally across the label, stating it 

is unfilled.
Print warnings for unfills If selected, warnings are printed for unfilled Rxs.
Print DOS-style vials If selected, you can  print DOS-style vial labels.
Print drug expiry dates 
for... section

Indicates whether drug expiry dates are printed for non-mixtures and 
mixtures.

Hardcopy
The options on this tab vary depending on whether laser labels, dot matrix labels, or thermal printer labels 
are configured on the General tab. The options available for laser labels are described below.
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The following table describes the configuration settings on the Labels > Hardcopy tab. 

Name Description
Hardcopy TxNum prefix The prefix that appears in front of the Rx number on the vial label. 

This is typically set to ‘Rx’, although some provinces set it to ‘Tx’.
Print store header on laser 
hardcopy

If selected, the header that configured in the Labels > General tab 
is printed on the laser hardcopy.

Print refill "days early/late" 
message

If selected,  a message is printed letting the pharmacist know if the 
refill is early or late.

Print patient, drug, and doctor 
hardcopy comments

If selected, the comments entered on the F3, F5 or F7 windows are 
printed.

Do not print hardcopy when 
electronic signatures enabled

If selected, hardcopies are disabled if a signature pad is configured.

Hardcopy Rx Comment 
Priorities

Click to select the sequence in which Rx comments are printed.

Print fill time If selected, the time at which the Rx was filled is printed.
Include due date in Rx 
messages

If selected, the due date for the Rx is included on the hardcopy.

Print Sig status on hardcopy If selected,  “New” prints in front of the sig if the signature has been 
changed since the original fill.
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Name Description
Print native language sig when 
printing foreign sig

If selected, the sig on the hardcopy is printed in the native language, 
even when printing a foreign language sig.

Print gross profit on hardcopy If selected, the total gross profit is printed on the hardcopy.
Replace total with patient pays 
on dot matrix / thermal labels

If selected, the patient pays amount is printed on the label instead of 
the total cost.

Print transaction number on 
bottom of hardcopy

If selected, the Tx number is printed on the bottom of the hardcopy.

Print indications on Hardcopy If selected, the indications are printed on the hardcopy.
Print gender If selected, the patient’s gender is printed on the hardcopy.
Print allergies and conditions If selected, the allergies and conditions from the patient profile are 

printed.
Print NH code If selected, the nursing home code is printed on the hardcopy.
Print ward Short Form Code If selected, the Ward Short Form Code is printed on the hardcopy.
Print NH room If selected, the patient’s nursing home room number is printed on 

the hardcopy.
Print med type If selected,  the medication type is printed on the hardcopy.
Print pass times If selected, the pass times are printed on the hardcopy.
Always print brand and 
generic drug names

If selected, the drug’s brand name and generic name are printed on 
the hardcopy.

Print pack size and cost If selected, the pack size and cost of the pack are printed on the 
hardcopy.

Print lot and drug expiry date If selected, the lot and expiry date are printed.
Print plan-specific DINS for 
mixtures

If selected, the DIN that is entered on the Plans tab on the F5 - 
Mixture window is printed.

Show default vendor's item 
number

If selected, the default vendor item number entered on the Ordering 
tab on theF5 - Drug window is printed on the hardcopy.

Print drug location If selected, the location of the drug is printed, if the location was 
entered on the F5 - Drug window.

Print refrigerated product 
indicator

If selected, the refrigerated product indicator is printed, if applicable.

Print watermark on section The types of hardcopies the watermark is printed on.
Print counselling on section The types of Rxs that counselling information is printed for.
Print doctor license Whether the doctor's license is printed on all, none, or select hard 

copies.
Print store header on laser 
hardcopy

If selected, the header that configured in the Labels > General tab 
is printed on the laser hardcopy.
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Receipt

The following table describes the configuration settings on the Labels > Receipt tab. 

Name Description
Print "Official Receipt" at 
top

If selected, ‘Official Receipt’ is printed across the top of the laser 
receipt.

Print initials If selected, the initials of the user who filled the prescription are printed 
on the receipt.

Print patient address If selected, the  address entered on the F3 - Patient window is printed 
on the hardcopy.

Print drug DIN If selected, the DIN is printed on the receipt. This is required if the 
patient is using the official receipt to submit to a drug plan.

Print doctor license If selected, the doctor's license number that is entered on the F7 - 
Doctor window is printed.

Print cost breakdown If selected, the markup and mix fees are printed.
Print Markup in, Print Mix 
Fee in

Where the Markup and Mix Fee, respectively, are printed.

Print gross and discount 
cost

If selected, the cost of the drug and the discounted amount are printed.
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Name Description
Print gross and discount 
markup

If selected, the gross and discount markup are printed on the receipt.

Print discounted amounts If selected, the discounted amounts are printed on the receipt.
Discount title The name of the discount.
Print USD indicator on 
receipt and delivery invoice

If selected, a USD indicator (U.S. dollars) is printed on the receipt and 
invoice.

Print Days Supply If selected, the days supply quantity is printed on the receipt.
Receipt Free Form  
Print third party breakdown If selected, the amounts the third party paid are printed on the receipt.
Prompt to print third party 
messages

If selected, you are prompted to print third party messages on the 
receipt.

Print owed message on 
regular label set

If selected, the owed amount is printed on the bottom of the receipt, if 
an owing label is selected of the F12 window.

Print signature line If selected, a signature line is printed at the bottom of the receipt for the 
pharmacist to sign.

Print electronic signature 
from workflow action

If selected, the pharmacist’s signature is printed on the receipt when 
signed using the electronic signature pad.

Print receipt for refusal to 
fill

If selected, receipts are printed for refusal to fill Rxs.

Receipt breakdown (Bill 92) Whether the receipt breakdown is always or never printed, or printed 
according to the AQPP rules.

Other Labels
The options on this tab vary depending on whether laser labels, dot matrix labels, or thermal printer labels 
are configured on the General tab. The options available for laser labels are described below.
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The following table describes the configuration settings on the Labels > Other Labels tab. 

Name Description
Print Rx ranges on daily total label If selected, the Rx regular and narcotic range 

used for the day is printed on the end of day 
totals.

Print warning label to indicate no refills 
remaining

If selected, a warning (auxiliary) label is printed, 
warning the patient that no repeats remain.

Print mixture component breakdown label If selected, a mixture breakdown is printed when 
the Rx is a mixture.

Print costs If selected, the Rx costs are printed on the label.
Print AR label when Rx is charged If selected, the AR label is printed if an Rx is 

changed.
Print Tx label If selected, the transmission label is printed.
Print pictures If selected, drug pictures are printed.
Print description with drug image If selected, the drug description is printed with 

the drug image.
Audit/Tracking position The placement of the audit/tracking information 

(none, hardcopy, Tx label 1, or Tx label 2).
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Name Description
Audit/Tracking label box wording The names of the audit/tracking steps that are 

printed on the label.
Print Ontario-compliant counselling checklist (Ontario only) If selected, the Ontario-compliant 

counselling checklist is printed.
Print Provincial card expired label on Ontario dot 
matrix set

If selected, the  expiry date that is entered on the 
F3 card is printed on the dot matrix label set.

Print free form labels to dot matrix printer If selected, free form labels are sent to a 
configured dot matrix printer.

Print user labels to dot matrix printer If selected, all user labels are sent to a 
configured dot matrix printer.

Print "Controlled Partial Fill Pickup" label If selected, the Controlled Partial Fill Pickup 
label is printed after an Rx for a controlled drug 
is partially filled.

Print Allergies/Conditions label when 
inactivating/reactivating

If selected, allergies and conditions are printed 
when inactivating or reactivating Rxs.

Print enhanced work order drug list If selected, the Work Order Drug List label is 
printed as part of the Print Work Order Drug 
List workflow action.

Print mixture component breakdown on second 
vial

If selected, the components within a mixture are 
printed on the second vial.

Print Robotic in separate section on Work order 
drug list label

If selected, the robotic barcode label is printed in 
a separate section on the work order drug list 
label.

Compliance label location, Dose checking label 
location, Drug message location, and Workflow 
messages location

The location of these four components with 
respect to other elements on the label.

Profile/Wallet Card

The following table describes the configuration settings on the Labels > Other Labels > Profile/Wallet 
Card tab. 
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Name If selected...
Print Wallet card by default (can 
change on Rx)

A wallet-sized patient profile is printed on the bottom right hand 
side of laser label set.

Print generic drug name The generic name of the drug is printed on the wallet card.
Print sig The Rx sig is printed on the wallet card.
Print refills remaining The number of remaining repeats  per Rx are printed on the 

wallet card.
Include inactive Rxs Inactive Rxs in the patient’s profile are printed on the wallet 

card.
Include unfilled Rxs Unfilled Rxs from the patients profile are printed on the wallet 

card.
Include Fee for Service Rxs Select to include fee-for-service Rxs on the wallet card.

Delivery/Privacy

The following table describes the configuration settings on the Labels > Other Labels > Delivery/Privacy 
tab. 

Name Description
Use enhanced 
delivery label 
(Thermal only)

If selected, the enhanced version of the delivery label is used. This field is 
disabled if your store does not use thermal labels.

Always print 
delivery label

If selected, a delivery label is printed each time an Rx is filled.

Print Rx number If selected, the Rx number is printed on the delivery label.
Print phone number If selected, the phone number listed as the first phone number in the patient 

profile is printed on the delivery or privacy label, depending upon which 
checkbox is selected.

Print co-pay If selected, the copay is printed on the delivery label.
Print pending 
medication review 
notification

If selected, a pending medication review is printed.
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Name Description
Print signature line If selected, a signature line is printed on the delivery or privacy label, depending 

upon which checkbox is selected.
Position For laser labels only, this identifies the position of the delivery or privacy label.
Print patient pays If selected, the  print includes the amount the patient pays.
Print third party 
amount

If selected, the print includes the third party amount.

Print pending 
medication review 
notification

If selected, the pending medication review notification is printed.

Print patient email 
address

If selected, the patient's email address is printed.

Print refrigerated 
product indicator

If selected, the refrigerated product indicator is printed.

Coupon
You can use the Coupon tab  to specify the X and Y offset, and the  height and width of printed coupons. 
Use the Load button to import a coupon image and adjust the parameters so it prints correctly. 

The dollar value is set by the image and cannot be changed without loading a new image.

The following table describes the components on the Labels > Other Labels > Coupon tab. 

Name Description
X Offset, Y Offset, 
Width, and Height

The position and size of the coupon.

Load Select to load the image you want to display on the coupon.
Delete Select to delete the image.
Print coupon 
section

Select to print a coupon for New Rxs or Refill Rxs, or both. In one or both of 
these sections, enter a Value (% of Rx price) of the coupon, and enter the 
Minimum value and Maximum value to which the coupon can be applied.
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Name Description
Value (% of Rx 
price), Minimum 
value, and 
Maximum value

The discount percentage and amounts.

Include provincial 
plan

If selected, the provincial plan is considered when calculating coupon values.

Expire after (days) The number of days in which the coupon will expire.
Override using plan 
settings based on

The criteria that overrides will be based on.                         

Message The text to be printed on the coupon.

NH (nursing home)

The following table describes the configuration settings on the Labels > NH tab. 
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Name Description
Only print regular label set for 
NH Rxs if regular labels > 0

If selected, a regular label set is printed if the number of NH regular 
labels on the F12 fill window is more than zero.

Print receipt for NH Rxs when 
patient pays > 0

If selected, a laser receipt is printed when a nursing home patient 
pays more than zero.

Print receipt with Ontario 
Standard labels

If selected, a receipt is printed with the Ontario Standard labels.

Print ManRex labels for 
unfilled Rxs

If selected, a ManRex label is printed for unfilled Rxs if ManRex 
labels are selected as the label set for the nursing home (under 
Labels > General).

Print pass times on ManRex 
labels

If selected, the pass times that are set on the F12 fill window under 
ALT N are printed if ManRex labels are set for nursing home (under 
Labels > General)..

Print Rx expiry on ManRex 
labels

If selected, the prescription's expiry date is printed on the ManRex 
label if ManRex labels are set for the nursing home (under Labels > 
General).

Always split quantity on 
Ontario Standard vials

(Ontario only) if selected, the quantity is split when using Ontario 
standard vials.

Use "NH labels" to govern vial 
label count on NH Laser Label 
Style 1 & 2

If selected, the NH Label field on the Fill Rx window is used to 
control the number of vial labels used for NH laser label styles 1 & 2.

ManRex label header The pharmacy’s address information as it appears on ManRex 
labels.

Bar Codes

You can use the Bar Codes tab to set up bar codes. You must know what type of system you are using, as 
not all POS systems are interfaced with Kroll. 

 1.  Select Add or select a row from the table and then select Edit .

The Edit bar code popup is displayed.
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 2.  Select the bar code Type and Position.

 3.  Use the checkboxes to select where you want the barcode to be printed, and the 2D Bar 
Coding. 

Typically, barcodes are placed on receipts and privacy labels.

 4.  Select OK.

Delivery
The options selected for the delivery order report will vary depending on the needs of the pharmacy.

The following table describes the configuration settings on the Delivery tab. 

Name Description
Print Delivery Order report, 
Print Delivery Invoice Report

When the Print Delivery Order and Print Delivery Invoice reports, 
respectively, are generated (Always, Never, or Only if > $0.00)

Print Credit Card on Delivery 
Order Report, Print Credit 
Card on Delivery Invoice 
Report

If selected the credit card number is printed on the Print Delivery 
Order and Print Delivery Invoice reports, respectively.

Print drug information on 
Delivery Order report

If selected, the  drug name and drug information are printed on the 
Delivery Order report.
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Name Description
Print section Release of 
Delivery Order on Delivery 
Order report, Print section 
Delivery of Order on Delivery 
Order report, Print section 
Receipt of Delivery Order on 
Delivery Order report, Print 
section ID Required on 
Delivery Order report.

If selected, the Release of Delivery Order, Delivery of Order, 
Receipt of Delivery Order, and ID Required sections are printed 
on the Delivery Order report.

Print store logo on delivery 
invoice

If selected, the General Store Logo from the General tab is printed.

Mark delivery order shipped 
on print

If selected, the delivery order is marked as shipped when the receipt 
is printed.

Warn me if the address used 
in the delivery order is not 
valid

If selected, the user is warned if the delivery address that was 
entered is not valid.

Delivery order bar code The number that is used for delivery bar codes.
Delivery order export If selected, a file is created that contains the information from the 

delivery order report.
Delivery order export folder The folder where delivery order exports are saved. A shared network 

folder is recommended.
Delivery Order Export Fields The fields that are displayed on the Delivery Order Report. Select  

Edit to change these fields.
Default delivery charge The default fee charged for deliveries.
Retain completed delivery 
orders for [x] months

The number of months delivery orders will be kept. Delivery orders 
cannot be deleted until they are older than the number specified.

Allow patients to receive 
deliveries without signature

If selected, patients can receive deliveries without signing for them.  

Require signature for orders 
with value greater than $[x]

If selected, signature is required for orders with values greater than 
the number supplied.

Require signature for 
refrigerated products

If selected, signature is required for refrigerated products.

Require signature for delivery 
addresses in these 
provinces/territories

If selected, signature is required for delivery addresses in the 
selected provinces and territories.

Require signature for 
products under these 
schedules

If a drug belongs to one of the drug schedules listed here, and that 
drug is included in a delivery, the recipient must sign for the delivery.
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Name Description
Require lockbox to receive 
delivery without signature and 
Acceptable penetration 
percentage

Select Require lockbox to receive delivery without signature to 
indicate that the patient must receive their mail in a lockbox if they 
want to receive their order without a signature. 

Whether a patient has a lockbox is based on a file provided by 
Canada Post that lists the postal codes and the percentage of 
addresses for each postal code that have lockboxes. If this checkbox 
is selected, the system looks up the  postal code and if the 
corresponding penetration percentage is greater than or equal to the 
value of the Acceptable penetration percentage field that you set 
beneath the Require lockbox to receive delivery without 
signature checkbox, the order is eligible for delivery without 
signature. 

For example, if you selected the Require lockbox to receive 
delivery without signature checkbox and set Acceptable 
penetration percentage to 95%, signature is not required for 
residents with postal codes where >=95% of the mailboxes are in 
lockboxes.

Default waybill number for 
Store Delivery

If selected, the default waybill number is used for store deliveries; 
otherwise, you can enter a waybill when completing the delivery 
order.

Reports
The following section describes the configuration settings available on the Reports tab.
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General

The following table describes the configuration settings on the Reports > General tab. 

Name Description
Insert row breaks into 
report

If selected, blank space is inserted between rows on the report.

Reports shading [x] % The percentage of visual shadow used on the report, to make the data 
easier to read. 

Always show masked 
Credit Card Numbers

If selected, credit card numbers are masked on reports.

Store ID and Format The Store ID and format needed to run the IMS report.
Send scheduled report 
failure notifications to

The user on the Kroll mailing list who receives failure notifications.

Fax cover page disclaimer The text of the disclaimer to be printed on the fax cover page.
Include canceled Rxs on 
MAR/TMR forms

If selected, cancelled Rxs are displayed on Mar and TMR forms.

Include cancelled Rxs on 
compliance reports

If selected, cancelled Rxs are displayed on the compliance reports.
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Name Description
Exclude full suspension 
period Rxs on MAR/TMR 
forms

If selected, and an Rx is suspended during the period specified by the 
start and stop dates of a MAR or TMR report, that Rx is excluded from 
the report.

MAR/TMR: when patient 
has no 
allergies/conditions, print

The text that is printed, if applicable, when the patient does not have any 
allergies or conditions.

Date Format and Time 
Format

The formats used for dates and times.

Prescription Authorization 
Request message

The text of the prescription authorization request.

Kroll Care
Kroll Care, also known as the patient information leaflet, explains what a drug is used for, how the patient 
should take it, and its precautions, side effects, and so on.

The following table describes the configuration settings on the Reports > Kroll Care tab. 

Name Description
Offsets section The printing parameters. By default, these are all set to 0..
Base Font Size The base font size for Kroll reports.
Print store name If selected, you are asked whether you want to print the pharmacy name 

at the top of the Kroll Care leaflet.
Print store logo If selected, you are asked whether you want to print the store logo at the 

top of the Kroll Care leaflet.
Print drug picture If selected, you are asked whether you want to print a picture of the drug 

at the top of the Kroll Care leaflet.
Print sig If selected, you are asked whether you want to print the doctor’s 

directions at the top of the Kroll Care leaflet.

Kroll Care > Rx tab
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Name Description
Print pharmacist's 
signature line

If selected, you are asked whether you want to print a signature line at 
the top of the Kroll Care leaflet.

Hide patient last name If selected, the patient’s last name is not printed at the top of the Kroll 
Care leaflet.

Hide entire patient name If selected, the patient’s name is not printed at the top of the Kroll Care 
leaflet.

Duplex (if supported) If selected, duplex (double-sided) printing is allowed if it is supported.
Print Rx Number instead 
of patient name

If selected, the  patient’s name is printed on the leaflet instead of the Rx 
number.

Print opioid education 
sheet

If selected, the opioid education sheet is printed 

Print for Retail New Rxs If selected, you are asked if you want to print a Kroll Care leaflet for retail 
new Rxs.

Only print if patient hasn't 
had the drug in the last [x] 
days

A Kroll Care leaflet is printed only if the patient has not had the 
medication in a specified number of days.

Prompt to print for retail 
Rxs

If selected, you are asked if you want to print a Kroll Care leaflet if you 
are filling for a retail (non-nursing home) Rx.

Print for Retail Refill Rxs If selected, you are asked if you want to print a Kroll Care leaflet for refill 
Rxs.

Print for NH New Rxs, 
Print for NH Refill Rxs

If selected, you are asked if you want to print a Kroll Care leaflet for 
Nursing Home new and refill Rxs, respectively. These checkboxes are 
rarely enabled.

Print for Unit Dose New 
Rxs, Print for Unit Dose 
Refill Rxs

If selected, you are asked if you want to print a Kroll Care leaflet for unit 
dose or compliance pack Rxs, for new or refill Rxs, respectively.

Print for Autofill New Rxs, 
Print for Autofill Refill Rxs

If selected, you are asked if you want to print a Kroll Care leaflet for new 
or refill Rxs, respectively, that are automatically filled in a retail batch.

Security
You can use the Security tab to configure the level of security within the application. The fields on this tab 
vary according to the store, chain, and province. The same fields are displayed on both the Regular Users 
and Manager Users sub-tabs.

Security > Rx tab
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The following table describes the configuration settings on the Security  tab. 

Name Description
Require Passwords If selected, users must enter a password when logging into Kroll.
Min password length The minimum number of characters a password may contain.
Min password age The number of days that must pass before a password can be 

reused.
Force password change after [x] 
days

The number of days that passwords remain valid. If this is blank, 
users will never be prompted to change their passwords.

Prevent usage of [x] previously 
used passwords

The number of previously used of passwords that cannot be 
reused.

Disable user after [x] failed 
attempts

The number of times a user can unsuccessfully enter a 
password before their account is disabled.

Disable user if dormant period 
exceeds [x] days

The number of days after which to disable a user if they have not 
been active in Kroll. 

Disable user if activation period 
exceeds [x] days

The number of days after which to disable a user if they have not 
yet activated their account.

Force password change for new 
user

If selected, new users are prompted to change their password 
the first time they log in. This is on by default.

Security > Rx tab
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Name Description
Enforce complex passwords 
section

If selected, you can use the fields in this section to choose the 
amount of numbers and symbols passwords must contain.

Lock session after [x] minutes The number of minutes of inactivity that must pass before the 
user is logged out.

Terminate session [x] minutes 
after locked session

The number of minutes after a session has been locked that it 
will be terminated.

Require User ID for Every Rx If selected, the user must enter their login credentials before 
filling an Rx.

Require Password after no 
Activity in [x] Minutes

When the session is unattended for this number of minutes, you 
must login again to resume your session.

Allow Password Recovery With 
App

If selected, the user can recover their password through the app.

Allow sending public IP address 
to Pharmanet

If selected, the public IP address can be sent to Pharmanet.

Banner If selected, users have to acknowledge a configurable banner 
before they can log into Kroll.

Log Rx reprints, Log Rx Modifies If selected, a log entry is created when an Rx is reprinted or 
modified, respectively.

Log On Hand changes If selected, a log entry is created when the on-hand quantity is 
changed.

Require user login If selected, you must log in before you can changed on-hand 
values.

Only log for drug Schedules The selected drug schedules are logged.
Log AR modifications, Log AR 
deletions

If selected, a log entry is created when an AR setting is modified 
or deleted, respectively.

Log if refill is [x]% early or late A log entry is created when refills are early or late by the 
specified percentage.

Log credit card access and 
changes

If selected, a log entry is created when a credit card is accessed 
or modified. 

Log user information access and 
changes

If selected, a log entry is created when a user account is 
accessed or modified. 

Restrict and log running of 
reports for all patients

If selected, a log entry is created  and login credentials are 
required when reports are run for all patients.

Log Vendor Socket 
Communications and Log handled 
exceptions

If selected, vendor sockets and handled exceptions, 
respectively, are included in the log.

Always double count drug 
schedules

The categories of drugs that must always be counted twice.

Double Count Acknowledgement The type of acknowledgment required when performing double 
counts.

Show notifications for pending 
updates on the Start screen

If selected, notifications for pending updates are displayed on 
the Alt+X - Start screen.

Security > Rx tab
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Name Description
Only show to users who can run 
updates

If selected, notifications are only shown to users who can run 
updates.

Include updates that are effective 
in the future

If selected, notifications about future updates  are included.

Interfaces
The following section describes the configuration settings available on the Interfaces tab. These settings 
vary depending on which interface is selected.

Point of Sale/Robotic
The Point of Sale and Robotic selections on the Interfaces tab are mostly identical, although the Robotic 
selection has an additional Log data field.

The following table describes the configuration settings on the Interfaces  tab when Point of Sale or 
Robotic is selected. 

Interfaces > Rx tab
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Name Description
Interface Type The type of interface.
Transfer Type The method by which the files will be transferred. The Robotic Interface 

Type you select may limit which transfer types are available.
Ignore NH Rxs and 
Ignore Unit Dose Rxs

If selected, nursing home Rxs or Unit Dose Rxs, respectively, are ignored.

Log data If selected, data is logged for the robotic interface.

Central Fill
The Central Fill tab only appears if the Central Fill module has been enabled (Configuration > Kroll > 
Modules > Central Fill). Note that this is a billable module. Central Fill enables users to process an Rx at 
one location and send it to Central Fill where it is dispensed, packaged, and shipped back to the store, 
directly to the patient, or to a nursing home.

The following table describes the configuration settings on the Interfaces  tab when Central Fill is 
selected. 

Name Description
Request counselling If selected, prompts for counselling on the client side.
Request Rx receipt If selected, prompts for a receipt.

Central Fill > Rx tab
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Name Description
Allow backorders If selected, Rxs can be filled even if the quantity of drugs is insufficient.
Prevent order if Rxs 
need verification

If selected, you cannot complete orders for Rxs that require verification.

Prevent order if not 
billed

If selected, you cannot orders that have not been billed/adjudicated.

Request invoice If selected, an invoice is printed, showing a successful transfer.
Request packing slip If selected, the CF facility is requested to include either an invoice and/or a 

packing slip with an order.
Dynamically create 
orders when filling 
Rxs

If selected, a CF order is automatically created to be sent to the CF host when 
filling an Rx.

Prompt to Send Now If selected, you are prompted to immediately send CF orders to the CF host.
Default destination The central fill site that is pre-selected as the destination for data 

transmission.
Prompt For CF 
refusal reason

If selected, you are prompted to enter a refusal reason if you opt not to send 
an Rx to the CF host.

Prompt For CF 
patient consent if 
unknown

If selected, you are prompted for the patient consent if  the patient consent is 
unknown.

CF requires patient 
consent

If selected, you are prompted to ask the patient if they would like to participate 
in the central fill program.

Central Fill requires 
guardian consent for 
patient under age [x]

The age under which patients will need a parent or guardians permission to 
participate in the CF program.

Pre-qualify nursing 
home Rxs for remote 
packagers

If selected, all NH prescriptions are eligible to be filled by a packager, by 
default.

Send to CF when 
Batching (if 
previously sent)

If selected, when performing a batch fill, the system references the last time 
the Rx was sent to CF and sends it again. The drug must be eligible for CF.

Prompt to update CF 
order status before 
receiving

If selected, you will not be able to receive a CF order unless you have updated 
the order status to the filled state. When updating the order status, a request is 
sent to the CF host to determine the status of the order.

Override default 
timeouts

The timeout parameters for Connection Timeouts, Send Timeouts, and 
Receive Timeouts.

Central Fill > Rx tab
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Outbound Communication
The Outbound Communication interface works in conjunction with the IVR system (Voiceport and 
VoiceTech). Your pharmacy must use the most recent version of the IVR system. 

The following table describes the configuration settings on the Interfaces  tab when Outbound 
Communication is selected. 

Name Description
Message Type The type of message.
Comm Type The communication type, such as phone or e-mail.
Provider The provider of the communication type.
Level 1, Level 2, Level 3, 
Level 4, Level 5

The escalation levels you want to assign to the selected communication 
type. Level 1 is the number of hours that will elapse before the patient is 
contacted a second time, Level 2 is the number of hours that will elapse 
before the patient is contacted a third time, and so on. 

Notification Window 
(Hours of Operation)

The window of time during which the selected communication type can 
be sent.

Notify when items in 
Queue are more than [x] 
minutes overdue

If a number of minutes is entered, notifications are sent when the items 
in the queue are older than that number.

Outbound Communication > Rx tab
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Name Description
Allow sending free form or 
editing predefined text 
messages

If selected, users can enter custom messages or edit predefined 
messages. 

Enable Shipping and 
Delivery Notifications

If selected, shipping and delivering notifications are sent.

Send appointment 
reminder #1 [x] minutes 
before the appointment 

The number of minutes before each appointment that the first reminder 
is sent.

If blank, the first reminder is not sent.
Only send appointment 
reminder #1 if the meeting 
was created at least [x] 
hours before the reminder 
time

If the appointment was created less than the number of hours ago 
specified by this field, the first reminder is not sent.

Send appointment 
reminder #2 [x] minutes 
before the appointment

The number of minutes before each appointment that the second 
reminder is sent.

If blank, the second reminder is not sent.
Only send appointment 
reminder #2 if the meeting 
was created at least [x] 
hours before the reminder 
time

If the appointment was created less than the number of hours ago 
specified by this field, the second reminder is not sent.

Set patient appointment 
reminder alert in .ics file to 
[x] minutes before the 
appointment 

The number of minutes before the appointment that the reminder alert in 
the .ics file is set to .

If blank, no alert is sent.

Send appointment 
immunization consent 
questionnaire [x] minutes 
before the appointment 

The number of minutes before the appointment that the immunization 
consent questionnaire is sent.

If blank, no questionnaire is sent.

Include time zone in 
outbound messages

If selected, the time zone is included in outbound messages.

Outbound Fax
The Outbound Fax tab displays the settings used when sending faxes.

Outbound Fax > Rx tab
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The following table describes the configuration settings on the Interfaces  tab when Outbound Fax is 
selected. 

Name Description
Use outbound fax service If selected, this service is used.
Local prefix and Long distance prefix The prefixes used by the outbound fax.
Ignore failed outbound fax attempts 
after [x] days

The number of days after which to ignore failed outbound 
fax attempts.

External Interfaces
The External Interfaces tab lists the external interfaces that have been defined.

Due Dates
You can use the Due Dates tab to configure the wait times and due dates.

External Interfaces > Rx tab
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The following table describes the fields on the Due Dates tab.

Name Description
Configure Wait Times Select this button to define the wait times used by 

the fields on this tab.
Default wait time The wait time that is used if a specific wait time is 

not set for an item.
When calculating due dates, defer items 
within [x] minutes of closing until next 
business day

If an item's due date is this number of minutes 
before closing, its due date will be deferred to the 
next day.

Other drop-down lists on this tab The waiting times used by various items.
Don't promise due date to patient fields If selected, the pharmacy will contact the patient 

when the prescription is ready for pickup or delivery.

Due Dates > Rx tab
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VoicePort, RxTouch, and Vigilance
These tabs list the settings needed to connect to VoicePort, RxTouch, and Vigilance.

VoicePort, RxTouch, and Vigilance > Rx tab
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AR Payment Import File

Use this tab to configure the AR Payment Import file.

PointClickCare
This tab is used if the PointClickCare software is connected.

If Send Generic Drug Name is selected, the generic drug name is sent instead of the brand name.

AR Payment Import File > Rx tab
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Order
The following section describes the configuration settings available on the Order tab.

The following table describes the configuration settings on the Order tab. 

Name Description
Perform Inventory Adjustment If selected, inventory tracking is enabled.
Enable automatic drug ordering If selected, you can use automatic ordering.
Base ordering on, Base 
minimum scripts on

The pharmacy's reorder parameters.

Allow “Base Ordering On” 
Override at Drug Pack Level

If selected, you can change ordering options at the drug card 
level.

Auto increment PO numbers Automatically assigns PO numbers to drug orders.
Allow order grouping If selected, orders are grouped.
Create order grouping when 
receiving a substituted item

If selected, all substituted items in an invoice are included in an 
order group.

Do NOT prompt to link items If selected, you are not asked whether you want to link catalog 
items to a drug pack so that the inventory/prices can be updated 
when the order is received.

Order > Rx tab
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Name Description
Prompt for untransmitted 
purchase orders when closing 
Kroll

If selected, if you close Kroll while you have untransmitted 
purchase orders, you are asked to confirm that you want to exit.

Warn if item order price >= [x] If an order item exceeds this value, an order reconciliation 
warning message is displayed.

Warn when ordering from 
another vendor if item available 
from primary vendor

If selected, a warning is displayed when you order an item from a 
secondary vendor that is available from the primary vendor.

Base reorder on the inventory of 
the primary product

If selected, the primary product is used to determine inventory 
level when there is an order grouping in place.

Primary vendor and Secondary 
vendor

The primary and secondary order suppliers.

# of days to base average usage 
calculations on

The number of days used by the average usage calculation.

Show warning if unresolved 
purchase order greater than [x] 
days

The system warns if a purchase order has not been received 
within this number of days (unless the number is 0).

Force inventory adjustment on 
all drugs

If selected, an inventory adjustment is applied to all drugs.

Next PO number The next PO number to use for orders.
Allow non-PO receive If selected, you can receive all products in the system whether or 

not a PO is linked.
Average drug's acquisition cost 
upon receiving new inventory

If selected, the drug's acquisition cost is averaged when new 
inventory is received.

Allow default vendors for 
specific drug packs

If selected, default vendors can be set for specific drug packs.

For shared DB, order only for 
current store

If selected, if you use a shared database for multiple stores, 
orders are only made for the current store.

Order > Rx tab
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X - AR
The Accounts Receivable (AR) module is enabled from the Configuration > Kroll > Configuration tab. 

Please contact TELUS Health for helping adjusting these settings.

To Do
The To Do tab works in conjunction with the To Do tabs on the Alt-X window. Please contact 
TELUS Health prior to changing any of the settings on this window.

X - AR > Rx tab
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Cleanup

The following table describes the  configuration settings on the Cleanup tab. 

Name Description
Purge data with no activity in the past [x] 
years

Data that has not been used in this number of years is 
removed when a purge is performed.

For patients, also retain data for [x] years 
after the patient turns [x] years old

The number of years patient data is retained, after the 
patient reaches the specified age.

Generate Purge Report If selected, a purge report is generated.
Automatically delete processed inbound 
documents and faxes after [x] days

The number of days after inbound documents and 
faxes are processed that they are deleted.

Cleanup > Rx tab
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Adjudication configuration
You can use the Adjudication Configuration window to configure how data is transmitted to third party 
insurance providers. The five tabs across the top of the window allow you to configure different parts of the 
adjudication process.

Adjudication configuration > Rx tab
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Hosts tab
The Hosts tab displays a list of providers and the routes used for communicating with them.

Hosts tab > Rx tab
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The following table describes the fields on this tab and the popup that is displayed when you enter or edit a 
host.

Name Description
Name The provider.
Route The adjudication route. Ensure you select the appropriate route for the provider.
Secondary 
Route

The backup transmission route. 

BIN The  identification number that corresponds with the selected adjudication host. 
DNA The adjudication host's DNA value.
Transmit 
Timeout

The length of time, in seconds, that should pass before the adjudication service reports a 
transmission has failed because it took too long.

Hosts tab > Rx tab
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Routes tab
The Routes tab shows the configured routes available to communicate with. It displays the name of the 
route, the type of connection it uses, and the phone number it uses to dial out, if it is configured as a dial-up 
connection. The Is Down column indicates whether you should mark the route as ‘down’ after a failed 
adjudication attempt, if the connection is not available.

The following table describes the fields on this tab and the popup that is displayed when you enter or edit a 
route.

Name Description
Name The name of the adjudication route.
Node Type The type of node.

Routes tab > Rx tab
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Name Description
Route Type The type of route.
Protocol The protocol. The protocol determines which fields are displayed in the popup.

Nodes tab
The Nodes tab shows where each connection type will be routed for communication with third party 
providers. There are usually only two nodes present, though more can be added. Nodes are usually set to 
the system the adjudication service is hosted on.

The following table describes the fields on this tab and the popup that is displayed when you enter or edit a 
node.

Name Description
Priority The sequence in which the node is used.
Station The name of your station.
NodeType The type of node. The node may determine which fields are displayed in the 

popup.
ComPort/Station The communication port or station.
Modem/Password The modem or password, depending on the type of node.

Nodes tab > Rx tab
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Modems tab
The Modems tab shows a list of all pre-configured modems. Depending on the firmware used by the 
modem and a number of other factors, some configuration changes may be required.

Use the Add Modem, Edit Modem, and Delete Modem to manage the list of modems.  

The following table describes the fields on this tab, and the Modem Edit Form popup.

Name Description
Name The name of the modem.
Config 
cmd

The modem's unique configuration string. If you do not have this string, refer to a website 
such as Modem Help or Jay’s Page of Modem Inits  for assistance.

Hangup 
Cmd

The command that is used to end the connection on the phone line, thus terminating data 
transmission. This field is usually set to ‘DTR’.

Modems tab > Rx tab
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CPHA Field Transfers tab
The CPHA Field Transfers tab determines what type of information is sent when an Rx is sent for 
adjudication, and in which fields.

Select Ins or press Insert  to add a new field transfer. Existing field transfers can be edited by double-
clicking the record or selecting F2.

Both actions call up the CPHA Field Transfers form where you can enter/edit the field transfer details.

CPHA Field Transfers tab > Rx tab
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Name Description
When the 
Plan (Adj 
Host) is

The adjudication host to which the field transfer applies.

And the 
Drug 
Price 
Group is

The drug price group that must be used in order for the field transfer to be applied. If you 
select <Any Price Group>, the field transfer is applied regardless of the selected price 
group.

And this 
Plan is

Whether the drug plan must be the primary or secondary plan in order for the field transfer 
to be applied.

and the 
Rx 
Primary 
Plan is

The Rx primary plan that must be used in order for the field transfer to be applied. This 
option is only available when And this Plan is is set to Secondary.

Send the 
and in the 
fields

Use these fields to indicate which information should be displayed in which field. Options 
in the Send the drop-down list include Cost, Markup, Fee, and Mix Fee; options in the 
second drop-down list include Do Nothing, Cost, Markup, Fee, and Mix Fee.

Hours of Operation
You can set the hours of operation for the pharmacy, as well as the time windows during which SMS, email, 
phone, and push notifications will be sent.

Hours of Operation > Rx tab
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The Pharmacy Hours of Operation popup contains a field for each day, as well as a table to which you 
can add holidays.

The SMS, Email, Phone, and Push Notifications Time Windows popups use the same fields as the 
Pharmacy Hours of Operation popup, although the values of the daily fields differ.

Hours of Operation > Rx tab
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Use the dropdown boxes next to each day to indicate whether and when the pharmacy is open, or whether 
or when  SMS, email, phone, and push notifications can be sent.

Use the Holiday Hours section to set holiday hours. 

Permissions
You can use the Permissions settings to control which areas of the application are accessible and usable 
by specific user groups.  Before you adjust the permissions, ensure you have set up your user groups.
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Assigning permissions
 1.  From the Alt-X Start window, select File > Configuration > Permissions and select the 

applicable user group.

The Edit Permissions window is displayed.

 2.  Select the actions you want to grant to the selected user group permission. 

 3.  Select OK.

Group permissions 
The following table describes the permissions you can apply to user groups:

Name If selected, users in this group can...
View Clinical 
Info

View all patient-related drug information.

If deselected, users cannot view patient allergies and conditions, patient profile, or 
F12 window. They can access individual drugs and doctors, but not as they pertain to 
a specific patient.

Allow Viewing 
Rx Screen

Access  the F12 window.

View Patient Search for and access patient profiles. 

If deselected, users can refill prescriptions but not fill new prescriptions.
Allow Patient 
Changes

Update patient profiles.

View Doctor Search for and access doctor profiles. 

If deselected, users can refill prescriptions but not fill new prescriptions.
Allow Doctor 
Changes

Update doctor profiles.
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Name If selected, users in this group can...
View 
Drug/Mixture

Search for and access drug/mixture profiles. 

If deselected, the users can refill prescriptions but not fill new prescriptions.
Allow 
Drug/Mixture 
Changes

Make changes to drug/mixture profiles.

Allow Drug 
Bases 
Changes

Make  changes to the base in a mixture.

If deselected, users can only change variable drug information such as pricing and on-
hand quantities

Allow Adding 
New 
Drugs/Packs

Add and copy new drugs into the database. 

If deselected, users can only add new pack sizes to existing drugs.

Allow Drug 
Price Changes

Make changes to drug prices.

Allow Drug 
Inventory 
Changes

Make changes to the on-hand and min/max/days fields. Users can also enable the No 
Inventory Adjustment and Disable Automatic Orderingflags on the F5 window.

For Schedules 
requiring user 
login

Make changes to the on-hand and min/max/days fields for schedules requiring user 
login.

Allow Custom 
FDB Changes

Make customized FDB changes to counseling messages, Kroll Care, and auxiliary 
labels.

Apply Drug 
Inventory 
Counts

Generate cycle counts.

Allow 
Manually Mark 
as Scanned at 
POS

Manually set the Scanned at POS Date if the Rx was picked up by Kroll.

Allow Create 
Purchase 
Orders

Generate and send purchase orders.

Allow Create 
Narcotic 
Orders

Create narcotic orders.

Allow Receive 
Purchase 
Orders with no 
invoice

Receive purchase orders without invoices.

View Financial 
Reports

View the financially sensitive reports.

View Non-
Financial 
Reports

View the non-financial reports.
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Name If selected, users in this group can...
Allow Running 
Reports for All 
Patients

Run patient reports.

View AR 
Information

Access the Patient AR Profile window

Add 
AR Charges

Charge items to patients’ accounts receivable accounts.

Edit/Delete AR 
Charges

Edit and delete charge items in patients’ accounts receivable accounts.

Add AR 
Payments

Add payment items to the Payments tab on the patient’s Accounts Receivable profile.

Edit/Delete AR 
Payments

Edit and delete payment items from the Payments tab on the patient’s Accounts 
Receivable profile.

Run AR 
Reports

Access the AR Adjustments Audit and AR Taxes Breakdown reports.

View Credit 
Card Numbers

View, add, delete, and edit patient credit card entries.

Allow Credit 
Card 
Password 
Management

Access Utilities > Credit Card Password Manager from the menu.

Allow Merges Merge duplicate patient, drug, and doctor records.
Allow Viewing 
History 
Records

View history records on the patient, drug, and doctor windows.

Allow Use of 
Drug Update 
Utility

Update drug configuration and drug fields for multiple drug records at the same time.

Allow Manual 
Comm. Queue 
Changes

Manually change the communication queue. 

This applies only to pharmacies with the Kroll Outbound Call Module (OCM).

Allow Bypass 
Or Postpone 
Verification 
Workflow 
Actions

Bypass or postpone verification actions in the workflow.

View Deleted 
Faxes / 
Network 
Scans

View deleted inbound/outbound faxes and network scans.

Group permissions > Rx tab
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Name If selected, users in this group can...
Allow 
Permanent 
Deletion of 
Faxes / 
Network 
Scans

Permanently delete faxes and network scans.

Allow 
unlocking 
user accounts 
of lower 
privilege level

Unlock lower-level user accounts.

Allow 
Database 
Maintenance

Perform database maintenance tasks.

Run Updates Perform Kroll updates.

Maintenance permissions
The following table describes the permissions under the Maintenance heading on the Edit Permissions 
window.

Name If selected, users in this group can...
Change Plans Access the Plans tab on the Plans/Pricing window.
Change Pricing Access the Strategies, Strategy Exceptions, Drug Price Groups, Patient Price 

Groups, and Copay tabs on the Plans/Pricing window.
Change Master 
Lists

Access the menus in the Master Lists window.

Change Users Access the Users and Groups window.
Change Sig 
Codes

Add, edit, and delete Sig codes from the Edit Sig Codes window.

Change Vendor 
List

Add, edit, and delete vendors in the Edit Vendor List window.

Change NH 
(Excluding 
Cycles)

Add, edit, and delete nursing home information from the Edit Nursing Home List 
window.

Change NH 
Cycles

Change the nursing home cycles.

Change 
Adjudication 
Config

Update the adjudication configuration.

Change Head 
Office Config

Access the Head Office Level Configuration Parameters window.

Change Store 
Config

Access the Store-Level Configuration Parameters window.
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Name If selected, users in this group can...
Change Services 
Config

Access the Services Configuration window.

Change Workflow 
Config

Access the workflow configuration windows.

Change 
Workstation 
Config

Access the Station Configuration window.

Change Central 
Fill Config

Access the Central Fill parameters window.

This option is only available to pharmacies that use the Central Fill module.
Change Province Change the system’s default province.
Change User 
Permissions

Access the Edit Permissions windows. 

Change Mail 
Distribution Lists

Change Mail Distribution lists.

Change Enhanced 
Kroll Care

Change enhanced Kroll Care settings.

Change Hours of 
Operation

Change the hours of operation.

Control Services Control Kroll services.
Manager Signifies that the user is in the Manager group.
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Printers
 1.  From the menu, select File > Configuration > Printers. 

The Printer Configuration window appears.

 2.  Double-click the printer name or highlight the printer name and select Edit.

The Edit Printer Settings window is displayed.

The following table describes the printer properties.

Name Description
Emulation The appropriate emulation for the printer  (e.g., thermal emulation should not be 

set for a laser printer).
Bar Code The bar code number  used to select a printer when filling an Rx. This enables 

you to print vial labels using a scanner.
Print watermarks as 
an image

If selected, watermarks are printed as images.

Label Offsets The offsets are used to control the label alignment.
Tray The tray used for prints.

Printers > Rx tab
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Printer stocks
Printer stocks are configured from the File > Configuration > Printer Stocks> Edit Printer Stocks.

The following table describes the fields on this window.

Name Description
Description A descriptive name of the printer stock.
Document Type The type of document.
Label Style The style of label. These values vary depending on the Label Style.
Warning label for 2D bar code The warning label used on 2D bar codes.

Printer stocks > Rx tab
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Services configuration
Services are configured from File > Configuration > Services Configuration.

To specify the location of a service, enter the name of the host computer in its Host field. You can change 
the port if the service has been set up to operate on a port that is different from the default ports.

Workstation configuration parameters
This section describes the configuration settings available in File > Configuration > Work Station > 
Station Configuration.

Services configuration > Rx tab
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Label Printers

The following table describes the buttons on the bottom of this window.

Name Use to...
PCL 
Commands

Set tray options that are sent as RAW PCL commands to the printer.

Edit Printer 
Definitions

Manage the  IE, Laser, Thermal, and Oki Data printer types, and configure custom 
barcodes that enable scanning from handheld devices for automatic printing. You can 
also modify the label offsets.

Other printers

The following table describes the sections on this window. For information on the buttons on this window, 
see "Label Printers" (page 441).
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Name Description
Report Printer The printer that used for printing reports. 
Kroll Care Printer The printer used for printing Kroll Care leaflets.

ManRex Printers

The following table describes the sections on this window. 

Name Description
Printer The names of the printers used for ManRex printing.
Tray The printer tray to use.
Use Two ManRex Label Printers If selected, two ManRex printers are used.

Input Devices

ManRex Printers > Rx tab
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The following table describes the configuration settings on the Input Devices tab.

Name Description
Scanner The scanner used for importing documents and images.
Resolution The dots per inch for higher and lower resolution scans. The default is 100DPI.
Mode Whether documents and images are scanned in grey scale, black and white, or 

colour. Grey is the default.
JPEG Quality The percentage the image can be compressed without compromising its quality. For 

the scanner, the maximum is 50% and the default is 40%. For the camera, the 
default is 80%.

Iterative Crop If selected,  more precise image cropping is used.
Brightness, 
Contrast, 
Saturation

The lighting, sharpness, and colour intensity of the scanned image.

This Scanner 
auto-crops the 
image

If selected, scanned images are auto-cropped after they are imported.

Camera The camera device.
Resolution DPI The dots per inch of photos taken by the camera. The default is 300DPI.
Signature 
Tablet

The signature tablets configured in the Kroll Device Helper, if applicable. When 
setting this value, select a configured signature tablet and select Identify. 

This ensures you are prompted to sign the electronic signature if patient or 
pharmacist signatures are required.

Labels
Use the Labels tab to configure a custom label header, to overwrite the label configured in File > 
Configuration > Store. 
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 1.  Use the controls to specify the Font, Font Size, and make the text bold (B), italic (I), or 
underlined (U).

 2.  Select Print Test Page to print a test page so you can preview the custom label header.

Backup

This following table describes the configuration settings on the Backup tab.

Name Description
Warn if backup file is 
older than 2 days

If selected, and the  configured backup is older than two days, a warning is 
displayed when you log into Kroll for the first time.

Backup Location The location where the file will be backed up each day.

General

This following table describes the configuration settings on the General tab.
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Name Description
Lock session 
after [x] minutes

The number of minutes after which the touch pickup station is locked, if it is 
inactive.

Use on-window 
keyboard in touch 
mode

If selected, you can use the on-window keyboard to input entries. This setting is 
enabled by default.

Screen Width The screen width of this workstation.
Allow 
Unrestricted 
Screen Resizing

If selected, the screen at the workstation can be resized.

Launch Kroll 
Device Helper on 
Startup

If selected, the Kroll Device Helper is automatically launched when Kroll is 
launched.

Auto-detect 
Devices

If selected, barcodes are automatically detected on scanners and signature pads.

Client Type The current environment:

If the user environment is using the device locally, then Windows Thick client 
should be used.

If you are using an RDP with a Simply Core USB Redirector to redirect the 
USB device to the RDP environment, then Thin Client (Simply Core USB 
Redirector) should be used. 

If you are using RDP with Fabulatech USB Redirector to redirect the USB 
device to the RDP environment, then Thin Client (Fabulatech USB Redirector) 
should be used.

If you are using RDP with Wyse TCX to redirect the USB device to the RDP 
environment, then Thin Client (Wyse TCX) Redirector should be used.

Workflow
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From this tab,  select the workflow queues that you want to be available for this workstation when a user 
selects the Get Work button on the F9 - Workflow window.

Workflow > Rx tab
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